
Guide to Invoicing

Payments

Banking

Financial Statements

and more

Magaya Software 
Accounting Manual



Magaya Corporation

Magaya Software Accounting Manual

Document Publication Date:

January 23, 2017

Copyright 2017



Contents

Chapter: 1 How to Use this Manual .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
Introduction to the Accounting Manual .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2
How this Manual is Organized  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2
Contact and Help Resources   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3

Chapter: 2 Magaya Accounting System Overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 7
Introduction to Accounting in Magaya   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  8
Accounting Folder Overview  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

Chapter: 3 Configure your Accounting System  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11
Accounting Wizard .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12
Entering Opening Balances  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 18

Chapter: 4 Chart of Accounts   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22
Chart of Accounts: Introduction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 23
Add to the Chart of Accounts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24
Actions in the Chart of Accounts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 26
Configure Default Accounts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
Inventory Accounts   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 28

Chapter: 5 Items and Services  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 30
Introduction to Items and Services .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31
Add Items and Services   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32
Dependent Charges   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
 i MAGAYA SOFTWARE ACCOUNTING MANUAL



Priority of Charges  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
Actions Performed with Items and Services .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 38

Chapter: 6 Accounts Receivable  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 41
Introduction to Accounts Receivable .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 42
Create Invoices  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 43

Actions for Invoices .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 50
Import Invoices into your Magaya System   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 55
Print Invoices to a Fiscal Printer   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 58

Fiscal Printer Overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 58
Configure a Fiscal Printer   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 59
Download and Use the Panama Check Template  .  .  .  .  .  .  .  .  .  .  .  . 62

Close of Day Procedure   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 64
Credit Memos .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 65
Payments   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 67

Customer Payment Terms  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 73
Depositing Payments  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 78

Refund Check .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 81
Customer Statements .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 84

Chapter: 7 Accounts Payable .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 86
Introduction to Accounts Payable   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 86
1. Create Bills  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 87
2. Purchase a Fixed Asset   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 93
3. Bill Credits  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 93
4. Bill Payments .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 95
5. Pay Multiple Vendors  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 97
6. Vendor Refunds  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 100

Chapter: 8 Banking   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  103
Introduction to Banking in Magaya Explorer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 103
Writing Checks  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 104
Pay Expenses with a Credit Card  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 107
Pay Sales Tax   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 109
Making Deposits  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 117
Bank Reconciliation   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 120

Chapter: 9 Accounting Reports   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  127
Introduction to Accounting Reports  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 127
Customize Reports  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 132
Financial Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 136
Profit & Loss Report  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 137
Comparative Profit & Loss Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 140
Shipment List P&L Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 143
MAGAYA SOFTWARE ACCOUNTING MANUAL ii



Balance Sheet  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 144
Statement of Cash Flows .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 148
Sales Reports   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 150
Purchase Reports  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 155
Profit Reports Overview  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 159
Customer Profit Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 161
Salesperson Profit Report   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 162
Agent Profit Report   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 163
Profit & Loss by Operations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 163
Other Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 165

Multicurrency Reports  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 167
Shipment Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 169
Cash Basis Reports   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 171
Cash Basis Reporting Overview  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 171
Configure for Cash Basis .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 172
Cash Basis Balance Sheet .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 172
Prorated and Partial Payments in Cash Basis Reports   .  .  .  .  .  .  .  . 174

Chapter: 10 Advanced Accounting Features   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  175
Setting Accounting Roles   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 177
Accounting Configuration .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 178
Main Accounting Configuration Tab   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 179
Accounting Document Numbers Configuration  .  .  .  .  .  .  .  .  .  .  .  .  . 184
Accounting Reports Configuration .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 185
Cost Configuration .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 186
Tax Configuration   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 188
Accounting Integration Configuration .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 188
Credit Limit Configuration  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 190
Miscellaneous Accounting Configurations   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 191
Additional Financial-related Configurations   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 192
Average Cost   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 194
Configure Average Cost System-wide  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 194
Configure Average Cost per Item .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 195
Additional Configuration  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 196
Sell Items and Create Invoices   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 197
Specific Identification   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 198
Changing Costing Methods  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 199
Landed Cost Management .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 200

Landed Costs in “Items & Services” .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 200
Sales Taxes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 203

Steps to Add a Sales Tax Item  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 204
Create a Withholding Tax (Retention)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 206
Group Taxes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 208
Tax Dependencies .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 210
Change a Tax Rate   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 212
VAT Example: Ecuador   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 216
 iii MAGAYA SOFTWARE ACCOUNTING MANUAL



Tax Example .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 216
Tax Example: Colombia   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 223
Tax Example: Mexico .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 229
Tax Example: Canada .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 234
Simple Tax Example   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 234
Compound Tax Example .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 237

Approve/Dispute Invoices .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 242
Configure: Approve or Dispute Invoices .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 242
How your Customers Approve or Dispute an Invoice Online .  .  .  .  .  . 243
Approve or Dispute in your Magaya System   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 243
Journal Entries   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 245
Steps: Create a Journal Entry   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 245
Adjustments .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 249
Multiple Currencies   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 251

How to Set up Multiple Currencies in your Magaya System .  .  .  .  . 251
How to Activate Currencies  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 253
How to Add a New Currency to the Currency List  .  .  .  .  .  .  .  .  .  . 256
How to Manage Exchange Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 256
How to Create an Operations Transaction in a Different Currency . 259
Multicurrency Reports  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 264

Relationship Between Accounting & Operations  .  .  .  .  .  .  .  .  .  .  .  .  . 266
Accounts Receivable Special Procedures .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 269
Processing Discounts Manually .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 270
Handling Bounced Checks   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 271
Processing Wire Transfer Fees   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 272
Petty Cash Deposits   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 274

Chapter: 11 Automated Accounting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  277
Introduction to Automated Accounting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 278
Automated Creation of Charges   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 278
Automate Charges per Customer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 283
Creating Charges from Routes   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 284
Recurrent Accounting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 285

Create a Recurring Invoice .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 285
Create a Recurring Bill  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Create a Recurring Check   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Actions for Recurrent Transactions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 295

Periodic Invoices  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 296
Periodic Billing for Vendors .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 298
Tariffs and Rates: Introduction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 299
Tariffs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 301

Tariffs: Introduction   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 301
How to Set Up Tariffs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 302
How to Customize a Tariff .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 308

Rates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 311
Carrier Rates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 314
MAGAYA SOFTWARE ACCOUNTING MANUAL iv



Enter Carrier Rates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 314
Actions in the Carrier Rates List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 320
Query Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 322
How to Query Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 322
Standard Client Rates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 326
Steps to Set Up Standard Client Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 326
Actions in the Standard Client Rates List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 329
Custom Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 331
Create Customized Rates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 331

Carrier Contracts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 335
Managing Contracts   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 335
Add a New Carrier Contract .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 337
Add Rates to a Carrier Contract .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 340

Amend Rates   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 347
Amend Rates based on GRI  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 347
Modify a Standard Rate   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 354
Modify Rates for Your Customers   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 356

Client Contracts   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 358
Salesperson’s Commissions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 361

Add a New Salesperson .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 361
Freight Commission   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 362
Inventory Commissions   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 366
Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 370
Enable a Salesperson to Submit Orders on behalf of Customers .  .  . 372

Index  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  i
 v MAGAYA SOFTWARE ACCOUNTING MANUAL



1

Chapter 1 1. How to Use this Manual

1. How to Use this Manual



Chapter 1 Introduction to the Accounting Manual
Introduction to the Accounting Manual

Introduction

Welcome to the Magaya Software Accounting Manual.

This manual is designed to teach you how to perform accounting procedures in 
Magaya software and answer common accounting questions such as “How do I 
create an invoice?” and “How do I add an account to the Chart of Accounts?”

Magaya software is designed for logistics providers, freight forwarders, 
N.V.O.C.C.’s, consolidators, forwarding agents, couriers, warehouse providers
and others in the logistics and supply chain industries. Magaya software
contains a complete accounting system that integrates the accounting features
with the operations features in the software.

How this Manual is Organized

This manual is designed to be task oriented. You can skip to any topic you need 
and get step-by-step procedures for all the accounting tasks performed in 
Magaya software. You can also click on any word in the Index to go to that topic. 
This manual is organized into the following topics:

• An overview of the accounting system and accounting wizard (it is recom-
mended you begin with the Accounting Wizard to set up your company’s
accounting information such as fiscal year, home currency, and more)

• How to use the Chart of Accounts

• How to use the Items and Services

• Accounts Receivable, including working with invoices, credit memos,
receiving payments, and how to create a report of open invoices and aging
AR

• Accounts Payable, including creating and paying bills, bill credits and
vendor refunds, and how to create a report of unpaid bills and aging AP

• How to perform banking tasks such as how to write checks in Magaya soft-
ware, how to make deposit tickets, and to reconcile the bank account
2
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• Reports include financial reports such as Profit and Loss, Balance Sheet, 
and Cash Flows; other reports you can make include sales and purchase 
reports, trial balance, transaction details, and more

• Additional topics include working with the Tax Table, setting up your 
company divisions and document numbering in Magaya software, 
creating Journal Entries, working with multicurrencies, and more

Customize Accounting Features for your Company:

You can set up your Magaya system to customize and automate accounting 
procedures. For example:

• Rates: Enter custom rates that apply to specific customers as well as 
general rates that apply to all your customers. You can also enter rates 
from your carriers so they are ready to use when creating shipments.

• Recurring Invoices: Automate the creation of invoices for specific 
customers to save time each month and ensure all charges are included.

• Enter commissions for salespeople and profit sharing rates for agents.

To learn more about other customization features, please see the Magaya Soft-
ware Customization Manual available on the Learning Center, available from 
Page One. Our website also lists professional services available from our 
company such as EDI integrations and custom documents. Also ask about 
accounting documents for Panama, Colombia and other countries.

Contact and Help Resources

Help with the software is available in a few different places and formats for your 
convenience. We know that reading a full user manual isn’t for everyone, so we 
also have a searchable knowledgebase that you can access from Page One, the 
welcome screen in your software.

Page One is the welcome screen in your software with links to resources and to 
Magaya Tech Support. You can request Tech Support and check on the status 
of a request, find the user manuals and link to the Knowledgebase to search for 
topics.
 3
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Click the Help menu in the top toolbar of your software to access resources such 
as videos, user manuals, the Knowledgebase, and more.

Tips and suggestions are available in Magaya software on dialog boxes and other 
locations in the software program.
4
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Hover over the “Magaya Tip” button to see a quick tip or link to more resources 
such as how-to articles and videos.

It is recommended to leave the Tips on, but your system can be set to turn it off; 
go to: the Maintenance folder > Configuration > General.

Video tutorials are on www.magaya.com and YouTube.com

If you have any questions or require assistance, please contact Magaya at:

Phone: (786) 845-9150

Email:support@magaya.com
 5



Chapter 1 Introduction to the Accounting Manual
You can request Tech Support from Page One, the welcome screen in your soft-
ware, and check that status of an existing support case.
6
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Chapter 2
Introduction to Accounting in Magaya

All Magaya products include a complete accounting system that is integrated 
with the operations features in the software. For example, when you add charges 
to a Warehouse Receipt or Shipment, the Magaya system transfers all the infor-
mation so you can create bills, invoices, and other accounting transactions 
easily.

The following diagram illustrates the accounting processes and the financial 
reports included in the Magaya system:

The accounting system also includes financial reports such as the balance sheet 
and the profit and loss report that you can create in Magaya Explorer.

There is an Accounting Wizard you can use when you first install the Magaya 
software. This will help you set the beginning balance of all the accounts as of 
the date you start using the Magaya system. See Chapter 3 "AccountingWizard" 
in this manual for details or the following article in the Knowledgebase:

http://knowledge.magaya.com/#/article/accounting_wizard
8
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Accounting Folder Overview

The Accounting folder includes a list of functions to enable you to perform 
common accounting transactions such as create invoices, bills, payments, 
deposits, and checks and to enter rates:

The following is a brief overview of the features in the Accounting folder (each 
of these topics is covered in detail throughout the Magaya Software Accounting 
Manual):

• Chart of Accounts: This is the general ledger accounts definition (where 
you enter the accounts definitions). It helps you keep track of your income 
and expenses by categorizing them by type. You can add accounts that are 
specific to your business. You can have one account such as “Documenta-
tion” for many different items such as the different types of documenta-
tion that you charge for, including EEI, air waybills, bill of lading, etc., or 
you can create an account for each one.

• Items and Services: This shows codes for the services you provide such as 
ocean freight and the account name that service is associated with. You 
will use these items when creating and working with Accounts Receivable 
(AR) and Accounts Payable (AP) transactions.

• Invoices (and Invoice List): These are your Accounts Receivable (AR) 
transactions. The following are types of AR transactions:

– Add Invoice: this is for regular invoices

– Add Credit Memo: this is for a refund. You send it to a customer if 
you overbilled them. It is also used for agents you owe money to; the 
credit memo is automatically generated during Liquidation.

• Bills (and Bill List): These are your Accounts Payable (AP) transactions. 
The following are types of AP transactions:

– Add Bill: for items that do not have bills such as the rent, salaries, etc. 
(you do not have to make a bill for these; it is optional)
 9
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– Add Bill Credit: if you overpaid a vendor (or they overbilled you), 
then you make a record of the credit they give you. If you owe them 
a balance, you might deduct it from that balance. When you write 
the check, the Magaya software will subtract the credit. If they send 
you a refund check, you can create a Payment which will be a 
Vendor Refund.

• Payments (and Payment List): When you receive payments from 
customers, the payments will be listed here. You can create a customer 
payment or a vendor refund here by selecting it from the dropdown arrow 
of the “Add” button. Types of payments you can make:

– Customer Payment: Used to record what a customer pays

– Vendor Refund: Used when a vendor sends you money (a refund, 
maybe they overcharged you)

• Deposits (and Deposit List): This records your deposits to the bank. Types 
of deposits are:

– Deposit Payment: to deposit a payment you received from a 
customer

– Deposit: to deposit monies from any other source such as a loan

• Checks(and Check List): This records the checks to make payments to 
your vendors. The following are the types of checks you can create:

– Pay Bills (check): to pay regular bills

– Check to Expense: to pay for items that you do not have bills for such 
as rent, salary, etc.

– Refund Check: a check that you create to give your customer a 
refund

– Pay Sales Tax: a check to pay sales taxes that you collect from 
Accounts Receivable (AR).

These topics are explained throughout the Magaya Accounting Manual. To find 
any topic quickly in the PDF, go to the Index and click on the index word. Also 
see the Knowledgebase for articles.

For details on using rates and how to automate some accounting tasks, see the 
chapter “Automated Accounting” in the Magaya Software Accounting Manual.

Navigating: For any list, you can right-click on an entity or transaction to access 
a pop-up menu of options. The same menu is available from the Actions button 
in each list. You can also see open transactions for any customer, vendor, etc. by 
right clicking on the entity name in the Maintenance folder.
10
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Configure your Accounting System

When you first begin using Magaya software, we recommend that you enter 
accounting data to customize the system to your company’s needs. Start with 
the Accounting Wizard, which is explained in the Accounting manual, or see 
the following article in the Knowledgebase:

http://knowledge.magaya.com/#/article/Configure_accounting

This will help you set up your document numbering system and how to make 
system-wide settings related to currency and more. Settings per customer are 
made in the Customer’s profile dialog box (in the Maintenance folder). Addi-
tional customization information is available in Chapter 11 “Automated 
Accounting” and in the following article in the Knowledgebase:

http://knowledge.magaya.com/#/article/intro_automated_accounting

Also see the sections on Permissions and Roles in Chapter 4 of the Magaya 
Cargo System User Manual. This will help you set access for employees to 
accounting functions in the software.

We also recommend reading the section “Relationship between Accounting 
and Operations” in Chapter 10 of the Magaya Software Accounting Manual.

Magaya Corporation also offers training in the software in general and specifi-
cally for accounting staff and managers, customizations of documents, 
importing your company’s previous accounting data, and more. Contact your 
Magaya Logistics Advisor for options and prices.
 11
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Chapter 3
Accounting Wizard Overview

The Accounting Wizard is designed to help you enter your company's 
accounting information into the Magaya system. This is an easy way to enter the 
beginning balances for accounts, customers, and vendors as of the date you start 
using the Magaya system.

Setting up this information is usually done when Magaya software is first 
installed. If this wizard was not used then, it can be used now or at any time. It 
is recommended that you use this accounting wizard and the Startup Wizard. It 
is especially important if you will be working in more than one currency that 
you select the home currency to match the currency of your country in the 
Startup Wizard; home currency will affect tax transactions. The Startup Wizard 
is explained in the Magaya Cargo System Operations Manual.

The Accounting Wizard helps you set up your:

• Chart of Accounts (also called the general ledger)

• Items and Services

• Opening balances of your customers and vendors

Each screen in the wizard contains instructions to help you work through the 
wizard. You can go forward and back in the screens to change information. 
When you finish the wizard, all the information is saved in your Magaya system.

Additional setup of accounting related options can be done in the Maintenance 
> Configuration menu. See the Knowledgebase:

http://knowledge.magaya.com/#/article/Configure_accounting
13
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Enter Information in the Accounting Wizard

Go to the File menu and select “Accounting Wizard”.

The Welcome screen opens:

Click the "Next" button to start the wizard.

Select the month that you want to assign as the beginning of your fiscal year. 
This is required to calculate earnings for the year. The system will use this 
month to automatically close the year.

On the Chart of Accounts screen, add or edit accounts as needed. (The software 
provides a default list of accounts. It is recommended that this information be 
entered in the wizard so you can use the accounting features in the Magaya soft-
ware.)

Also enter opening balances for accounts that you need such as petty cash and 
bank. (For more details on entering opening balances, see the topic:

http://knowledge.magaya.com/#/article/opening_balances
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This is the wizard screen for the Chart of Accounts:

• The opening balance is used by the system to create a journal entry that 
credits that account for the balance and debits the beginning balance 
equity account.

• More details about the Chart of Accounts can be found in the topic:

http://knowledge.magaya.com/#/article/chart_accounts

On the Items and Services screen, add or edit the Items and Services as needed. 
(The software provides a default list of items and services. To add a new item or 
15
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service, click the Add button. Existing items can be changed by using the Edit 
button.) This is the wizard screen for the Items and Services:

For more details on Items and Services, see the topic “Items and Services” in the 
Knowledgebase:

http://knowledge.magaya.com/#/article/items_services

On the next screen, enter opening balances for forwarding agents. In the 
Magaya system, forwarding agents are considered “customers”. Add or edit 
opening balances by clicking on the Add or Edit buttons for:

• Customers (this includes forwarding agents). When you enter the opening 
balance for a customer, the system will automatically create an invoice for 
the customer for that amount that will go to AR, and the line item will be 
assigned to the Items and Services for beginning balance income. The 
screenshot shows forwarding agents; the Customers screen functions the 
same way.

• Vendors (this includes carriers, sales persons, and warehouse providers). 
The system will automatically create a bill and send it to AP, and the line 
in the bill will use the beginning balance expense.
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• The wizard screens for each of these functions the same way.

Click the Finish button when you are done. Your information will be saved.

After completing all the screens in the Accounting Wizard, you can modify and 
add to the information entered at any time by opening the Accounting folder or 
by returning to the Accounting Wizard.
17
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Entering Opening Balances

Entering Opening Balances

To enter opening balances in your Magaya software, follow these steps.

This procedure is recommended after using the Accounting Wizard to set up 
your accounting details.

Before beginning the steps below, have a trial balance report that lists all your 
profit and loss accounts from your previous system so you can enter the data 
from it into your Magaya system. You may already have a report that you used 
to enter details in the Accounting Wizard; you can use the same report for this 
procedure.

Steps to Enter an Opening Balance

1) Create a Trial Balance Report in your Magaya system:

• Go to the Accounting folder > Chart of Accounts

• Click the Actions button and select Reports > Trial Balance
18
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• Find the opening balance income and expense

This trial balance report displays all the data you entered in the 
Accounting Wizard.

Note: The Trail Balance report can be viewed on a cash basis or 
accrual basis. Select the option from the Configure button on the 
report toolbar, and select the “Financial” tab.

2) Create a Journal Entry in your Magaya system:

• Go to the Accounting folder > Chart of Accounts

• Click the Actions button and select General Journal Entries.

• Click the Add button to open a Journal Entry dialog box.

3) Add the following items in the Journal Entry dialog box:

• Click the Add button to activate a line in the detail table.
 19
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• In the Account Name column, select Opening Balance Income.

If there was a Debit in the Trail Balance, then enter the amount in 
the Credit column. This reverse is required for this step.

• Click the Add button again, and in the Account Name column, 
select the Opening Balance Expense. If there was a Debit amount for 
this expense in your Trial Balance, enter the amount in the Credit 
column. This reverse is required for this step.

4) Enter your other account names in the Journal Entry dialog box. For 
example, enter the debit and credit for the air freight income and cost.

Continue to enter all your accounts. If you had an account in your 
previous system but it is not showing in the Magaya list of default 
accounts, you can create it: Click the Plus sign in the dropdown menu of 
the Account Name column and add the account.

5) To make the debit and credit totals equal, add the account “Opening 
Balance Equity” and enter the difference between the credit and debit 
amounts. If the debit is short, enter the difference in the Debit column. If 
the credit amount is short, enter the difference in the Credit column.
20
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6) Click OK in the Journal Entry dialog box to save.

Now your the Debits and Credits are equal, and the opening balances are 
complete.
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Chapter 4
Chart of Accounts: Introduction

The Chart of Accounts is a list of accounts in your general ledger. It helps you 
keep track of your income and expenses by categorizing them by type. Then you 
can generate reports to see the different types of income you are bringing in and 
what types of expenses you have.

The Magaya system has many accounts in the Chart of Accounts folder by 
default. You can add accounts that are specific to your business. You can have 
one account such as “Documentation” for many different items such as the 
different types of documentation that you charge for, including EEI (formerly 
SED), air waybills, bill of lading, etc., or you can create one account for each.

The following screenshot shows a close-up of the Chart of Accounts, high-
lighting the Air Freight Cost, Air Freight Income, and their account type.
23
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Add to the Chart of Accounts

Step-by-Step Procedure:

1) Go to the Accounting folder and click "Chart of Accounts".

2) Click the “Add” button. A dialog box opens:

Use the first dropdown menu to select a type of account. The Type 
“Accounts Receivable” displays by default. Choices are:

• Accounts Receivable (AR): This is the money that is owed to you 
(considered an asset).

• Accounts Payable: (AP) This is money that you owe (considered a 
liability).

• Income: Defines where money comes from.
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• Expense: Used to define what you are spending money on.

• Cost of Good Sold: Use this to determine the cost of the items you 
sell.

• Bank: Use this account for checking and savings transactions, 
money market accounts and petty cash.

• Undeposited Funds: Money you hold to deposit later.

• Fixed Assets: For equipment or furniture that will not be converted 
to cash within one year.

• Other Assets: Use this account designation for any asset that cannot 
be classified as Fixed or Current.

• Other Current Assets: For notes receivable that are due within one 
year, inventory value, etc.

• Long Term Liability: Accounts that are due over a long period of 
time such as a mortgage, over one year.

• Other Current Liability: Due within one year. Examples are sales tax.

• Equity: The net worth of the company.

• Credit Card: Create one “Credit Card” account per card to track 
business expenses paid for with the credit card. (You will also need 
to add the credit card company as a Vendor in the Maintenance 
folder.)

3) Enter the account name and number.

4) Select a parent account as needed. This allows for grouping accounts in 
reports (such as all freight accounts grouped together or all documenta-
tion, etc.)

5) Options: Add any notes as needed. The “Inactive” box is available if you 
do not want to use this account in the future.
25
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Actions in the Chart of Accounts

The Actions button in the Chart of Accounts screen gives you many options.

The following actions can be performed by clicking on the Actions button:

• Other Reports: This option generates reports by name, type, account 
number, currency, parent account, or by type code.

• Reports: This option offers the same list of reports as the “Reports” menu 
option on the top Magaya Explorer toolbar such as Profit & Loss, Balance 
Sheet, taxes, General Ledger menu, and more.

To create a cash basis report, click the Configure button in the report 
screen toolbar, and click the “Financial” tab.

• Transaction Listing: This enables you to see a list of transactions when 
you click on an asset or liability in the list. (This option is grayed out if you 
select income or expense.)

• Reconcile: Use this option to reconcile the Bank Account. A screen opens, 
showing deposits and credits, checks and debits, balance totals and more. 
You have the option to add, edit, or delete transactions.

• Replace Account: Use this to replace an account of the same type. The 
account will be replaced in any transactions where it has been used. This 
 26
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is useful if an account has been duplicated or used incorrectly. After the 
account is replaced, you can disable or delete the old one.

• General Journal Entries: This shows you a list of general journal entries. 
To learn how to add a new journal entry, see Chapter 10 in the Magaya 
Software Accounting Manual, the topic “Journal Entries”. 

• Divisions: This shows a list of divisions, if your company has divisions. 
For details on how to set up divisions, see the Divisions topic in the 
Magaya Software Customization Manual.

• Tax Table: This shows a list of sales taxes (for merchandise you sell, not 
services). For details on how to add sales tax to your Magaya system, see 
the topic “Sales Taxes.” 

• Choose Columns: Use this to select the columns you want to see.

• Import (and Export): Use these options to send data from the Magaya 
database or bring data into the Magaya database in XML or CSV formats.

To view more details for an account, click the “Detail” button to open the 
Details panel.

Configure Default Accounts

Default accounts can be defined for AR, AP, and banking. Then the system uses 
these accounts when new transactions are created. If a default is not set up, the 
system uses the account present in the last equivalent transaction.

To set up default accounts, go to Maintenance > Configuration > Accounting.
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Find the option “Configure default accounts.”

Click the “Accounts” button. A dialog box opens.

Select the default accounts from the dropdown menus. These are system-wide 
settings. To set your preferences for specific customers, go to the Maintenance 
> Customers list. For more details on the Configuration menu, please see 
Chapter 10 of the Magaya Software Accounting Manual.

See also the Knowledgebase:

http://knowledge.magaya.com/#/article/Configure_accounting

Inventory Accounts

If you buy and sell inventory, you can manage the accounting in Magaya.

The software includes accounts for inventory, sales income, and cost of goods 
sold. You can also choose the costing method for inventory, either by average 
cost or by exact price per item which you specify. The accounting is shown in 
the Adjustments tab of invoices and in the Balance Sheet.

Landed costs for freight can also be managed in the system. For details, see the 
sections in the Magaya Software Accounting Manual for Landed Costs, Average 
Cost, and Accounting Configuration.

How to create and manage Purchase Orders and Sales Orders is included in the 
Magaya Supply Chain Solution Operations Manual.
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To customize and automate your accounting processes, please see Chapter 11 of 
the Magaya Software Accounting Manual.
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Chapter 5
Introduction to Items and Services

The “Items and Services” list in Magaya Explorer shows all the items and 
services your business buys and sells such as documentation services, freight 
services, crating fees, and more. Items and Services are used for sales reports 
such as how much ocean freight you sold or purchased, etc.

Magaya software comes with a predefined list of items and services that will 
cover the needs of a standard logistics provider. You can modify it or add more 
to it based on your specific needs.

Items and services are used in Accounts Payable and Accounts Receivable. 
When you use an item or service in an invoice, the line in the invoice will affect 
the account that this item applies to by adding or subtracting from it whether it 
is an invoice or a credit. The account will show in the Profit and Loss report.
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Add Items and Services

To add an item or a service to your Magaya system, follow these steps.

1) Click on the Add button in the Items and Services subfolder. A dialog box 
opens:

2) Select the typeof item (or service). When you select a Type, it will not be 
an income or expense until you also select the Account type. Types of 
items and services available from the dropdown are:

• Other: Use this for items (or services) that cannot be classified as 
Freight or as one of the other types listed.

• Freight: Use this for freight items (or services) such as Ocean 
Freight or Air Freight.

• Valuation: When you use this type to create an item, this value 
(value of the cargo) will appear on air waybills.
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• Tax: This is used for taxes such as duty taxes, and the amount will 
appear in air waybills. Note: If more than one tax needs to be applied 
to this item, then create a group for those taxes first, and then select 
it from the Tax Code dropdown in this screen.

• Other Freight: Use for items (or services) that relate to freight but 
are not actual freight such as Fuel Surcharge cost and income.

• Inventory: Use this for items that you keep in your inventory and 
sell. If you select “Inventory” then the “Assets Account” and “Inven-
tory Item” dropdowns will be available.

3) For the “Tax Code” field, select a sales tax to apply to the item or service. 
(To set up the sales tax, go to Chart of Accounts, Actions button, Tax 
Table.)

4) Enter a description of the item. The “Code” field will fill in automatically 
based on the description.

5) Select an account the item (or service) will refer to in the general ledger 
(select the account you want when you run your income statement to see 
this item reflected in, depending on how detailed you want your income 
statement to be). The item (or service) will be income, expense or cost of 
goods sold depending on what account it is related to. For example a 
storage fee is assigned to a Cost of Services account. Ground Freight 
Income is assigned to a Ground Freight Income account.

6) Enter a price. If you want to have the price calculated, use the “Tariff” 
button. For details on using the Tariff dialog box, see Chapter 11 in the 
Magaya Software Accounting Manual.

7) If you check the box to indicate this is a resaleitem, the fields below the 
checkbox will become available:

• The checkbox “Create related resale item automatically” is used if 
you want your Magaya system to automatically create a resale item 
when either a manual expense or income charge is created.

• Income Item (or Expense Item): If you selected an Income Account, 
then this field will be “Income Item”.

• Preferred Vendor: This may be grayed out.

• Assets Account: For purchasing inventory and reselling it. (This will 
be activated when you select the Type as “Inventory”).

• Inventory Item: Select from the items in the dropdown or add a new 
item. (This will be activated when you select the Type as “Inven-
tory”). This pulls from information from the Inventory Item Defini-
tions that are located in the Warehousing folder.
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• Landed Costs: This tab only appears if your system is configured to 
be active. This cost includes transportation costs of an item. For 
details, please see the topic “Landed Cost Management.”

8) Click the OK button when done. The item (or service) now appears in the 
list.

Automatic Creation:

If you want to make an item/service appear automatically on a transaction, click 
the “Automatic Creation” tab. Check the box to enable the automation, and 
select the transactions. If you don’t want the charge to appear in the documents, 
check the box.

Full details about automating charges are explained with examples in the 
chapter “Automated Accounting.”

Dependent Charges

If an item/service depends on other charges, check the box to enable that depen-
dency. This function enables you to set the order that the system will calculate 
the charges in a transaction. For example, use this option if you have a service 
for freight, and you want the insurance charge to depend on the freight charge. 
Then the system will calculate the freight charge first, and then calculate the 
insurance based on the freight charge.

Another example of a dependent charge could be a Documentation fee that you 
want to calculate based on a percent of the shipment profit. In this case, the 
shipment profit is calculated first, and then the documentation is calculated as 
a percent of that total.

Enable: On the “Automatic creation” tab, check the box to enable the function.
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Select a dependency level from the dropdown menu.

The following shows an example of a dependent charge using the percent of 
agent profit sharing tariff. The dependency can be used for any item/service.
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In this example, we set the tariff at 10% of the profit (via the “Tariff” button on 
the “Definition” tab of the Items & Services dialog box):

Save the percent and go to the “Automatic Creation” tab of the Items & Services 
dialog box. Check the box to enable dependencies.

Then set the dependency by using the dropdown menu.

The Items & Services List has columns available to show the dependency level 
number and if the charge has dependencies (Yes or No).

Let’s look at how the system processes different dependency levels: For example 
setting the dependency at "1" will tell the system to calculate the charge at the 
same level as the ocean freight charges.
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But if you set the dependency lower such as "4" then the system will calculate the 
percent of profit afterother charges that may be on the shipment such as a 
Repacking fee (if they have been set at a higher dependency such as a 1, 2, or 3).

As with many features in the software, we recommend creating a sample trans-
action to ensure this functions the way you want it to. You can always return to 
the Items & Services dialog box to make changes.

Priority of Charges

The Priority feature determines how the charge for an item/service will appear 
in a document, in LiveTrack, and in Transaction Tracking email messages. This 
is useful for transactions with many charges; you can tell the system which 
charges to display at the top of the list of charges (Priority = 1) or sort it any 
other place in the list.
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Select a number from the dropdown to set the priority of this charge.

Click “OK” to save.

Actions Performed with Items and Services

To make reports based on the Items and Services, use the Actions button and 
select “Reports” from the pop-up menu.
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The following sales and purchase reports are available:

The reports will be generated using the transactions for the items and services.

Other Actions available from the Actions button include the option to choose 
the columns you want in the list, and to import or export the data in or out of 
the Magaya system.

Replace Item: You can find and replace any existing item of the same type, and 
the system will update all the transactions that have that item in it. When you 
open the dialog box from the Actions menu, select the items to find and replace:

The Find and Replace feature is useful if an item has been duplicated or not used 
correctly. After the item is replace, you can choose to disable or delete the old 
item.

Extra Information:
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The Items and Services list can be filtered by using the Standard or Advanced 
Filter. For details on filters, see Chapter 5 in the Magaya Cargo System Opera-
tions Manual.

For more details on working with inventory and resale items, see the section 
“Add Resale Items” in Chapter 7 of the Magaya Supply Chain Solution Opera-
tions Manual.
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Chapter 6

Introduction to Accounts Receivable

Accounts Receivable (AR) is money owed to you in outstanding invoices. The 
sections of this topic will explain how to create the following transactions in 
Magaya software:

• Invoices

• Credit Memos

• Payments

• Deposits

• Refunds

All of these transactions are created by using a dialog box that transfers all the 
data into the document forms. The data is also saved in your Magaya system so 
you can create reports and more.

Magaya Explorer offers AR reports to show which customers are overdue (aging 
reports), open (unpaid) invoices, and sales reports.
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Create Invoices

To create invoices in Magaya Explorer, follow these steps.

1) In the Invoice (document or list), click on the Add button. Select “Add 
Invoice” from the pop-up menu.

The Invoice dialog box opens. On the first tab, enter details of the transac-
tion. Enter details in the Events, Attachments, Notes tab, and Internal 
Notes tabs as needed. Events and any attached documents or photographs 
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will be visible to customers in the interactive online tracking tool, Magaya 
LiveTrack.

Note: When working in the Document view, you can quickly see the status 
of the invoice by looking at the symbol in the document toolbar next to the 
navigation arrows:

The List view also has a Status column which indicates if an invoice is open 
or paid. Other columns can be added via the Actions button.

2) Enter information in the Invoice dialog box:

• The Invoice number fills in automatically. For information on 
setting up the numbering of invoices, see the topic "AccountingCon-
figurationMenu".
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• Select the customer that you are invoicing from the “Apply to” drop-
down menu. The customer’s address and Payment Terms (if set) are 
filled in from their profile.

• Select “Accounts Receivable” for the Account field. If you are 
working in multiple currencies, there will be at least one account 
available in the dropdown for each currency. To make the invoice in 
one of those currencies, select it from the dropdown list. For infor-
mation on setting up your Magaya system to work with multiple 
currencies, see the topic "Multicurrencies".

• The Transaction Date is set to today’s date. NOTE: If you don’t want 
an employee to change dates, deny access in Roles. Go to the 
Employee list, right-click their name and select Roles.

• When you select the payment terms, the Due Date field will update 
automatically. If you have pre-defined payments terms for your 
system or for this customer, the Payment Terms field will fill in auto-
matically.
45



Chapter 6
• Add Charges: Click the “Add” button in the Invoice dialog box to 
add charges to this invoice. A new dialog box opens:

The Type you apply pulls information from the Items and Services 
list. The Type dropdown list for invoices will show you only Items 
and Services that refer to Income accounts.

Add a description (optional). Additional information can be added 
in the Notes tab. Remember: Any notes you add will appear in the 
invoice for the customer to see.

The Tax Code pulls from the Sales Tax Table.

Enter the Quantity and Price. The Amount will be calculated auto-
matically. The Unit can be a word such as “pounds”, “lbs”, or “each”. 
The Unit field is optional.

Click the OK button. The charge fills in on the line in the Invoice 
dialog box. You can add as many charges to the invoice as needed by 
using the Add button. The totals are calculated. If you need to delete 
multiple charges, select them by holding the Shift key on your 
keyboard and clicking the “Remove” button.

• If you need to edit a charge, select the line item for the charge and 
click the Edit button. To remove (delete) a charge, select the line 
item for the charge and click the Remove button.
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• To add an Account line to an invoice, click the “Accounts” tab.

This can be useful if you need to re-issue an invoice because a 
customer had non-sufficient funds (NSF) and their check bounced. 
Another example is if you want to offer a customer a discount. For 
details, see the section “Accounts Receivable Special Procedures” in 
Chapter 10.
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• If this invoice is related to a transaction such as a shipment or a WR, 
a button for that transaction will appear on the invoice dialog box. 
View the transaction by clicking the button.

A periodic invoice will display a “History” button that will show all 
related transactions.
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3) Click OK when you are finished entering all the information for this 
invoice. The data is transferred into an invoice form, and it is saved in your 
Magaya database.

The invoice form can be changed by clicking the Actions button and 
choosing “Select Template”.

In the dialog box, you can choose different templates and link them to this 
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transaction or set the template as the default.

If you click the “New” or “Copy” buttons, the Magaya Document Designer 
opens. This program is used for customizing templates. See the Magaya 
Software Customization Manual for details.

You print this invoice from the document view or print multiple invoices 
the list view.

If an invoice is related to a shipment, you can include that information in the list 
of invoices: Go to the Invoice List > Actions > Choose Columns > Master Ship-
ment Name.

If you want to see the currency rate in the Invoices List, add a column for the 
exchange rate from the “Choose Columns” option on the Actions menu.

Actions for Invoices

The Actions button for Invoices provides many features. You can access 
Actions while you are in the Invoice document view or in the Invoices List view. 
Hover over the Actions button and click the arrow on the side of the button.
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The following Actions are available from the Document view:

The Actions button in the Invoices List view contains these options plus more:

The Cargo Reports relate the operations and accounting information in the 
Magaya system, enabling you to see reports such as how much you have billed 
for certain ports or destination agents.

Sales Reportsthat can be created are:
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• Open Invoices: View a report of open invoices. When the report opens, 
you can modify the report by choosing what columns to view, change the 
date range, filter the list, save or export it.

• Open Invoices by Date: To view invoices that were open as of that date, 
regardless whether the invoice was paid after that date.

• A/R AgingReports: Select a report that shows details itemized or a 
summary to view what is overdue.

• Invoice Details: A list of all invoices, including the detailed, itemized lines 
for each invoice.

Other Actions button options:

• Export the list to QuickBooks® or PeachTree® (Sage) accounting software 
programs to export the invoices you have filtered and to save them on 
your computer (or other directory) in a file format that can be opened in 
those applications.

• Import invoices into your Magaya system: First format the data into CSV 
in a spreadsheet or plain text file. See an example in the section “Import 
Invoices.”

• Go to a Document when you click on an invoice.

• Print a batch of invoices that you have in a filtered list. In the printing 
wizard screen, there are options to select printers and templates.

• Exclude the invoice from tracking online
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• Approve/Disputean invoice (this option is available from the Actions 
button in the Invoices List or if you right-click on an invoice in the list.

To approve or dispute invoices, the customer profile must have this Web 
Track access configured by right-clicking their profile; see Chapter 10, 
“Advanced Accounting Features” for details.)

Click the button to either approve or dispute. Enter the reason in the 
dialog box.

The comment appears in the Events tab for the transaction.

• Receive payment for an invoice that you have clicked on. A dialog box 
opens. See the section “Payments.”

• For details in using the online payments option, see Chapter 9 in the 
Magaya Software Communications Manual.

• Void a transaction you have selected.

• Save as Recurrent: This will convert the selected invoice into a Recurrent 
Invoice that can be charged to the customer every month (or time period 
you set). Steps for creating recurrent invoices are explained in Chapter 11 
of the Magaya Software Accounting Manual.

• Copy an invoice.
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• To view a list of recurrent invoices, use the Actions button and select 
“Recurrent Invoices”.

• Open Transactions: This options creates a list of all open transactions. 
Change the date range to see the time period you choose, or customize the 
list via the Actions button > Choose Columns.

Other options in the Invoices List enable you to choose the columns or view the 
History of an invoice by selecting the invoice and the History option in the 
Actions button list.

All of the above actions are also available when you right-click on a transaction 
in the list.

To view more details about an invoice, select it and click the “Detail” button in 
the list view. This gives you more information in one glance.
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Import Invoices

Import Invoices into your Magaya System

To import invoices into your Magaya system, first format the data into a 
Comma Separated Value (CSV) file. This can be done in a spreadsheet or a plain 
text file. Certain data is mandatory and other fields are optional. Create these 
fields as columns in the CSV file.

Mandatory fields:

• Entity name (the customer or vendor name)

• Transaction number (such as the invoice number)

• Date of the transaction (in contrast, the due date is optional)

• AR/AP Account (which account the transaction is assigned to such as 
Accounts Receivable; if you need to learn more about accounts, please see 
Chapter 4 in the Magaya Software Accounting Manual)

• Charge count

• Quantity (For example, this invoice includes a Documentation charge and 
a Packaging charge, then it has two charges in this invoice)

• Charge Name (for example, Documentation or Packaging)

• Unit price (the price for one of the charge)

• Amount (the total of the charges for this line: The Amount must equal the 
Quantity multiplied by the Unit price. For example, if you have one Docu-
mentation fee which costs $50, then the Amount must be 1 x 50, which is 
50 in this example.)

Optional fields:

The following data for these columns is optional:

• Due Date

• Notes

• Charge Description
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Steps to Import Invoices into your Magaya system:

1) Go to the Invoices list.

2) Click Actions > Import. A wizard opens. The wizard has two import 
options: by CSV or XML.

Extra Info: The columns in this dialog box are the same as the columns in 
your Invoices list. To change them, close this dialog box and make the 
changes to the columns in the list first (via the Actions button > Choose 
Columns). Then open this dialog box again.

3) Click the “Import CSV” button in the dialog box.

4) Browse to the file location on your computer or network, and click OK to 
import it. Verify the data in the Invoices List.

Here is an example of two invoices and one credit memo imported:
 56



Chapter 6 Import Invoices
Options: To make changes to an invoice before it’s imported, select it in the list 
to highlight it and click “Edit.”

Click “Save” and close the dialog box. The invoices are now saved to your 
Invoices List where you can work with them.

If you experience any errors during importing, verify the columns in the CSV 
or text file.

Note: The same process can be done to import bills into your Magaya system.

For tips on using the wizard to import data, see:

http://knowledge.magaya.com/#/article/import_wizard_tips
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Print Invoices to a Fiscal Printer

Fiscal Printer Overview

Fiscal printers are often used in countries in Latin America such as Panama and 
other regions to collect tax revenue data. Your Magaya system can be config-
ured to print invoices to a fiscal printer by selecting the printer model, etc. in the 
Configuration menu. Magaya also has a check template that complies with 
Panama’s banking regulations.

This article explains how to:

• Configure a fiscal printer in Magaya

• Print an invoice to a fiscal printer

• Select the check template for the standard check format in Panama

• Perform the close of day procedure
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Configure a Fiscal Printer

To use a fiscal printer with your Magaya system, first configure it.

Check the box to enable the fields on the screen.
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Print Invoices to a Fiscal Printer

To print an invoice to the fiscal printer, go to the document view of the invoice, 
select “Print > Print with Fiscal Printer.”

The system verifies to determine if the invoice was printed already. If the invoice 
was already printed, then an error message will display. The system will ask you 
to confirm that you want to print because after it is printed, the invoice cannot 
be deleted (unless an admin configures the system to allow it). The charge must 
use the defined tax rates.

The only fields of an invoice that can be changed after it was printed to a fiscal 
printer are the invoice number, the Division, payment terms, due date, if it was 
prepaid or collect. The charges cannot be changed after printing.

Tax Rates: The charges in the invoice must have tax rates that match the tax 
rates of your fiscal printer.

A record of the printing is now displayed in a new tab on the Invoice dialog box:
60



Print Invoices to a Fiscal Printer Chapter 6
Also view what has been printed by choosing the columns “Fiscal Transaction 
Number” and “Print Time” for the Invoices List.

Cancel an Invoice Printed to the Fiscal Printer:

To cancel an invoice printed to the fiscal printer, enable the option in the 
Configuration menu. Then create a credit memo. A credit memo can be created 
for an invoice in a partial amount. If more than one credit memo is created for 
this, then the total amount cannot exceed the amount of that invoice.

To create this credit memo, go to the Invoice List, right-click and select “Create 
Credit Memo.” This option will only display if the invoice was printed via the 
fiscal printer. This credit memo can be printed or edited to cancel only certain 
charges in it. To see all the transactions related to a credit memo, click the 
“Detail” button on the List. You cannot delete an invoice that was fiscally 
printed and included in a shipment.

To search for a fiscally printed invoice, use the Quick Find option and select 
“Invoice” as the transaction type and enter the fiscal transaction number.

To add the RUC number to any entity involved in a fiscal transaction: Go to the 
entity profile, on the General tab, enter the RUC number in the field “Identifi-
cation Number.” Select “Other” for the type.
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Download and Use the Panama Check Template

The Magaya system includes a check template that was developed to comply 
with Panama's banking regulations for commercial checks. Follow the steps 
below to download it into your Magaya system and use it.

1) Download the check: Go to File > Download Document

2) Select the check template and set it as the default for your system (setting 
it as the default is optional but recommended for Panama):

- Go to Accounting > Checks.

- Click the Actions button > Select Template

The template is “Cheque - Formato Estandar Panama - v1” (Plantilla 
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Estandar de Cheque para Panama).

3) Create a check by clicking the Add button.

The details you enter in the dialog box fill into the check template.

The template includes the check and the check stub.
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Close of Day Procedure

To close a fiscal session and print a report of all the operations that took place 
during this day, go to “Accounting” on the top menu and select “Close of Day” 
from the dropdown menu.
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Credit Memos

Credit Memos are issued if you overbilled a customer or if you need to give a 
discount after creating an invoice. (Note: Discounts can also be created another 
way; see Chapter 10, section “Accounts Receivable Special Procedures”.)

Follow the steps below to create a Credit Memo.

1) Go to Invoices (document or list view) and click the Add button. Select “Add 
Credit Memo.”
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A dialog box opens with the following tabs: the first tab is used for all the credit 
memo transaction details; the others are for Events, Attachments, Notes, and 
Internal Notes.

• The fields in this dialog box are the same as in the Invoice dialog box. See 
the Invoices section for details. Reminder: All amounts will be treated a 
negative (a subtraction) for the selected accounts and items.

When a credit memo has been paid to the customer (either in a check or credit 
on a balance), the status will be updated in the Invoices List. You can also see the 
status on the toolbar similar to the Invoices.

When you enter this transaction, it will show a negative (deduction) in 
Accounts Receivable.
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Enter Payments

A Payment is a check or credit card payment that you receive from a customer. 
This process creates a record of the payment in your Magaya system. To create 
a Payment:

1) Go to Accounting > Payments.

2) Click the Add button and select “Customer Payment.”
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Or, right-click from the List view and select “Receive Payment.”
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A dialog box opens.

3) Enter the information you need in the payment transaction dialog box:

• The A/R Account of “Accounts Receivable” is selected by default. 
You can select a different A/R account. For example, if you are 
working in multicurrency and select an A/R account with another 
currency, this payment will be made in that currency, and that A/R 
account will be updated with this payment transaction.
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• Select the customer who is making the payment. When you select 
the customer, you will see any outstanding invoices or credit memos 
for them. The checkbox to show open invoices is checked by default.

If payment terms were set for this customer on their profile (or set 
system-wide in the Configuration menu), then any applicable 
discount will display.

The “Suggested Discount” is the amount calculated by the system. 
The “Discount” is the actual discount applied. Click the “Apply 
Discounts” button to accept the suggested discount and apply it.

When you click the “Apply Discount” button, the screen is updated 
and the button is grayed out. (A discount can only be applied one 
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time per invoice. The invoice must have a remaining balance of zero 
to qualify for the discount.)

Option: Manually type a discount amount in the “Discount” column.

The “Accounts” tab displays the discount. The account that the 
discount is applied to can be changed on that tab if needed.

To apply a discount manually for a customer that does not have 
payment terms set, see the section “Accounts Receivable Special 
Procedures” in Chapter 10 of the Magaya Accounting Manual.

• Additional fields on the Payment dialog box:

Select the bank account to deposit the payment. The checkbox next 
to the “Deposit to” field is not checked by default. If you leave it 
unchecked, the money will be sent to the Undeposited Funds 
account in your Magaya system to hold until you go to the bank with 
all the deposits. (Then you will create a “Deposit Payment” transac-
tion in the Deposits subfolder).

• If the customer gave you a credit card number to pay with, select it 
here. (To add a credit card, go to the Customer profile Pmt Tab.)

• Enter the check number from the check that the customer sent you.

• The date will be filled in with today’s date. It can be changed as 
needed.

• Enter the amount of the payment. If there are outstanding invoices, 
the payment amount will be deducted from the total. You can also 
click on the Invoices in the list to apply the payment.

• Enter a memo (note) as needed.

• Click on the invoice to be paid. A checkmark appears in the 
checkbox and the Amount Due changes to Amount Paid. To enter a 
partial payment, click in the “Amount Paid” table cell of the invoice 
and type in the amount paid. Filter the list if needed.
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• Click the OK button when done. All the information is saved, and a 
Payment document is created automatically.

The Payments List will be updated and display the new transaction.

Overpayment: You can enter an amount that is larger than what is listed 
in the Invoices screen. A notice will appear, as shown in this example:

This example shows an overpayment of $271.15. Click “Yes” if you want 
to accept the payment, or click “No” if you need to make a change. The 
difference will remain as a credit for that customer.

The next time you accept a payment from this customer, the credit will 
appear in the list. The amount can be applied to future invoices, or you can 
create a refund check.

Advanced Payment: Enter the amount in the “Amount” field and click 
“OK”. The amount will show as a “Payment” and will be available as a 
credit toward future invoices.

Wire Transfer Fees: See the section “Accounts Receivable Special Proce-
dures” in Chapter 10.
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Actions for Payments

The Actions button in Payments (list view or document view) enables you to 
create reports and more.

Reports can be created by account number, name, currency, etc. Reports can be 
configured with different fonts and more.

To view a payment, select it and choose the “Go to Document” option.

To see undeposited funds, click on this option. A list opens of funds that have 
not been taken to the bank yet.

You can also choose the columns you want in your list, export or import data, 
and view the history of a transaction.

These actions are also available when you right-click on a transaction in the list.

View more details about a Payment by selecting it and clicking the “Detail” 
button.

Customer Payment Terms

The system includes a set of default payment terms and a way to define your 
own payment terms. The terms can be used in transactions such as Quotations, 
POs, Invoices, etc. (This feature is available in Magaya software version 9.3 and 
higher.)

Payment terms can be set system-wide or per customer. You can use them to 
offer discounts to customers who pay early. Then the discount will be applied 
automatically and show in Invoices.
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If you had an account in your Chart of Accounts set up to handle discounts, you 
can still use it. If not, the system now includes one called “Customers 
Discounts.”

Below are the options for setting up payment terms:

Define your own payment terms (optional):

Go to Maintenance > Configuration > Payment Terms
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Note: Only users with permissions can access this configuration.

1) To create your own payment term, click the “Add” button. A dialog box 
opens.

2) The “Description” field is optional. If you do not fill it in, the system will 
based on the other fields.

3) The Net Due (days) field is the number of days when the transaction is 
due.

4) Enter the Discount percentage (optional) and the number of days when 
the discount will be given. In this example, the customer will receive a 5% 
discount if they pay within 15 days. Or, the total is due in 60 days.

Now this payment term will be available to use. Discounts are also shown on the 
Profit & Loss report.

System-wide Payment Terms Setup:

If you want to create system-wide payment terms for all customers, enter it in 
the Accounting Configuration menu.
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This payment term will be applied to every new customer that is created. It will 
also be the default payment term for every new invoice created, unless you 
already have set up a customer’s payment term.

1) Go to Maintenance > Configuration > Accounting.

On the “Main” tab, select the dropdown menu for “Default payment terms 
for.”

This setting will apply to all customers.
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2) Click the “Accounts” button to configure the default accounts. A dialog 
box opens.

3) Select the accounts to use for A/R, A/P, checks, deposits, and discounts for 
customers and vendors.

If you had an account defined for discounts, you can still use it.
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Set up Payment Terms per Customer:

1) To assign a payment term to a customer, open their profile and click the 
“Pmt. Terms” tab.

2) Select the payment term from the dropdown menu.

3) Click OK to save the setup. These terms will be applied to this customer’s 
invoices automatically, and the due date will be set based on the terms. (It 
can be changed at any time.)

Depositing Payments

Deposits of payments that you get from customers can be created in the 
Deposits List or document view. There are two types of deposits:

• Deposit Payment: Use this option when you are depositing money from 
the Undeposited Funds account.

• Deposit: Use this when you are making the type of deposit such as if you 
receive a loan from a bank. See the topic "Banking" for details.

To deposit a payment:
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Click on the Add button and select “Deposit Payment”:

A dialog box opens.

• Select the bank account that the deposit will go to.

• The date will be filled in with today’s date.

• Add a memo (note) as needed.

• The checkbox to show all undeposited funds will be checked by default if 
the deposit you are making is new (not existing). If the list is too long, 
uncheck the box to see only the deposits related to the transaction you are 
working on.
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• In the list of Payments, click in the checkbox of the transactions you want 
to deposit. The text will change from “No” to “Yes”.

• Click the OK button when done. A deposit ticket is ready:
 80



Chapter 6
The payment is now considered deposited according to your Magaya 
accounting system. If you are receiving payments from customers online, 
deposit those payments just as any other deposit.

Actions for Deposits

The Actions button for Deposits can be accessed from the document view or list 
view for the following options:

• Reports: By account name, memo, etc.

• Go to Document: The Deposit appears in the viewing pane.

• Void Deposit: This will void the transaction but not delete it, so there is a 
record of the void in the Transactions log.

• Print Batch: This will print the transactions you have filtered.

• Choose Columns: A dialog box opens with options to include or exclude 
columns and rearrange them.

• Export: A dialog box opens where you can select the location (folder) to 
export data.

• History: A dialog box opens showing any transactions related to the trans-
action you have selected.

View more details about a Deposit by selecting it and clicking the “Detail” 
button.

Refund Check

There are two different types of refunds you can create in Magaya Explorer:

The “Refund Check” function is located in Checks (list and document view). 
Use this when a customer overpaid you and you will write them a check for the 
amount. In order to issue a Refund Check, a credit must exist for that customer 
either as a Credit Memo or as an advanced payment or an overpayment.

A “Vendor Refund” is available in Payments. Use this when you receive a refund 
from a vendor. For details on vendor refunds, see the topic "Accounts Payable".

Follow the steps below to create a Refund Check.
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In Checks, click on the Add button and select “Refund Check”.

A dialog box opens.

• Select the A/R Account. This will pull from the Chart of Accounts. If you 
are working in multicurrency, select the account for the proper currency 
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for this check. This screenshot shows the dropdown list with the Euro 
(EUR) and Venezuelan Bolivar (VEB) included in the list:

• Select the Bank Account that you are using to pay the refund.

• Select the company that you are creating a refund check for.

• Enter a Memo if needed.

• Check the box to show all non refunded credits.

• In the Credits list, click on the credit you are working with or enter in the 
amount for each credit.

• Enter the refund amount in the Amount field.

• Click the OK button.

A refund check will appear in the viewing pane.
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Customer Statements

To view, print or email a statement for a customer, right-click on their name in 
the Customer list (in the Maintenance folder). Select the Statement option.

Select multiple customers at once to print or email a batch.
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Select the statement template. The document displays any shipping transactions 
and accounting transactions during the period of the statement. 
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7. Accounts Payable

Introduction to Accounts Payable

Accounts Payable (AP) are bills from your vendors that you need to pay. The 
sections of this topic explain how to create the following transactions in Magaya 
Explorer:

• Bills

• Bill Credits

• Bill Payments

• Vendor Refunds

To see a list of unpaid bills, use the Actions button in the Bills list. For informa-
tion on how to create reports of unpaid bills and aging AP, see Chapter 9, 
section “Purchase Reports”.
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Accounts Payable

Accounts Payable Introduction

This topic explains how to do the following accounts payable procedures in 
your Magaya system:

1) Create bills and learn what actions can be done with bills

2) Purchase a fixed asset by creating a bill for it

3) Bill credits

4) Bill payments (how to pay bills by creating a check in your Magaya
system)

5) Pay multiple vendors

6) Vendor refunds

The dialog boxes for these transactions can be expanded by clicking and drag-
ging the corner. To select more than one line at a time, click on one line and 
press the “Shift” key on your keyboard and select multiple lines. You can also 
navigate the list with the up and down arrows keys on the keyboard. You can 
also press the space bar for a selected line to pay multiple bills, invoices, etc.

The data entered in the dialog boxes is filled into the paper forms such as the 
checks or invoices. There are different templates (in the Actions button menu), 
and the transactions can be printed, saved to PDF, and emailed.

1. Create Bills

To create a bill, go to Bills (the document or list view) in the Accounting folder 
in Magaya Explorer. Bills are often created for telephone expenses, marketing, 
etc.
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Click on the Add button and select “Add Bill”.

A dialog box opens. It has three tabs: Bill, Notes, Internal Notes.

• On the Bill tab, the transaction number fills in automatically, but you may 
override this and enter the actual bill number from the vendor.

• Select the Account to the “Accounts Payable” account you need for this 
bill. If you are working in multiple currencies, there will be at least one 
account available in the dropdown for each currency. To make the bill in 
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one of those currencies, select it from the dropdown list. For information 
on setting up your Magaya system to work with multiple currencies, see 
the topic "Multicurrencies".

• Select the vendor. The address will fill in automatically. If you need to 
change the address for this transaction, click the “Change” button and 
enter the new information. If you have set payment terms for this vendor 
or your system, the terms will display here and set the due date. (Extra 
Info: Payment terms are set in the Vendor’s profile or Configuration > 
Payment Terms.)

• The Transaction Date fills in automatically with today’s date. (Enter the 
date of the bill if needed.)

• The Due Date is filled in automatically based on the terms for this vendor. 
Change the due date if needed.

• Click on the “Add” button to add charges to the bill. A dialog box opens:

The “Type” selected will pull information from the Items and Services list 
(which will show only Items and Services that refer to expense (or COGS) 
accounts for this dropdown menu).

The description is optional. Additional information can be added in the 
Notes tab. Any notes you add will appear in the invoice for the customer 
to see.

Enter the quantity and price. The amount is calculated automatically. 
Units is optional (examples are: “pounds”, “lbs”, “each”, etc.).

Click the OK button. The information is saved in the Bill transaction. You 
can add as many charges as needed to the Bill.
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On the Bill screen, enter any Notes or Internal Notes as needed by clicking on 
the tabs.

Click the OK button when done. The bill will be updated in the Bills List and the 
document.

Configuration Note: If you sell inventory and want to be able to create bills 
before inventory items are received, set this option in Configuration > 
Purchasing.

Ensure the box is unchecked to allow the system to create bills for POs only after 
all inventory is received. In contrast, if this box is checked, then you will not be 
able to make bills until after receiving the items.

Actions for Bills

When you are viewing a bill, you can click on the Actions button to pay the bill, 
void it, save it as a recurring bill, select a template or view the history. Each of 
these will be explained in this section. First let’s look at the Actions button menu 
from the document view:
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When you access the Actions button from the list view, you see these options 
plus the following:

The Actions list is also available when you select a bill and right-click on it.

The following is a list of all the Actions:

• Create Cargo Reports: Select a bill, click on the Actions button, and click 
on the “Cargo Reports” option. Select the type of cargo report you need. 
The Cargo Reports relate the operations and accounting information in 
the Magaya system, enabling you to see reports such as how much you 
have billed for certain ports or destination agents.

• Create Purchase Reports: Use this option to create reports of all unpaid 
bills or unpaid bills as of a certain date. Other options are create an aging 
accounts payable (in detail or a summary) report and a Bill Detail report. 
The report opens in the viewing pane. You can adjust the columns in the 
reports, save a report, filter the information, or export the report data.

• Export the data in the bill list to QuickBooks® or PeachTree® accounting 
software programs to export the bills you have filtered and to save them 
on your computer (or other directory) in a file format that can be 
imported in those applications.

• To view a bill, select the document to highlight it and select “Go to Docu-
ment”.

• Print a batch of bills you filtered.
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• Pay a bill: A dialog box opens. For information on filling in the fields, see 
the section “Create Bills.”

• Void a transaction: Select the bill and click on this option to void a trans-
action.

• Save as Recurrent: This is useful to create a recurring bill based on the bill 
you are viewing if it is a bill you need to pay each month. A wizard walks 
you through the steps. See details in the Magaya Software Accounting 
Manual, Chapter 11. Also find steps for periodic billing there too.

• Recurrent Bills: This will display a list of recurrent bills.

• Open Transactions: This opens a list of open transactions. Set the date 
range as needed in the list.

• Choose columns in the list.

• Import or Export data into or out of Magaya database

• History: This opens a list of any transactions related to the one selected.

To pay more than one vendor, see the section “PayMultipleVendors”.

Note: Users of the Magaya Supply Chain Solution can create bills from Purchase 
Orders for more than one vendor. See Chapter 9 on Purchase Orders in the 
Magaya Supply Chain Solution Operations Manual.

If a PO is created with landed costs, the charges will be prorated. When the bill 
is created from the PO, the landed costs will be added to the asset account. Learn 
more about landed costs in the topic “Landed Costs” included in the Magaya 
Software Accounting Manual.

To view more details about a bill, select it and click the “Detail” button.
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2. Purchase a Fixed Asset

When you purchase a fixed asset, you can create a bill for it. For example, when 
purchasing a vehicle for your company, enter a bill which goes to Assets for your 
company.

Make payments just as you would for any other payments such as for a loan or 
to pay a credit card by using the Check to Expense. Depreciation is recorded 
using Journal Entries.

3. Bill Credits

A Bill Credit is a credit from a vendor. The credit may be the result of an over-
payment you made to the vendor or if they overbilled you. (If they send you a 
refund check, you will create a Vendor Refund in the Payments List.)
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The following steps explain how to process a Bill Credit in Magaya Explorer.

In Bills (document or list view), click on the Add button and select “Bill Credit”.

A dialog box opens. There are the following tabs: Credit, Notes, and Internal 
Notes. The date and transaction number are filled in automatically.

This screen is the same as the Bill screen. See the steps in the section "Create-
Bills" to fill the fields of the Bill Credit. Please note that the bill credit will be 
subtracted from Accounts Payable and will show as a negative in the AP.
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4. Bill Payments

To pay bills, go to the Checks list (or document view) and click on the “Add” 
button. Select “Pay Bills (Check)”.

Use this option to create a check for a bill such as telephone bills or freight bills, 
etc.
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• Select the A/P Account for this bill. (If you are working in multicurrency 
and select an A/P account with another currency, this payment will be 
made in that currency, and that A/P Account will be updated with this 
payment transaction.)

• Enter the check number. (For information on setting up the numbering of 
checks, see the topic "AccountingConfigurationMenu".)

• Select the Bank Account to use for this check. If you have a credit card set 
up in the Chart of Accounts, you can select it here also. (The balance for 
the bank account selected is displayed on the bottom of the dialog box.)

• The date is filled in automatically.

• Select who to pay the check to (“Pay to the Order of”). If there are any 
existing credits or discounts to apply, the amount will be displayed at the 
bottom of the screen. (If the vendor offered you a discount, and you 
entered it on the Bill, it will display here.)

• Add a memo as needed.

• Check the box to show all open bills in the Bills List. If there are multiple 
bill, select the one you want to pay.

• Enter the amount paid in the “Amount” field.

• Click the OK button when done. The check will display in the viewing 
pane. To print a check, click the “Print” button. For more details, see the 
section “Actions for Checks.”
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5. Pay Multiple Vendors

From the Checks List, you can pay multiple vendors. Select the option from the 
“Add” button. A wizard opens:

Select the bank account you want to use to pay the vendors.

The options are checked by default to make the checks payable to the parent 
accounts and to generate check numbers automatically.

Go to the next screen.
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Select the bills to pay. A checkmark appears for each bill as you select it:

In the next screen, if there are any bill credits, select the credits to apply:
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In the next screen, the system shows you the checks it will create for you:
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In the last screen of the wizard, click the “Create Checks” button to let the 
system create the checks. The screen shows the progress of the system as it 
creates the checks:

If any bills are not valid, a check will not be created by the wizard. This may 
happen if someone else in your company is paying that bill at the same time that 
you are running this wizard.

Click “Finish” when done. The checks paid will appear in your Checks List. You 
can print the checks as usual.

6. Vendor Refunds

A “Vendor Refund” is available in the Payments subfolder. Use this when you 
receive a refund from a vendor. To be able to receive a refund check from a 
vendor, you need to have a bill credit for that vendor in the system.
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Go to Payments (in the document or list view) and click on the Add button.
101



Accounts Payable Chapter 7
A dialog box opens. (It is similar to the Payments screen.)

• Select the A/P Account for this vendor refund. If you are working in 
multicurrency and select an A/P account with another currency, this 
payment will be made in that currency, and that A/P account will be 
updated with this refund transaction.

• Enter their check number.

• Select the Bank Account to deposit for this refund check.

• Select the vendor name.

• The date is filled in automatically with today’s date.

• Check the box to show all nonrefunded credits.

• Enter a memo if needed.

• Enter the refund amount in the “Amount” cell, or select from the credits 
in the list. In the Credits list, you can click on the line for “Amount Paid” 
and enter the amount.

• Click the OK button. The refund will be displayed in the viewing pane.
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8. Banking

Introduction to Banking in Magaya Explorer

Magaya Explorer offers accounting features to handle your banking needs such 
as:

• Writing checks (to pay expenses and sales tax)

• Making deposits

• Bank reconciliation
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Checks

Writing Checks

There are different types of checks that you can create in your Magaya system. 
From the Add button (in the document view or list view) you can choose the 
following:

The rest of this topic will explain the following check writing tasks:

• Checks to Expense: This is to pay expenses such as office supplies or other
expenses that you do not receive a bill from the vendor.

• Pay Sales Tax: This is to write a check to a tax agency, department, or
authority to pay sales tax you collected on invoices.

The following other types of checks are explained in the topics indicated:

• Pay multiple vendors: Use this option to write checks to multiple
vendors. See the topic “Accounts Payable” for details:

Accounts Payable

http://knowledge.magaya.com/#/article/accounts_payable

• To Pay Bills (Check): This is to pay outstanding bills. See the topic in
Accounts Payables (see the link above).
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• Refund Check: This is to refund money to a customer. See the topic in 
Accounts Receivable:

Accounts Receivable

http://knowledge.magaya.com/#/article/accounts_receivable

Check to Expense: Use this option to create a check for an expense such as office 
supplies for your business. (The Check dialog box can be resized by clicking and 
dragging the bottom corner.)

• Select the bank account you will use for this check. If you are working in 
multiple currencies, there will be at least one account available in the 
dropdown for each currency. To write a check in one of those currencies, 
select it from the dropdown list. The current balance for the selected bank 
account is displayed on the bottom of the screen. For information on 
setting up your Magaya system to work with multiple currencies, see the 
topic:

Working with Multiple Currencies

http://knowledge.magaya.com/#/article/multiple_currencies
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• The check number is filled in automatically based on the last check used 
for the selected bank account. For information on setting up the 
numbering of checks, see the topic:

How to Configure Accounting

http://knowledge.magaya.com/#/article/Configure_accounting

• Select who to pay (“Pay to the order of”).

• The date is filled in automatically. It can be changed if needed.

• Click the Add button, and a line in the Detail table will be created and 
highlighted:

a) Click a cell in the table under the column “Account Name.” A drop-
down menu opens. Select the account for this line.

b) Click the Amount cell in the table and type in the amount.

c) Click the Description cell of the table and enter a description (optional 
but recommended).

d) Click the Entity field if this line relates to a customer, and select the 
customer from the dropdown. (Otherwise the Entity field is optional.)

• You can add as many details to the check as needed by clicking the Add 
button again and following the same process. The total amount will 
increase with each detail you add.
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• Click the OK button when done. The check will display in the viewing 
pane.

Pay Expenses with a Credit Card

If you pay expenses with a credit card, enter the information as shown:

Note: In order to pay with a credit card, you must first have a credit card account 
set up in the Chart of Accounts.

In the check dialog box:

Select the credit card from the “Bank Account” dropdown.

Use this method when you do not have a bill; for example, you went to Office 
Depot, bought office supplies, and paid for them with a credit card. When you 
return to work (or to your Magaya system), update your Magaya system with 
the transaction.

Pay Credit Card:
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When the credit card statement arrives in the mail and you need to pay it, use 
this same method: Check to Expense. Select the bank account you want to use 
to pay it, and select the credit card company as the “Pay to the order of”. When 
you add the item in the dialog box, the Account Name will be the credit card.

This transaction creates a record of what you paid and what account it went to.

See more about using credit cards:

Using Credit Cards

http://knowledge.magaya.com/#/article/credit_cards
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Pay Sales Tax

Use the option “Pay Sales Tax” from the “Add” menu to write a check to the tax 
agency such as state or county to pay taxes you have collected in invoices for 
goods sold.

• Select the Bank Account that you will use to pay this tax. The current 
balance for that bank account is displayed.

• The date and check number are filled in automatically.

• Select the tax agency that you are paying the sales tax to (“Pay to the order 
of”).

• Add a memo as needed.
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• Check the box to show balances due for that tax authority (if the box is not 
checked already). Any taxes due for the selected agency will show in the 
table:

a) The first column shows if the tax is paid or unpaid. When you click on 
it to pay it, the field changes to “Paid” and a checkmark appears in the box.

b) The Name column shows the name of the tax agency.

c) The Code is the tax code.

d) The Balance is the balance outstanding for that tax agency.

e) The Credit column shows a credit if one exists. You will have a credit if 
you have paid sales taxes when you make purchases. That credit will show 
here.

e) Amount due is the total due.

f) Enter Amount Paid.

• The discount field below the totals is for a percent of the total taxes due. 
This amount is determined by the tax authority.

• Click the OK button when done. The check will display in the viewing 
pane.

Also see the topic on sales tax and to learn about configuring your Magaya 
system to handle taxes as needed for your business. Also learn about grouping 
taxes and handling dependencies:

Sales Tax

http://knowledge.magaya.com/#/article/sales_taxes

Actions for Checks

To view the actions available in the software for checks, click the arrow on the 
side of the Actions button. The options from the document view are:

• To void a transaction

• Save as a recurring transaction (only for “Checks to Expense”) you can 
also copy an expense check
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• Select a template: Use this to choose the template that matches your 
pre-printed checks.

In the dialog box “Select Template,” choose the template. A preview of 
each template appears in the window.

To link the template to the current transaction, check the box. You can 
also set the template as the default for all checks (optional).

Extra Info: There is a check template for Panama. Learn more about our 
Fiscal Printer connection in our Knowledgebase.

Printing on Pre-Printed Checks: Before printing, select the template as 
noted above, and then click the “Options” button on the menu above the 
check document. Select “Print fields only”. This will print the data in the 
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check fields such as the date and amount. It will not print the lines (which 
are already on your pre-printed checks).

If you do not have pre-printed checks to use in your printer, you will need 
a font for the account number and routing number; this is not provided 
by Magaya Corporation, but we do provide customizations to the 
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template of the check and other documents. Contact Magaya for details 
and prices.

The default size for printing is letter size paper. One check will print per 
page with two stubs below the check on that page.

Print Multiple Checks: To print a batch of checks, select them from the 
Checks List and right-click to select the option “Batch Print” from the 
pop-up menu.

A wizard opens. It enables printing of the checks selected from the list, and 
has the option to select different templates for checks.

• View the history related to this transaction

The options from the list view include:

• Other Reports: Create reports by account number, etc.

• Reports: See the details of checks. The report opens in a list that you can 
customize the date range you want to view.

• Go to the document (the check).
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• Void a check: To void a selected check. This retains a record of the void.

• Print a batchof checks: First filter the Checks List.

Then click the arrow on the side of the Print button and select “Print 
Batch.”

Follow the prompts in the batch printing wizard. It will print the filtered 
list of checks using the template assigned to each check. The printer that 
the checks will be sent to is shown in the screen. To change the printer, 
click the “Configure” button next to the Printer field.

Option: The screen also includes an option to print additional templates. 
To use this option, select the template from the list. You can select a 
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printer for each template by clicking the “Configure” button next to the 
list of other document templates.

• Additional menu choices from the Actions button for the Checks List:

Save as Recurrent: To convert to the selected check into a recurrent check 
to be paid every month or other time period you set.

• Recurrent Checks: Displays a list of recurring checks.

• Choose columns for the Checks List.

• Export data from Magaya Explorer.
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• History: View related transactions.

To view more details about a check, select it and click the Detail button.
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Making Deposits

A Deposit refers to making a deposit of funds such as a loan that you receive, in 
contrast to making deposits of customers’ payments for invoices. Deposits can 
be created in the Deposits List or document view in Magaya Explorer. There are 
two types of deposits:

• Deposit a Payment: Use this option when you are depositing money from 
the Undeposited Funds account. See the topic in Accounts Receivable: 
"DepositingPayments".

• Deposit: Use this option when you are making a deposit into your bank 
account such as for a loan you have received.

To make a deposit, click on the Add button and select “Deposit”:
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A dialog box opens:

• Select the bank account for this deposit.

• Add a memo as needed.

• Click the Add button to add the deposit. The line in the Detail table is 
created and highlighted.

• Click on a line in the Details table, and a line will highlighted:

a) Click on the table cell “Account Name”. This activates a dropdown 
menu. Select the account related to this line in the deposit (for this 
example, Small Business Administration loan).

b) Enter the amount of the deposit by clicking in the cell under “Amount”.

c) Type in a description by clicking in the “Description” cell.

d) If there is an entity (or customer) related to this line in the deposit, enter 
it by clicking on the “Entity” cell to activate the dropdown menu. If not, 
the Entity field can be left blank.

You can add as many lines as needed by clicking the Add button again and 
following the above steps. The total amount will increase with each detail you 
add.
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Click the OK button. A Deposit ticket is created.
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Bank Reconciliation

To perform a bank reconciliation, go to Chart of Accounts, select the bank 
account to reconcile, click on the Actions button and select “Reconcile”.

The reconciliation screen opens. In this screen you can reconcile the account 
activity to match the statement from the bank.
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If you click the “Leave” button, your work will be saved, and you can return to 
the screen at any time. The “Done” button is to be used after completing the 
reconciliation.

Set the Statement Date: The Statement Date is the date that the bank statement 
was issued. When you set the date, only transactions before that date appear.

If you have used this reconciliation screen before, the opening balance for this 
month will be the same as the end balance from the previous month.

If this is the first time you are performing a reconciliation in Magaya Explorer, 
the opening balance will be zero. To add an opening balance, create a Journal 
Entry and then clear it in the Transaction Listing so it appears in the reconcili-
ation: in the Chart of Accounts list, click the “Actions” button, and select 
“Transaction Listing”. Right-click on the transaction and select “Clear/Unclear 
Transaction” from the pop-up menu. Then return to the reconciliation screen.

Enter the Statement Ending Balance: Use the balance that is listed on your 
statement.

Place a checkmark in each transaction in the list as you match it with the bank 
statement. The status in the “Cleared” column will change from No to Yes:
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To place a checkmark in all the transactions, click on the “Mark All” button. To 
uncheck all the transactions, click on the “Unmark All” button:

As you check the transactions, the total number of Cleared Transactions will be 
updated on the bottom of the screen:

Add: Use the Add button to add a transaction that is listed in the statement but 
not in this screen.

Edit: Use the Edit button to change a transaction. Click on the transaction to 
select it. Click the Edit button. A dialog box opens that will look different, 
depending on the transaction selected. Modify it and click OK.

Print: Click to print the Deposits or the Checks. These can be printed separately.

Delete: If a transaction is not in your statement, select the transaction to delete, 
and click the Delete button.

The Uncleared Balance must be zero to complete the reconciliation. If you click 
the “Done” button when the Uncleared Balance is not zero, the system will give 
you a notice and not complete the reconciliation. You can leave and return to 
the reconciliation screen at any time and your work will be saved. When you 
click the “Leave” button, the reconciliation screen closes.

When you are done with the reconciliation and you click the Done button, the 
system will ask if you want to print the statement. You can print it now or print 
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the bank reconciliation from the Reports option from the Actions button in the 
Chart of Accounts at a later time.

To view transaction amounts in the home currency and the applied exchange 
rate (if working with multiple currencies), right-click on a transaction in the 
“Deposits and Other credits” section of the Reconciliation screen. Select 
“Choose Columns”.
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In the dialog box, check the options “Amount (USD)” and “Exchange Rate”.

This adds the columns to your Reconciliation screen.

If there is an error to fix after reconciling, you can go to the Transaction Listing 
for the bank account (in the Chart of Accounts) and clear (or unclear) the trans-
action there.
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Select Transaction Listing from the Actions button (in the Chart of Accounts 
for the bank account). The list opens. In the list you can right-click on a trans-
action and choose to clear it:

Undo a Bank Reconciliation: A bank reconciliation can be rolled back if 
needed. All the cleared transactions will be changed back to the status of 
“Unclear” all at once, instead of one at a time. From the Chart of Accounts list, 
right-click on the bank account, and select “View Reconciliations” from the 
menu. Right-click the desired reconciliation and select "Undo Reconciliation" 
from the pop-up menu.

Note: You can configure your system to require a password to undo a reconcil-
iation. It will first ask if you are sure you want to proceed.
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Then it will ask for the password.

The password is the one set in the Configuration > Accounting menu.
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Chapter 9 9. Accounting Reports

9. Accounting Reports

Introduction to Accounting Reports

Magaya Explorer offers accounting reports, including:

• Financial Reports: Standard financial reports such as Profit and Loss
reports and Balance Sheets

• Sales Reports: These reports provide information about sales by item or
by customer, about open invoices and aging Accounts Receivable

• Purchases: These reports provide information about purchased items,
carriers, and vendors, about unpaid bills, and aging Accounts Payable

• Multicurrency Reports: View any gain or loss by doing business in
multiple currencies
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Overview of Accounting Reports

You can access reports in different ways in Magaya Explorer. Many financial 
reports are available from the Reports option on the top menu:

• Each report type has a submenu with additional options.

• You can also access reports that were saved.

You can also find many reports by using the Actions button in any Accounting 
list such as the Invoices List, Payments List, Bill List, Deposit and Check Lists to 
see reports specific to each of these types of accounting transactions. The 
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Actions button in the Chart of Accounts (shown below) and in Items and 
Services also gives you access to many financial reports:

You can customize the reports in many ways such as changing the columns and 
the currency by using the Actions button, or filter the report with the Filter 
button. Columns include “Last Payment Amount” and “Last Payment Date,” 
columns that are useful for AR/AP summarized reports.

The date range can be changed using the date fields at the top of the list. Click 
the Refresh button to see changes.

Reports can be created to show the employee who created certain accounting 
transactions such as invoices and bills.

After you customize a report, you can save it. When you open a saved report, it 
will display with all the customized features saved.

To save a report, click on the “Save” button when you are viewing the report.
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A dialog box opens with fields filled in, but you can change them as needed.

The “Save As” option allows you to keep the original format of a report and to 
save a copy of it by another name. Then you can make changes to the second 
report without having to start all over to build it.

To view saved reports, go to the Reports option on the top of Magaya Explorer 
and select “Saved Reports”. A dialog box opens, showing the list of any saved 
reports.

In a report you can double-click on a transaction to view its details:

To go to a document, right-click on the transaction and select “Go to”. To 
return to the report, click on the Back button. Note: Only a user with Adminis-
trative rights or the creator of a report can delete a saved report.

Tabs:

You can switch between views of reports and lists. Similar to tabbed browsing 
available on Internet Explorer and some other web browsers, the tabs in your 
Magaya Explorer enable you to switch between views.
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For example, when you are viewing a list such as the Invoices List, and you want 
to also view a report, now you can view both in tabs. Previously you had to close 
a report to return to the list view. Now you can switch between both.

When you are viewing a report, you can double-click on a line item in a report 
to drill down for more details. For example, run an Income statement (P&L 
report) and double-click on a line item. The item will open in a tab.
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Customize Reports

You can enhance and customize the format of reports. Change the font, color, 
size, etc. of the different elements in the report such as company name, title, 
subtitle, columns headers, rows, etc.

Steps:

1) Click the “Configure” button on the bottom toolbar in the Document 
view.

A dialog box opens with three tabs: Header Info, Fonts, and Numbers. The 
Header Info tab displays your company name, the report title, and 
sub-title; you can change any of these as needed.

2) Click the “Fonts” tab. Select the element you want to customize such as 
the Header – Company Name. Make changes to the font and click OK.

Other custom options on the “Numbers” tab:

• Display whole numbers or numbers divided by 1000

• Output numbers using the thousand separators, for example: 1,000,000.00
132



Chapter 9
• Display negative values in red or in parenthesis

In the Profit Reports, you can view the profits by entity, Select “Profit by 
Entity” tab: To filter the report by operation type, select it from this tab:

Other options: Include costs of agent profit sharing and/or salespersons’ 
commissions. Sort by profit or entity name. Learn more in the Knowledgebase 
article on Profit Reports:

http://knowledge.magaya.com/#/article/profit_reports
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Steps to Customize Numbers:

1) Click the “Numbers” tab in configuration dialog box:

2) Check the options you want to use, and click OK to save the changes.

Select Additional Columns in Fixed Reports:

Additional columns can be selected in all fixed reports pre-created in the system 
such as adding the "Shipment Name" or "Port of Origin" column to an Open 
Invoices report.

Steps:

1) Click the Actions button, and select “Choose Columns”.

2) In the dialog box that opens, select the column you want, or click the “Add 
Column” button to open a new dialog box with more choices.

Change Column Names on Reports:

You can change the column names in any report, including those that are 
created by the system.

Steps:

1) Open the “Choose Columns” dialog box.

2) Click on the column name. Then type the new name, and click OK to save.
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You can also set the default columns to a report that the user modified to bring 
the report to its original status: Click on the Actions button and select “Set 
Default Columns”.

This feature is especially useful when you want to create another report that is 
similar to the first one; you do not have to start from scratch to build it.

You can add Credit and Debit columns to any “Detailed” report by selecting the 
Actions > Choose Columns.
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Financial Reports

Financial Reports are Profit and Loss, Balance Sheet, and Statement of Cash 
Flow. The “Reports” menu gives you access to each type of financial report.

See the Knowledgebase for the article on accounting reports to get an overview 
of what’s available, especially useful if you are just getting started with Magaya:

http://knowledge.magaya.com/#/article/Accounting_Reports_Getting_Started
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Profit & Loss Report

Profit & Loss report show your income (also called revenue or sales), costs, 
expenses, and profitability for a time period. The reports can be created in 
summary format or a detailed view.

Profit and Loss reports, also called “Income Statements,” show how well the 
company is performing.
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This is an example of a summary view of the Profit and Loss statement:

To create a report, set the date range, and click the Refresh button.

• The creation date of the report displays on the top of the report. The 
creation date will be today’s date.

• The Income section shows income from freight and other sources.

• The Cost section shows Cost of Goods Sold such as freight costs. (Note: 
Freight costs can be included in Landed Costs. See the topic “Landed Cost 
Management” for details.)
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• The Gross Profit shows total income minus total cost.

• The Expense section shows expenses such as rent, salary, utilities, 
discounts and other fees you paid for services such as an accountant.

• The Net Income total is listed on the bottom and shows the company’s 
profit after all expenses have been paid. It is the Gross Profit minus the 
total expense.

Double-click on a number in the report to view its details.

The detailed Profit and Loss Report shows more information such as the item-
ized cost, income, and expense:

You can see any transaction in this report by double-clicking on it.
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To filter the report, click the “Filter” button and select the option: Standard or 
Advanced. The Standard filter for report transactions has the options shown in 
the screenshot:

Comparative Profit & Loss Reports

To see profit and loss information from more than one period of time, follow 
these steps:

1) Go to Reports > Financial Reports and select Profit & Loss (by summary 
only)

2) Click the Configure button.
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3) In the dialog box that opens, click the “Columns” tab. Select from the 
following:

Type of Columns: By Month, Quarter, Fiscal Quarter, Year, Fiscal Year. 
Select one of these to view the time periods to view columns. The other 
dropdown “Type of Analysis” is optional.

You can also include an analysis of the time periods:

Type of Analysis: Previous Period, Previous Year, Year to Date. The anal-
ysis option can show a percent change or the amount of change.

To view the report on a cash basis, click the “Financial” tab and select 
“Cash Basis.” For more on cash basis reports, see the following Knowl-
edgebase article:

http://knowledge.magaya.com/#/article/cash_basis_reports
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4) Click OK to view the report. This example shows a comparative Profit & 
Loss report by month with the percent change as compared to the 
previous month:

The report can also be saved. To view saved reports, go to the Reports menu and 
select “Saved Reports”. In the dialog box that opens, double-click on the report 
name to open it.
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Shipment List P&L Report

In the Shipment List, select a shipment and click the “Detail” button. Select 
“Profit & Loss” panel from the dropdown menu.

The Detail button and Panels enable you to quickly scroll through the list by 
selecting one shipment in the list and using the down arrow key on your 
keyboard to see the panel for other shipments.

Right-click a line for more options.
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Balance Sheet

The Balance Sheet shows total assets, liabilities, and equity. It provides a snap-
shot of your business capital (how much it owns and how much it owes) as of a 
certain date.

This report answers questions such as:

• “How much debt does the company have?”

• “How much money needs to be collected from customers?”

This report is cumulative; it will show the figures from the first day of your busi-
ness until the end date of the report.

If you sell inventory, the costing method you choose for your Magaya system 
will affect the balance sheet. For details see the topic “Average Cost” in the 
Knowledgebase:

http://knowledge.magaya.com/#/article/average_cost

To generate a balance sheet, select it from the Reports menu:
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The following is an example of a summary Balance Sheet report:
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• The Assets section summarizes current and fixed assets such as Accounts 
Receivable, bank accounts, cash, etc. If you own inventory items, they will 
show here as assets.

• The Liabilities section summarizes current liabilities such as Accounts 
Payable, loans, credit cards, etc.

• The Equity section shows the equity for the company (total assets minus 
total liabilities). The Retained Earnings line is from the Net Income of the 
previous years (it is money reinvested into the company). In Magaya soft-
ware, the closing of the year is done automatically. The Net Income line is 
from the beginning of the current fiscal year up to the report end date.

In the Balance Sheet summary view, you can compare time periods to analyze 
difference between months or between fiscal periods. Click the Configure 
button and go to the Columns tab to set the report period.
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A detailedBalance Sheet shows the transactions for the selected period for each 
account:

• The columns of the report show the transaction type, date and number, 
the customer or vendor name, the accounts, the balance, and more.

• If an invoice or other accounting transaction has more than one account 
included in it, the word “-MANY-” will display in the Account column.

• Each account will show a beginning balance that accumulates the activity 
before the period. After that, you will see the transactions for the period 
and then the ending balance as of the end date of the period.

If you sell inventory, and choose the Average Cost method of costing the items, 
the average will appear in the Balance Sheet.

For more details on this costing method, see the topic “Average Cost” in the 
Knowledgebase:

http://knowledge.magaya.com/#/article/average_cost
 147



Chapter 9
Statement of Cash Flows

This report shows a summary of how much cash is coming in (actual received) 
and going out of your business (amount paid out) over a period of time. The 
following shows a sample of a cash flow report:
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• The summary of net income from operating activities for the time period 
is listed first. This shows actual cash that has come in and what you have 
spent. It does not show what you have invoiced customers, only what is 
received (or spent).

• The Investing sectionshows cash used (spent) for investing in assets and 
the proceeds from the sale of other businesses, equipment, making or 
collecting loans, or long-term assets. Any changes to these accounts (gains 
or losses) will show here. This example shows zero investing because this 
cargo company is not buying or selling any businesses, etc.

• The Financing section shows cash you paid or that you received from 
issuing and/or borrowing of funds or other outside financing activities. 
For example if your company has stock and you sell it, the cash brought in 
by that sale would show on this part of the report. Also, paying back a bank 
loan shows as a use of cash flow. This example shows zero because this 
cargo company is not issuing stock, etc.

• The Cash section shows the net cash increase for the period, and the cash 
at the beginning and end of the period.
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Sales Reports

Sales Reports show sales by item, customer, and agent. Other report options 
under this menu are to create a report of open invoices and of aging accounts.

By Item: Shows the totals of sales by item and shows the Cost of Goods Sold 
(COGS) for items you resell. View a summary or a detailed report. The detailed 
report shows the invoices or other transactions associated with each item. The 
following is part of a summary, highlighting the columns:
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The report of sales by item can be configured to display just the inventory items, 
or just the non-inventory items, or both. Click the “Configure” button and 
select the options from the Profit by Item tab.

By Customer: Shows the sales amount per customer and the percentage that 
each customer represents of the total sales. You can view a summary or a 
detailed report:
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NOTE: Customer Statements can be made from the Customer List: Right-click 
the customer’s name and select “Statements” from the pop-up menu.

By Agent: This report is similar to the customer report, but this show the agents. 
This report is very useful for a logistics provider that works with several agents. 
The reports can be viewed as a summary or as a detailed report.

All Sales: View all the sales (in a summary or a detailed report). This report 
looks similar to the customer report.

Compare Sales: The sales reports can be configured to show a comparison of a 
customer by month, or other options. Here is an example:

Click the “Configure” button on the bottom toolbar of the report to open the 
“Configure Report” dialog box. Click the “Columns” tab and set the comparison 
terms you want to see:
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Open Invoices: Shows invoices that are open (not yet paid).

• Shows the invoice date and number, how many days it is overdue, the 
original amount and any amount paid, and a transaction reference.

Aging A/R: View past due Accounts Receivable (money your customers owe to 
your company) in a summary or a detailed report. In this summary, the time 
period that the account is overdue is in columns across the top, showing what is 
current, then what is between 1 and 30 days overdue, 31 to 60 days, etc. See the 
example below:

The Detailed report of Aging A/R shows invoices and other transactions that are 
overdue as of today. The report is organized in time periods of 30 days to show 
how long the accounts are overdue.
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The detail report is organized in time period similar to the summary report. The 
most current is listed first, then any accounts between 1 and 30 days old, to the 
oldest. It shows the status of aging accounts as of today:

The Aging reports by date show late receivables (or payables) by a specific date 
without including payments posted after the end date of the report. These 
reports can be configured to use the transaction date or due date to calculate the 
aging of each transaction.

If a customer has reached their credit limit (as set in their profile), you can put 
their cargo “On Hold” in the Commidity List or in the WR List by 
right-clicking.
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Purchase Reports

Purchases Reports show purchases by item, carrier, and vendor, and other 
reports show unpaid bills and aging A/P.
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The Purchase Report by Itemshows what you have purchased, the amount, and 
what percent that amount represents of your total purchases.

• In the summary by purchase item report, the air freight cost represents 
75.2% of the total purchases.

• In the detailed report, the accounting transactions related to the purchases 
are shown.
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Reports by Carrier (detail and summary) show the carriers, the amount you 
have purchased from them, and the percent that amount represents:

• In the summary report, the largest percent of purchases was from Crown 
Shipping (61.2%) for this time period.

• In the detailed report, the accounting transactions related to the purchases 
are shown.

The Purchases by Vendorreports show what you purchased (or paid) to a 
vendor such as the telephone company or vendors who provided services to 
you. The summary and detail reports look similar to the reports by carrier.

The report of All Purchases shows the purchases you have made from all 
vendors, carriers, etc.

The Unpaid Billsreport shows the name of the vendor, the date, transaction 
number, a reference, the due date and number of days old, and the amount due:

• Bills and credits are included in the Unpaid Bills report.
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Comparative Reports: Purchasing summary reports can be configured to 
compare time periods such as month by month or one quarter compared to 
another. Click the “Configure” button on the bottom of the report view, and 
select the “Columns” tab to set the elements.

Aging A/P Reports provide information on overdue accounts. Note: If a trans-
action was paid and you run a report before the date of payment, the transaction 
will not show as aging. To see what was open, use the Open Invoices report.
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Profit Reports Overview

Profit Report are available by Customer, by Salesperson, by Agent, and by Oper-
ations.
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You can create and customize any report. Click the “Configure” button in the 
bottom toolbar to open the following dialog box:

• On the Header Info tab, edit the report title, subtitle, or dates as needed.

• On the Profit by Entity tab, select which transactions to include. They are 
all on by default. The Charges from the checked transactions are gathered 
together for the report.

Other options: Select which costs to include (agent profit share, sales 
persons commissions) or exclude. If the agent is part of your company but 
in another division, you can exclude their costs and see the profit. 
Uncheck the boxes to see the profit before these costs are taken out of the 
profit.

The report can sort by profit or by entity name. If your database in larger, 
you can set up the report to show only the entities that bring in 80% of the 
profit, the most active companies that bring in the larger percent of your 
profits.

To include invoices and bills in the report, check the box. If not, the report 
will gather profits from operations transactions only. No invoices created 
manually will be included.

To include only liquidated operations, check the box.

• On the Fonts tab, select font type and properties.

• On the Numbers tab, select options to display numbers.
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Customer Profit Reports

The Customer Profit Report allows you to know the margins that each customer 
is contributing to the overall profit of the company.

The report displayed here sorts the customers (also called Clients) according to 
profit amount. The customer who contributes the higher profits appears at the 
top of the list:

You can customize the sort order with the Configuration button.

Double-click on a Customer name, and the dialog box for their profile opens. 
Double-click on any number in the list to see the details; they will open in a new 
tab, preserving your first report and the list so you can see them all.

When analyzing the profitability of Sales Orders, the other cost charges on 
related Purchase Orders are considered.

Prorating of Costs:

The Magaya system prorates the costs for the Houses and shows them in the 
profit report Expense column. Even though the Shipment Profit screen does not 
show the costs, the system prorates them for the report. The Expense in the 
report is all the costs such as the freight, documentation, etc., that are pro-rated 
across the entire shipment. (The Profit screen is available from the Profit button 
on the Shipment Toolbar.)

NOTE: To see a Customer Statement of just one customer, go to the Customer 
List, right-click their name and select “Statement.”
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Salesperson Profit Report

This report allows you to know the margins that each salesperson is contrib-
uting to the overall profit of the company. This screenshot shows the detailed 
view of the transactions for the salespeople. The other tabs here are the sales-
person list and the summary profit report for the sales people.

To learn about commissions for sale people, see:

http://knowledge.magaya.com/#/article/sales_commissions
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Agent Profit Report

The Agent Profit Report allows shows the margins that each forwarding agent 
is contributing to the overall profit of the company. We can see a summary, the 
details of the transactions, or the charges.

For details on agent participation, see:

http://knowledge.magaya.com/#/article/agent_participation

Profit & Loss by Operations

This is a unique report only available in Magaya software. It lets you see the 
profitability of your business from a different angle. When you use the 
accounting features in Magaya with operations, each operations transaction will 
have several accounting transactions such as bills and invoices related to it.
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This report will list each operations transaction for the time period with the 
associated income, expense, and profit coming from the related accounting 
transactions. Here is an example of a Profit and Loss report by operations:

• The date range of the report is displayed on the top. This is the date of the 
operations, not of the accounting transactions. For example the report will 
show invoices for the operation transactions whether they fall into this 
period or not.

• The operations are on the left and the transaction numbers are listed 
under each type of operation. The income, expense, and profit columns 
show the amounts for each transaction and the totals.

To filter the report by operation type, click the “Configure” button and 
select the types of operations you want to see such as Pickup Orders, etc.

• The detailed report by operations shows all the accounting transactions 
that are related to each operation transaction:

• The Income, Expenses, and Profit are also shown in columns with totals 
at the bottom.
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• The customer name (or vendor), number, and associated account (such as 
Accounts Receivable or Accounts Payable) are displayed.

• The miscellaneous income and expenses are displayed. This will show any 
accounting transaction that is not associated with an operations transac-
tion.

Other Reports

Other Reports show transaction details, trial balance, details of checks, invoices 
and bills, daily journal, sales tax and more.

Transaction Detail: To see transactions details for a specific account in the 
Chart of Accounts, select the account and use the Actions button. To see trans-
action details for all accounts in the Chart of Accounts, use the Reports menu 
from the top toolbar.
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Trial Balance: A list of the accounts showing the balance for each. The total for 
the Debit column should equal the total in the Credit column. This report is 
used by accountants to match credits and debits: 

General Ledger: This report displays all general ledger accounts balance and 
transaction detail by account during the selected time frame.

Check Detail: Lists the checks written, the type of transaction, the check 
number, customer or vendor name, amount, and each line included in the 
check. Use this to see a detailed view of your expenses:

Invoice Detail: Lists the invoices for the time period selected, the type of trans-
action, the invoice number, and other information. The report looks similar to 
the Check Detail report.

Bill Detail: Lists the bills for the time period selected, the type of transaction, 
the bill number, and other information. The report looks similar to the Check 
Detail report.

Payment Detail: See the list of payments and invoices paid, including taxes, 
retentions, and more.
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Daily Journal: This report shows all transactions in a selected date range.

Sales Tax Liability: Summary or detailed report. This shows the tax authority 
name, the tax rate, the amount of sales that period, the amount of the sales tax 
collected during that period and the previous period, and the sales tax liability.

When you use the Actions button in the Chart of Accounts, you can select a 
report for:

• Missing Checks: This report is available when you select a bank account.

Multicurrency Reports

The Multicurrency Reports show any gain or loss from business done in 
different currencies.

You must have multiple currencies turned on in your Magaya system and trans-
actions conducted in those currencies in order to have any information appear 
in one of these reports. If the exchange rate does not change or you do not 
update it in Magaya Explorer, no changes will be reflected in the reports.

Access the reports from the Reports menu:

There are two types of Multicurrency Reports available:
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• Realized Gains and Losses: This report shows transactions that have a 
gain or loss that became realized (actual) because a payment was received 
for an invoice that had a currency rate change or because you paid a bill 
that had a currency rate change.

For example, you invoice a customer for 250 Euros when the Euro was 
1.75. They pay the 250 Euros due, but the value of the Euro has decreased 
to 1.60 on the date you make the deposit. The report will show a realized 
gain for that account. If the Euro did not change, the report will not show 
anything.

The columns in the Realized Report show:

– The Type of transaction such as Payment or Bill Payment

– The date of the transaction

– The transaction number

– The Entity associated with that transaction such as the company that 
you paid the check to

– The Original Amount column shows the amount that the transac-
tion was originally set in

– The Realized Amount column shows that actual paid amount

– The Exchange Rate column shows you the rate of the currency

– The Gain/Loss column shows the amount gained or loss in your 
home currency

• Unrealized Gains and Losses: This report shows the balances for your 
accounts in different currencies. When you pay a bill or receive a payment 
for one of these currencies, the balance of that bank account, AR, or AP 
will reflect the result of the transaction.

The columns in the Unrealized Report show the following for the AP, AR, 
and bank account for each currency:

– The account name for each currency

– The current balance shows the amount in AP, AR, and the bank 
account

– The Balance column shows the amount in your home currency

– The Adjusted Balance shows the previous, original balance before a 
change

– The Exchange Rate column shows you the rate of the currency

– The Gain/Loss column shows the amount gained or loss in your 
home currency
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Multi-currency statements per customer: Right-click customer name in the 
Customer List. The statement displays each currency on a page.

Shipment Reports

For reports on your shipments, go to the Shipment List (in the Warehousing 
folder), and click the Actions button. Select the report you need.
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Other shipping reports can be created in the shipment screen by clicking 
buttons such as Profit.

Then click the Actions button to see reports for the Profit screen.

To create a report for a shipment liquidation, click the Liquidation button on 
the Shipment Toolbar, and then click the Actions button in the liquidation 
screen.

See also:

http://knowledge.magaya.com/#/article/profit_loss_report
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Cash Basis Reports

Cash Basis Reporting Overview

Cash Basis Reporting only includes payments that were made and checks that 
were written. Therefore, only these invoices, bills and checks will be included in 
a Cash Basis Report. In an accrual basis report, the balance sheet would include 
the AR and AP amounts.

By default, the system uses the Accrual Basis accounting method.

This topic explains how to configure your Magaya system to use the cash basis 
method, how to convert an individual report into a cash basis report, and how 
the system handles prorating and partial payments.

In addition to the Balance Sheet which can be created on a cash basis, the 
following reports can also be cash basis:

• Profit and Loss (P&L) Summary and Detail

• Transaction Detail for all accounts (Under Reports > Other)

• Trial Balance

• General Ledger
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Configure for Cash Basis

To configure your system to function on a cash basis, go to Configuration > 
Accounting > Reports

Select “Cash Basis.” Also determine if you want to include journal entries. The 
Journal Entries option is off by default. If you select it, the AP and AR will be 
included. If you leave Journal Entries unchecked, the AP and AR will be zero in 
the cash basis balance sheet. If the journal entries are included, they will affect 
accounts exactly as they do in accrual basis accounting.

This configuration is system-wide. It will affect the balance sheet, P&L reports, 
the trial balance report, general ledger report, and the Transaction Detail for all 
accounts.

Cash Basis Balance Sheet

To create a cash basis Balance Sheet, go to Reports > Financial Reports > 
Balance Sheet (summary or detail view).
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Even if your system is set to function on an accrual basis, you can still view the 
balance sheet on a cash basis by changing the configuration of this report.

The type of report (accrual or cash basis) is stated on the top of the report.

To configure an individual report, click the “Configure” button in the toolbar 
on the bottom of the report and select the “Financial” tab.

Select the settings you prefer. Click “OK” to save to configuration.
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To save the report, click the “Save” button in the bottom toolbar and name the 
report. All saved reports are accessible from the “Reports” menu in the top of 
your Magaya Explorer.

To learn more about balance sheets in Magaya, see the folliowing Knowledge-
base article:

http://knowledge.magaya.com/#/article/balance_sheet

Prorated and Partial Payments in Cash Basis Reports

The system prorates amounts: If you receive partial payment, the payment will 
be applied across all pending charges (if not applied to an invoice). The invoices 
and bills show the date of the first payment applied to them as their date.

If you receive an advanced payment, the amount is moved to an account called 
"Unapplied Customer Payments."

Any invoice can affect multiple income accounts, and any bill can affect 
multiple expense and/or cost of goods sold account. When a partial payment is 
received (or made), the total of the invoice or bill must be shown as the amount 
paid. The ratio of the distributed new total is as close as possible to the original 
ratio.
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Introduction:

The following sections will explain advanced accounting features available in 
Magaya Explorer. The features are:

• Configuration: Set up of some accounting options

• Costing Methods: Average cost and specific identification

• Sales Taxes: How to define sales taxes in the tax table and how to use them

• Approving/Disputing invoices

• Journal Entries: How to create journal entries

• Adjustments

• Multicurrencies: How to work with multiple currencies

• The relationship between operations and accounting procedures

• Accounts Receivable special procedures (bounced checks, etc.)
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Setting Accounting Roles

Roles can grant (or deny) permissions to employees. The system contains many 
roles, including ones related to accounting tasks.

Set roles by right-clicking an employee name > Roles. In the list, click the Add 
button. Select roles from the dialog box.
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Accounting Configuration

Introduction to Configuring Accounting in Magaya

This article covers the configuration options in your Magaya system.

Many accounting features are set up or changed in the Maintenance folder 
under Configuration > Accounting:

These settings are configured by an administrator or manager with admin rights 
in the Magaya system.

Here is a brief overview of the accounting-related options that can be config-
ured from this menu:
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• Setting document numbers such as consecutive numbers in accounting 
documents such as invoices and bills

• Configure how to export or import data between QuickBooks and your 
Magaya system

• How your system manages Credit Limits for customers

• Other settings: To generate charges automatically, date to close 
accounting, transaction due dates, set currencies, set fiscal year, set peri-
odic invoicing, setting sales tax and default payment accounts

Main Accounting Configuration Tab

The following settings are configured on the main tab of this menu:

Close Accounting Date:

Click the checkbox “Accounting will be closed on or before” to activate the date 
option to set the closing date of your accounting. Select a date using the calendar 
dropdown. As a result, users will not be able to enter or modify any transaction 
done before this date. Update this date as needed after each period.

If you want to restrict access to the closed accounting period or to previous fiscal 
years, check the appropriate box.

You can also require a password to access editing of accounting transactions 
from previous years, before the date set in the calendar dropdown above. This 
password will also be required to undo a bank reconciliation.

Select Default Payment Terms:
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Use this option to set payment terms system-wide for all customers. The system 
will use this in invoices and calculate the due date automatically.

To set payment terms per customer, set them in the Customer’s profile. For 
details, see Chapter 6 in the Magaya Software Accounting Manual. See also:

http://knowledge.magaya.com/#/article/maintenance_folder

Note: The system will carry over your settings any time you update your Magaya 
system to the newest version of Magaya software.

Set the default payment type, either prepaid or collect, to apply systemwide.
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Additional configurations on the Main tab:

Currency Options:

Select your home currency. Note: This option is active only if there are no 
existing accounting transactions. It is recommended that home currency be set 
up in the Startup Wizard. To update a currency rate, click the button on open 
the currency list. For information on working with multiple currencies, see the 
section “Multicurrencies.” In that topic, also find details on how to apply an 
exchange reate per the transaction date.

Automatically select account in entity’s preferred currency in accounting trans-
actions: Check this option if you want your system to allow you to define a 
preferred currency for an entity such as a customer or vendor. By setting this, 
all charges and transactions created for that entity will use the entity's currency. 
The user will be able to change the currency per charge if needed. This applies 
to charges created manually or automated charges.
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This will apply to the field "Apply to" in Invoices; to the "Vendor field" for Bills; 
to the "Customer" field for Payments; and to the "Pay to the order of" field for 
Checks.

In Shipment liquidations, the accounting transactions for the agent will be in 
their preferred currency (if you set it). Commissions for salespersons can also 
be defined with a preferred currency.

First, turn on the option in the Configuration menu. Then open the profile for 
the entity, and click on the Payment Terms tab.

Reverse Exchange Rate:

If you work with currencies that convert to very small amounts, you may want 
to work with the reverse rate. Check the box for this option, and your Magaya 
system will calculate the rate for you. Leave unchecked for the direct exchange 
rate.

Fiscal Year:

This sets the starting month for the fiscal year. If you used the Accounting 
Wizard to set up your Magaya software, the date displays here. The system will 
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use this month as the beginning of the new fiscal year to automatically calculate 
the retained earnings of the previous year.

Configure Liquidation Options:

These liquidation options can be set for outgoing and incoming shipments 
separately. This setting is global and will apply system wide.

There are settings to select the accounts and Items & Services you want to use 
when liquidating shipments.

Additional settings include how you want to calculate the profit for sales people 
and for agents. Check the box and enter the percent. These settings will apply to 
all shipments created.

All these settings are explained in the Shipments and Liquidations topics in the 
Magaya Cargo System Operations Manual. It also explains how to make changes 
for an individual shipment.
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Configure Default Accounts:

To set default accounts for the following transactions, click the “Accounts” 
button. In the dialog box, make selections.

Save your settings.

Accounting Document Numbers Configuration

Check the boxes in this section to set consecutive numbering for Invoices, 
Credit Memos, Bills, Credits, Checks, and Journal Entries.
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You can add prefixes and suffixes to the numbers: Click the “Set” button. In the 
dialog box that opens, enter the information you want to display for the specific 
accounting document.

Save your settings.

Note: To set document numbers for operations and sales documents such as 
Warehouse Receipts, Sales Orders and Bookings, please see the Configuration 
setting for Document Numbers.

Accounting Reports Configuration

Select cash basis or accrual accounting reporting. The accrual method is selected 
by default.

For more on cash basis reports, see the following Knowledgebase article:

http://knowledge.magaya.com/#/article/cash_basis_reports
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Cost Configuration

The Cost tab contains settings for inventory costing methods and landed costs.

This setting affects the invoicing, the accounts for Inventory Assets, for Cost of 
Goods Sold, and the balance sheet. This is an advanced accounting function. We 
recommend that you ensure you understand how this will change your 
accounting system before making any changes here.

Default Costing Method:

Select the default inventory costing method your company uses: by specific 
identification or by average cost for new items added to your system. This 
setting is global for your whole Magaya system. Individual costing methods can 
be set on each inventory item definition if you want to set only at the item level, 
not apply one method system-wide.

• Specific Identification: When items are sold according to the Specific 
Identification cost method, creating an Invoice for the items will cause the 
system to remove the exact amount that was assigned to the Asset account.

• Average Cost: When items are sold according to the Average Cost 
method, creating an Invoice for the items will cause the system to remove 
an average amount from the Assets account and transfer it to the Cost of 
Goods Sold Account. This averages out the costs of the items bought at 
different prices perhaps at different times or from different suppliers.

For details on costing methods, please see the section “Average Cost” in the 
Magaya Software Accounting Manual. See also:

http://knowledge.magaya.com/#/article/average_cost

Landed Cost:
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The Landed Cost setting generates asset adjustments for the additional charges 
found in Purchase Orders (PO) when the PO’s are billed. When you check this 
option, also decide how to prorate the charges, by cost or by pieces. Save.

Next, go to the “Items & Services” list.

- Select the service charge such as Inland Freight Cost, and double-click to open 
it.

- On the tab “Landed Cost,” check the box to include this non-inventory charge 
in Landed Cost. (Note: This tab only appears when configured to activate it.)

What will happen: When a PO is created with this Inland Freight charge, the 
charge will be distributed across the items in the list. See the PO dialog box to 
view how the costs are prorated. Tip: Right-click in the Commodities screen of 
the PO to choose the columns if needed to view them.

When a PO with charges for landed costs is billed, the Bill for the other charges 
will also contain an asset adjustment.

This will also affect your Balance Sheet and Trial Balance in your Magaya 
system.

For details on landed costs, please see the section “Landed Cost Management” 
in the Magaya Software Accounting Manual. See also:

http://knowledge.magaya.com/#/article/landed_costs
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Tax Configuration

Configure how your Magaya system will handle taxes such as those that apply 
when you sell freight, a service or inventory items and those that you pay to a 
tax authority.

• Keep tax for purchases as credit: To keep the sales tax for purchases you 
make and hold it as sales tax credit, check this box. This will apply when 
you are paying your sales tax. For example, You create a check to pay sales 
tax. The check is payable to the tax authority or agency such as the state or 
county. The total that you will pay will reflect the deduction of sales taxes 
you already paid when you made purchases that required sales tax.

• Enable cascading taxes: Used to create taxes that depend on other taxes. 
For details, see the section “Tax Dependencies.”

• Enable tax withholding: Used to withhold (or retain) taxes automatically 
from the income

• Round taxes up by default: Used to round up the tax amount

Learn how to use sales taxes:

http://knowledge.magaya.com/#/article/sales_taxes

Accounting Integration Configuration

You can exchange accounting data between your Magaya system and Quick-
books. First, configure your system and prepare your data. Also see the section 
“Import Invoices” in the Magaya Software Accounting Manual. Also see the 
Knowledgebase:
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http://knowledge.magaya.com/#/article/import_invoices

To include Account Definitions when exporting to QuickBooks®, click this 
option in the Configuration menu:

This will include the Account Definition from the Chart of Accounts in the 
output saved from Magaya Explorer and to be used in QuickBooks. It is 
important to make sure your accounts have the same names in both Magaya and 
in QuickBooks to avoid duplicates.

To include customers and vendors when exporting from Magaya to Quick-
Books, check the box. This will create the name in QuickBooks. Again, verify 
that the entity names are the same in both Magaya and QuickBooks. This 
options is disabled if you have multicurrencies turned on in your Magaya 
system. If you have the entity name in QuickBooks already, you will not need to 
check this box.

Check the box if you want to use Inventory Charge Definitions, not Inventory 
Item Definitions, when exporting to QuickBooks. If unchecked, it will export 
the Inventory Item Definition name, not the “Items & Services” account associ-
ated with it.

Extra Info: Magaya software can also integrate with other programs such as for 
managing purchase orders. If you need this functionality, please discuss the 
Magaya API with your Logistics Management Advisor.
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Credit Limit Configuration

To select the actions you want to take with customers who exceed the credit 
limit, use the options listed in this section of the Configuration menu. You can 
select just one, two, or all the options:

After you set a credit limit, the system will alert a user when a customer has 
reached their credit limit. For example, if you check the option “Do not release 
the cargo”, the system will not let you release any cargo. If you select “Do not 
accept more bookings (online also)” then the system will not let any bookings 
be made for that customer. A notice will appear to tell the user the credit limit 
has been reached.

A column can be added to lists to see if a customer has reached their credit limit. 
Click the Actions button in a list such as the Customer List.

The amount of the credit limit can be set in the Customer profile on the 
Payment Terms (Pmt Terms) tab. Learn more in this Knowledgebase article:

http://knowledge.magaya.com/#/article/payments
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Miscellaneous Accounting Configurations

This screen include various settings:

Periodic Invoices: To invoice periodically means that all charges generated for 
a customer will be accumulated in a single invoice as the end of the period (week 
or month). For any customer that you set this option for, the system will add 
charges to one invoice. To invoice customers periodically, click one of the 
options:

• Do not apply

• Weekly (Fridays)

• Monthly (this option enables you to set up to five dates in a month to 
invoice customers):

The option you set here becomes the default in the system. To change a setting 
for a specific customer, go to that customer’s profile and make the change on the 
“Pmt Terms” tab.

The “Periodic Invoices” option can also be set up in the Payment Terms (“Pmt 
Terms”) tab of any Customer profile. In that screen, you can determine per 
 191



Chapter 10 Accounting Configuration
customer how to apply the periodic invoice, customizing how the period 
invoices are handled for an individual customer.

Expense Items on Invoices: The option to “Allow to add expense items on 
invoices” will include expenses in a customer’s invoice. This is not recom-
mended according to many accounting best practices. This option is off by 
default.

Other Settings:

- To exclude new invoices from being viewed online, check the box.

- To enable the system to automatically generate recurrent transactions, check 
the box.

- Override the division of generated accounting transactions with the division 
of the source operation. This is designed to be used by companies that have 
more than one division so that the source (originating organization/parent 
company) will be able to see accounting transactions that are created by a divi-
sion. It also enables those accounting transactions to be visible in reports.

- Use account numbers to search instead of names: Check this option if you 
want to be able to search by account number in any search field (also called a 
“lookup field”) in the system instead of searching by the account name.

Additional Financial-related Configurations

Magaya software includes additional configuration options related to other 
financial aspects of running your business. The configuration of these options 
is explained in the Knowledgebase and in the Magaya Software Customization 
Manual. Here are some of the features available, depending on which Magaya 
software your company is using and if you sell inventory:

• Automatic Charge Generation: to include charges automatically in trans-
actions (see also Chapter 11 of the Magaya Software Accounting Manual)

• Fiscal Printer: for use in Panama

• Sales: for sales orders and inventory commissions

• Purchasing: for billing purchase orders

• Online Payments: to enable your customers to pay online

• Payment Terms: to define payment terms for customers and vendors
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• XML Transformations: used for converting invoices, etc. from another 
system

• JavaScript: create your own code for custom transactions such as calcu-
lating rates

Tip: Set up some System Alerts to notify you when certain events occur such as 
when an online payment is received from a customer. Explore the Configura-
tion options to determine which ones suit your operations so you get the most 
from your Magaya software. See the user manuals and other training materials 
for steps. Find the resources on Page One, the welcome screen in your Magaya 
software.
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Average Cost

The cost of an inventory item can be defined as “specific” or as “average.” 
Magaya software enables configuring your system for either costing method. It 
can be set system-wide or per item.

The Average Cost method calculates the average cost for inventory items (in 
contrast to a specific identification method). The Magaya system calculates the 
average of all the inventory items you have purchased. Every time you sell an 
item, the system will add the amount to your "Cost of Goods Sold" account and 
deduct from the Inventory Account for that item.

This topic explains average cost, a method that is helpful when assessing the 
profit of selling your inventory. Sections in this topic include:

• How to configure average cost system-wide and per item

• How to create a resale item as an “average cost” method item

• Purchase items and create bills

• Sell items and invoice them

• See the purchases and sales on the Balance Sheet

Configure Average Cost System-wide

Go to Maintenance > Configuration > Accounting.

Click the “Cost” tab.
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The first item is used to select the costing method. This example shows 
“average.”

By selecting this configuration option, this costing method will apply 
system-wide. (If you want to set the costing method per item, see the section 
“Average Cost per Item.”)

Configure Average Cost per Item

This section explains how to define the costing method of an item at the Inven-
tory Item Definition level, not system-wide.

The costing method of regular inventory items and resale inventory items can 
be defined. For a regular inventory item, select the costing method on the 
Accounting tab of the Inventory Item Definition dialog box.
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For a resale item, select the costing method on the dialog box:

Additional Configuration

Extra Info: If you want your Magaya system to create bills before items are 
received, set this option in Configuration > Purchasing:

Ensure the box is unchecked to allow the system to create bills for POs only after 
all inventory is received. In contrast, if this box is checked, then you will not be 
able to make bills until after receiving the items.
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Choose Columns: Go to the Inventory Item Definitions List and choose the 
following columns to see the Total Purchase Cost and Average Purchase Cost.

The totals in these columns will changes as items are purchased and sold.

Extra Info: The system can switch between costing methods and display the 
average instantly when the method is changed. See the section “Changing 
Costing Methods” before making changes to ensure you fully understand how 
this will affect your system and the accounting.

Sell Items and Create Invoices

In this section, we look at how to use the items created with the average cost 
method by placing the items in a Sales Order (SO) and creating an invoice.

Note: When you purchased the items, the system records the purchase price of 
the items, regardless of the costing method used (average or specific method).

1. Create the SO and add the items to the Commodity tab.

2. Create the invoice from the Actions button. See the Adjustments tab of the 
invoice to see how the average amount is removed from the asset account and 
transferred to the account for the cost of goods sold. This invoice Adjustment 
tab example shows the average is $105 for items purchased at $100 and $110. 
The two lines show the asset account and the cost account.
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The Inventory Item Definitions List and the Balance Sheet reflect the new totals.

To see the Balance Sheet, click “Reports” from the menu at the top of your 
Magaya Explorer screen.

The amounts are shown in the Balance Sheet’s Inventory Assets section, 
including the bill for each vendor and the invoice for the customer:

Specific Identification

An alternative costing method is “Specific Identification,” which is used to keep 
track of the exact cost of each item of inventory that is purchased and sold for 
each specific item. The exact cost is subtracted from your inventory assets 
account for the item sold. This will be displayed on the Adjustments tab of the 
invoice.

Your Magaya system can be configured to the costing method of “Specific Iden-
tification” in the Configuration > Accounting menu to apply the setting 
system-wide.
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To apply the costing method per item, go to the Inventory Item Definition 
dialog box, and select the method on the Accounting tab (or in the wizard for a 
resale item).

If your system is set to FIFO, the system will fill an order by taking the first item 
and record the price for that specific item.

Changing Costing Methods

Changing the costing method affects the invoicing, the accounts for Inventory 
Assets, for Cost of Goods Sold, and the balance sheet. This is an advanced 
accounting function. We recommend that you ensure you understand how this 
will change your accounting system before changing from Average Cost to 
Specific Identification and visa versa.

If an “Average Cost” item is invoiced, there may be a balance left in the asset 
account when changing that item to “Specific Identification.” To correct the 
balance, create a Journal Entry to transfer the balance left in the asset account to 
the item’s cost of goods sold account. For details on creating journal entries, see 
the section “Journal Entries” in Chapter 10 “Advanced Accounting Features” in 
the Magaya Software Accounting Manual.
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Landed Cost Management

Landed Costs are all the costs of items such as transportation costs, duties and 
taxes, in addition to the cost of the item itself.

Configure Your Magaya System for Landed Costs

Go to Maintenance > Configuration > Accounting. Click the “Cost” tab.

Click the checkbox to activate the Landed Cost options. When you check this 
option, also decide how to prorate the charges, by cost or by pieces.

The Landed Cost setting automatically prorates the costs and creates the asset 
adjustments for additional charges found in Purchase Orders (PO) when the bill 
is created from the PO. If you bill a third party, instead of the main vendor, the 
landed costs are also updated. If items are added or removed, the system updates 
the landed costs.

Save the configuration.

Landed Costs in “Items & Services”

To use landed costs, you must tell the system which item in the Items & Services 
list will calculate landed costs:

• Go to the “Items & Services” list.
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• Select the service charge such as Inland Freight Cost, and double-click to 
open it.

• On the tab “Landed Cost,” check the box to include this non-inventory 
charge in Landed Cost. (Note: This tab only appears when configured to 
activate it.)

What will happen: When a PO is created with this Inland Freight charge, the 
charge will be distributed (prorated) across the items in the list. See the PO 
dialog box to view how the costs are prorated. Tip: Right-click in the Commod-
ities screen of the PO to choose the columns if needed to view them. The column 
“Other Costs” means costs non-inventory costs.

Remember: Only costs that are defined as Landed will be included as Landed. Be 
sure the services or items in your Items & Services list are marked as Landed.

When a PO with charges for landed costs is billed, the Bill for the other charges 
will also contain an asset adjustment. The charges for landed costs will be added 
to the inventory asset account. When selling, the landed cost charges will be 
deducted from the inventory asset account (in addition to the inventory items).

View the details in the Inventory Item Definitions List (choose the columns for 
average landed cost, total landed cost, and average additional cost).
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This will also affect your Balance Sheet and Trial Balance in your Magaya 
system.
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Sales Taxes

Introduction to Sales Taxes

Sales taxes can be found in the Tax Table in the Magaya Explorer Chart of 
Accounts under the Actions button.

Note: For handling taxes (VAT) in other countries, see the examples in the 
“Additional Resources” section below.

We recommend that you evaluate the configuration options in your Magaya 
system to handle taxes specifically for your business before you begin adding 
taxes to the Tax Table. The Magaya Configuration menu contains the following 
options:

For details on these configuration options, please see the “Accounting Config-
uration” section of Chapter 10 in the Magaya Software Accounting Manual.

After you add a Tax Item, it can be added to an Item or Service. This will auto-
matically include the tax when the item is used in an Invoice or Bill.

If you work with an entity that is tax exempt, check the Tax Exempt option in 
their profile on the “Pmt. Terms” tab (Payment Terms).

Follow the steps below to add a new tax item.
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Steps to Add a Sales Tax Item

1) Go to the Chart of Accounts.

2) Click on the Actions button and select “Tax Table List.” A list opens. (Note: 
The list will be blank if you have not added any items.)

3) Click the “Add” button and select “Tax” to add a tax, or select “Tax Group” 
to add a tax group. A dialog box opens:

• Enter a code for the tax item. It can be any combination of letters and/or 
numbers.
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• Enter a description of the tax item, for example “Miami Dade County 
Sales Tax.”

• Select the tax authority from the dropdown. This is where the taxes will be 
collected. If you need to add it, click on the plus sign. The tax authority is 
considered a “Vendor” so the vendor dialog box opens.

• Enter the percent for the tax such as 15%. (Enter the number only, not the 
percent symbol.)

• Set a minimum and/or maximum as needed. Use this to pay taxes only 
within the range you define here. For example, if a certain tax is collected 
only on the first $5,000 then check the box for the “Maximum” field and 
enter 5000.

• Use the default Asset and Liability accounts or change them as needed. 
Remember: The Asset account is used for Bills, and the Liability account 
is for Invoices (except for withholding/retention tax transactions, which is 
the reverse).

• On the “Dependencies” tab, add any taxes that depend on this tax. This 
means the amount of the tax depends on the other taxes included here. 
The rate is applied on top of the sum of the rate of the dependency. See the 
section “Tax Dependencies” for more.

• Click the OK button when you are done.

The tax is added to the Tax Table and ready to use.

How to Include Taxes in Items & Services:

To automatically include the tax in an item or service, go to the Items and 
Services folder, select the item (or service), and select the tax from the Tax Code 
dropdown.
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How to Use Sales Taxes in Invoices and Bills:

When you select the tax in an invoice or bill, the tax amount will be calculated 
based on the tax percentage of the tax item and will be added to the total. The 
amount of the charges will be listed, and the tax amount will be shown sepa-
rately. Then a total that includes the charges and the tax will display. This is the 
freight charges screen from an invoice:

Create a Withholding Tax (Retention)

Withholding taxes are common in certain countries. When it is configured and 
used in invoices, the withholding tax amount is subtracted from the invoice 
total because the buyer withholds it from the seller and then pays it to the 
government tax authority.
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First, configure your Magaya system to enable withholding by checking the box 
in the Configuration > Accounting menu on the “Taxes” tab:

Go to the Chart of Accounts. Click the Actions button and select “Tax Table 
List.” A list opens.

Click the “Add” button and select “Tax Withholding.”
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Create the withholding tax by filling in the fields: Start with the Description field 
or the code.

Select the tax authority (or create it via the dropdown menu).

Enter the rate (percent). Do not enter the % symbol in the field; enter numbers.

The minimum/maximum fields are optional.

Group Taxes

When you need to apply more than one tax to an item in a transaction, it’s a 
good idea to group those taxes into one group. Then you can add the group tax 
to the transaction, and the system will calculate the total of all the taxes in the 
group. This will enable you to pay separate tax authorities for each tax within 
the group. Single taxes can be used in many different groups. When you update 
one of the taxes in a group, then the update will be applied everywhere that tax 
is used. You can also apply the group to a specific item or service in your list of 
Items Services.
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To group taxes together, click the “Add” button in the Tax Table List, and select 
“Tax Group.”

Enter a code name and a description for the tax group. The other fields on the 
General tab are not needed for the group.
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On the Dependencies tab, add the taxes to the list.

These individual taxes will be added together to create the total for this group.

Click OK to save.

Tax Dependencies

The Magaya system enables you to define taxes as dependent on other taxes. The 
single taxes will be multiplied together. This is also called cascading taxes.

First configure your Magaya system to enable cascading taxes. If not, then the 
“Dependencies” tab will not be activated in the Tax dialog box. It will only be 
available in the Tax Group dialog box.

Steps:

1. Open an existing tax or create a new one.
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2. On the “Dependencies” tab, check the box “This tax dependent on other 
taxes.”
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3. Click the “Add” button to open a dialog box with all the single taxes listed.

4. Click “OK” to save the tax in the Dependencies list.

Add any other taxes as needed, and click “OK” when done. Now this tax is ready 
to use.

Change a Tax Rate

The Magaya system has a wizard to enable you to update (or change) a tax. If a 
tax is used in a group, and you update the tax, the update will apply to all groups 
where that tax is included and any item or service that use that tax.

The updated tax will only be applied to newly created transactions. It will not 
change existing invoices or other transactions already using the tax.
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Note: If a tax has been used in a transaction, the tax cannot be deleted from the 
system. It will be saved in the system for older invoices, etc.

A dialog box opens. Begin on the first screen and follow the prompts:
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Next, add any dependent taxes, if applicable.

Next,
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In the next screen, the process is complete when the green bar is full.

Click “Finish” to save.

The previous tax is now deactivated. A tax can only be updated once. The new 
tax is active and ready to use.

Additional Resources

For example of handling tax retention (i.e., withholding tax; Value Added Taxes 
(VAT) or IVA (Impuestos por Valor)), see the following articles for examples 
from the following countries:

VAT Example for Ecuador:

http://knowledge.magaya.com/#/article/VAT_example_Ecuador

VAT Example for Colombia:

http://knowledge.magaya.com/#/article/tax_example_Colombia

VAT Example for Mexico:

http://knowledge.magaya.com/#/article/tax_example_Mexico

VAT Example for Canada:

http://knowledge.magaya.com/#/article/tax_example_Canada
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VAT Example: Ecuador

Introduction

Value Added Taxes (VAT) are often used in Latin American countries. The 
VAT is also called IVA (Impuestos por Valor). Another common practice is 
withholding tax, called "Retention." The following example illustrates how to 
create the tax items in Magaya to calculate these taxes so they are saved in your 
Magaya system when you need to pay them.

Tax Example

First, configure your Magaya system to enable withholding by checking the box 
in the Configuration > Accounting menu on the “Taxes” tab:

Overview of the example of withholding tax in Educador: For an invoice total-
ling $100, the IVA is 12%. There is a withholding of income of 2% and a with-
holding of VAT at 70%.

Prepare to create these tax functions in your Magaya system: This tax is 
payable to the Ecuador department of revenue called Servicio de Rentas 
Internas (SRI). You can create the entity now if you don’t have it in your Magaya 
system yet by using the menu in the dropdown box of the tax dialog box. You 
will also need to enter a Code for each tax below. This example shows Ecuador 
to illustrate the process. Change the tax names for your real tax.

Note: All sales taxes are created in the Chart of Accounts > Actions button > Tax 
Table.
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To perform this example calculation in Magaya, create these three types of 
taxes and one group:

1) Create a tax by entering "VAT Ecuador" in the Description field. Select the 
Tax Authority the Ecuador department of revenue called Servicio de 
Rentas Internas (SRI). Click OK to save and close.

2) a) Create a tax withholding item by clicking the “Add” button and 
selecting “Tax Withholding.”

Name it "VAT Withholding EC" and enter 70% for the rate.
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Enter a description and code.

b) On the Dependencies tab for this tax, check the box "This tax dependent 
on other taxes".
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Click "Add" to add the "VAT Ecuador" item you created in Step 1.

Click OK to save and close.
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3) Create another withholding Tax called "Ecuador - Income Tax" and enter 
2% for the rate. Click OK to save and close.
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4) a) Create a Tax Group called "Ecuador Tax Group."
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b) On the Dependencies tab, add all the taxes created in Steps 1 - 3.

Click OK to save and close.

How it Works:

The Magaya system calculates the taxes for the example invoice of $100 by 
applying all the taxes in the Tax Group as follows:

• The VAT Ecuador tax is calcuated as $100 x 12% = $12

• The VAT Withholding EC is calcuated as $12 x 70% = $8.40

• The Ecuador - Income Tax withholding is calcuated as $100 x 2% = $2

Result: The compounded tax is calculated.
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Tax Example: Colombia

This topic shows an example of handling taxes and withholding taxes in Magaya 
software for Colombia.

Note: All sales taxes are created in the Chart of Accounts > Actions button > Tax 
Table.

First, configure your Magaya system to enable withholding by checking the box 
in the Configuration > Accounting menu on the “Taxes” tab:
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1. Create a list of taxes, and create the Sales Tax (example 16%).

2. Then create the retention/withholding tax (example 15%); the 15% depends 
on the sales tax, so it is added on the Dependencies tab of the first tax dialog box.

3. Regional taxes can also be created.
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4. Create a group for each tax region. By creating a group for each region, you 
add only those taxes that apply to that region.
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When you create an invoice for an item that has a tax or tax group applied to it, 
the invoice shows the amount of tax withheld (retained).

The Adjustments tab of the Invoices shows the details:

Note: There is a Spanish-language template to display the retentions. The 
template is available in the Spanish version of Magaya software and in the 
English version. To get the Spanish template in the English version, you must 
select the option during the installation of the software or during the update to 
Magaya software version 9.7.

Note: Retention is also applied when Bills are created.
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See the results in the Sales tax report.

The Sales Tax Liability report shows the retention amounts as negative 
numbers.

The Purchase Report will also show retention as negative numbers.
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When you pay your taxes, the Payment screen shows what is due (ensure the 
box is checked to view balances due). Select the transactions to pay.
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Tax Example: Mexico

This topic shows an example of handling taxes and withholding taxes in Magaya 
software for Mexico. Note: All sales taxes are created in the Chart of Accounts > 
Actions button > Tax Table.

First, configure your Magaya system to enable withholding by checking the box 
in the Configuration > Accounting menu on the “Taxes” tab:

1. Create the sales tax.
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2. Create the withholding tax by clicking the “Add” button and selecting the 
“Tax Withholding” option.

Enter a description, a code, and the rate. Two-thirds of the tax is withheld = 
66.67%. Select the tax authority.
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On the Dependencies tab, add the sales tax.

Create the tax group and add the taxes needed. By creating a group for each 
region, you can add only those taxes that apply to that region. Then add the 
applicable taxes to the groups.
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When you create an invoice for an item that has a tax or tax group applied to it, 
the invoice shows the amount of tax withheld (retained). Note: Retention is also 
applied when Bills are created.

The Adjustments tab of the invoice shows the details.

Note: There is a Spanish-language template to display the retentions. The 
template is available in the Spanish version of Magaya software and in the 
English version. To get the Spanish template in the English version, you must 
select the option during the installation of the software or during the update to 
Magaya software version 9.7.
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See the results in the Sales tax report.
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Tax Example: Canada

This topic shows examples of handling taxes for Canada in your Magaya system.

There are three types of taxes for Canadian businesses:

• Goods & Services Tax (GST)

• Provincial Sales Tax (PST)

• Harmonized Sales Tax (HST): This is used in provinces that combine the 
GST and the PST into a single Value Added Sales Tax. In the Magaya 
system, this tax is handled the same as any other sales tax.

There are two possible scenarios when applying a GST/PST structure while 
invoicing:

• Simple tax calculation

• Compound tax calculation

Let’s see how to handle each scenario in your Magaya system. Note: All sales 
taxes are created in the Chart of Accounts > Actions button > Tax Table.

Simple Tax Example

For an invoice total $1000.

GST of 5% = $50

PST of 7% = $70
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Steps:

1) Create a Provincial Sales Tax (PST) of 7%
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2) Create a Goods & Services Tax (GST) of 5%

3) Create a Tax Group named “Canada Simple Tax Group” that includes the 
PST and the GST
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Compound Tax Example

For an invoice total $1000.

The PST of 7% = $70

The GST is calculated based on the PST and the original invoice amount, which 
is $1070 for this example. Therefore the GST = $53.50
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Steps:

1) Create a compound Provincial Sales Tax (PST) of 7% named PST CMPD
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2) Create a second Provincial Sales Tax (PST) of 7% named PST Base
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3) Create a compound Goods & Services Tax (GST CMPD) of 5%

4) Create a Tax Group named Canada Compound Tax Group that includes 
the PST CMPD, the PST Base and the GST CMPD.

How the Magaya system calculates the compound tax:

Using the PST Base tax that we created, the system will apply the 7% tax to the 
base of the invoice ($1000 x 7% = $70)

Using the GST tax that we created, the system will apply the 5% tax to the base 
of the invoice ($1000 x 5% = $50)

Using the PST CPMD tax we created, the system will apply the 7% to the 5% 
GST tax (5% x 7% = .0035%). This gets multiplied to the $1000. The result is 
$3.50.

In Summary:

Invoice Base = $1000

PST Base = $70
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GST = $50

PST CMPD = $3.50

Total $1123.50
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Approve/Dispute Invoices

This topic explains how to set up the option for your customers to approve or 
dispute invoices.

Configure: Approve or Dispute Invoices

To approve or dispute invoices, first configure this option in your Magaya 
system per customer:

• Go to Maintenance > Customers and right-click on the customer’s name 
in the list. From the pop-up menu select “Allow Tracking.” A dialog box 
opens.

• Click the Tracking tab in the Web Track User dialog box. Click the option 
“Approve/Dispute Invoices” to make a checkmark appear in the box.

Click “OK” to save the setting for this customer.

Configure per Contact: If a customer has more than one contact person, add 
their name, email, and information into the Contacts List, and send them an 
Invitation to use LiveTrack.

Invite the customer or contact to use LiveTrack: If you have not sent a 
customer the link to LiveTrack, do it by right-clicking their name from the 
Customer List and selecting “Send invitation email.” The customer must have a 
valid email address in their profile.

For more details on setting up LiveTrack for your customers, their passwords 
and more, see the Knowledgebase article:

http://knowledge.magaya.com/#/article/livetrack_setup
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How your Customers Approve or Dispute an Invoice Online

You can give your customers permissions to approve or dispute invoices online. 
They just need to log into LiveTrack, and go to the Invoices list.

Note: Customers will see only the transactions that you have given permission 
to access LiveTrack.

Right-click an invoice to see the pop-up menu of choices, including the option 
to approve or dispute an invoice.

For details on how to give your customers the option to pay their invoices 
online, see the Getting Started article in the Knowledgebase:

http://knowledge.magaya.com/#/article/online_payments_getting_started

Approve or Dispute in your Magaya System

To approve or dispute an invoice in your Magaya system, go to the Invoices List. 
Click the Actions button (alternate: right-click on an invoice in the list), and 
select “Approve/Dispute Transaction.”
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Enter the reason in the dialog box.

The comment appears in the Events tab for the transaction.

This option is helpful if you are on the phone with a customer or they send you 
an email to approve or dispute an invoice, and you need to make the change in 
their invoice.
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Journal Entries

Introduction to Journal Entries

Journal Entries are used to track non-routine transactions such as depreciation 
or sale of an asset. When you create Journal Entries in Magaya Explorer, they 
are saved in a list that you can sort and filter.

Steps: Create a Journal Entry

1. Go to the Chart of Accounts and click the “Actions” button.

2. Select “General Journal Entries”. A list opens.
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3. Click on the Add button. A dialog box opens.

The date field displays today’s date. Change the date if needed. Enter an Entry 
number.

4. In the dialog box, follow these steps:

• Click on the Add button to add a new line to the journal entry. A line in 
the table will be highlighted. The line has columns (these are also called 
“fields” because when you click on them, they become active and you can 
enter information).

• The first column in the line is “Account Name”. This is the account that 
you will apply the line to. The field becomes a dropdown menu. Select the 
account from the dropdown.

• The second column is “Debit” where you add the amount you will deduct.

• The third column is “Credit” where you add the amount that you will add.

• The “Description” column is used to add a description (optional). This is 
a text field.
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• The “Entity” is a customer, vendor, etc. that is related to this journal entry. 
Click on the field to activate the dropdown menu. This information will 
appear when you list the transactions for this entity or customer.

• “Currency” is set when you set up your Magaya system (changes can be 
made in the Maintenance > Configuration). Each line can be in a different 
currency if you select an account that is in a different currency, but the 
amount shown in the Debit and Credit columns are shown in home 
currency:

• “Exchange Rate” is used to enter the exchange rate if you create this 
journal entry in another currency. This is the exchange rate between the 
currency you have selected and the home currency that your Magaya 
system is set up with.

• The sum of all the Debits must be equal to the sum of all the Credits to 
keep the entry in balance. The system will not let you add an Entry that is 
not in balance.

5. Click the OK button. The entry will be added to the list and posted to the 
appropriate accounts.

Actions for Journal Entries:

In the General Journal Entries list, click the Actions button to make a copy of a 
journal entry, create reports, print an entry or a batch, choose columns, or 
import or export data.

Other options for journal entries:
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• Reverse a journal entry (useful when changing credits by debits and vice 
versa)

• Display total of debits and credits in the screen of the journal entry

• Set up consecutive numbers for journal entries in the Maintenance > 
Configuration > Accounting menu

• Select the template when printing a journal entry

To view more details about a journal entry, select it and click the “Detail” 
button.
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Adjustments

Adjustments

The Adjustments tab reflects transactions that keep your accounts in balance.

The information on the Adjustments tab is Read Only.

It also shows the cost of inventory (asset), and then when you sell it, the sale will 
show in the Adjustments tab as a deduction from the assets and it is converted 
to the cost of goods sold.

For example, when you purchase an item for your inventory, you create a PO. 
From that PO, you create a Bill. When a customer purchases that item, you 
create a SO and an Invoice for the customer. The cost and income will show on 
the Adjustments tab of the invoice.

Another use of the Adjustments tab is to show adjusted gains and losses for 
currency exchanges. If you are using multiple currencies, you will see the differ-
ence between the rate on the day your created the invoice and the rate on the day 
the customer paid the invoice. When you receive the payment and update the 
exchange rate in the Payment dialog box, the Adjustment tab will show the 
difference in rates.
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When you change the rate in the dialog box, the system will ask you if you want 
to save the change (so it will be reflected for all transactions using that currency 
that you create after this one).

If you add an adjustment to an accounting transaction on the Accounts tab of a 
transaction dialog box, it will appear on the “Adjustments” tab of that transac-
tion such as the invoice dialog box. This one shows the bank fee for a NSF:
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Multiple Currencies

The Magaya system includes a list of common currencies that you can edit and 
add new currencies not included by default.

How to Set up Multiple Currencies in your Magaya System

This section explains how to set up your Magaya system to work with multiple 
currencies, how to activate existing currencies from the Currency List or add 
new ones to it, how to enter a transaction in a different currency, and how to 
work with Multicurrencies Reports.

You can set up multicurrencies two ways in Magaya Explorer: 1) in the Startup 
Wizard or 2) in the Maintenance > Configuration > Accounting screen:
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Home Currency: IMPORTANT! This option is active only if there are no 
existing accounting transactions. It is recommended that home currency be set 
up in the Startup Wizard; steps for using the wizard are explained in the Magaya 
Cargo System Operations Manual.

Apply exchange rate as per transaction’s date: Check this option to enable the 
system to save a history of past rates for currencies. This will enable you to select 
a currency by setting the date of a transaction to match a past currency rate from 
a past corresponding date. If you only want your system to have one rate per 
currency, do not check this box.

Multicurrency: When you check the box “Use Multicurrency,” the system will 
activate the use of more than one currency in your accounting system. Be aware 
this option cannot be reversed if there are existing accounting transactions in 
different currencies in the system. The transactions would need to be deleted 
before the system will allow you to reverse this option. You must click the “Save” 
button in this Configuration screen before you activate individual currencies.

Reverse Exchange Rate: If you work with currencies that convert to very small 
amounts, you may want to work with the reverse rate. Check the box for this 
option, and your Magaya system will calculate the rate for you. Leave unchecked 
for the direct exchange rate.

Automatically select account in entity’s preferred currency in accounting 
transactions: Check this option if you want your system to allow you to define 
a preferred currency for an entity such as a customer or vendor. By setting this, 
all charges and transactions created for that entity will use the entity's currency. 
The user will be able to change the currency per charge if needed. This applies 
to charges created manually or automated charges.

This will apply to the field "Apply to" in Invoices; to the "Vendor field" for Bills; 
to the "Customer" field for Payments; and to the "Pay to the order of" field for 
Checks.

In Shipment liquidations, the accounting transactions for the agent will be in 
their preferred currency (if you set it). Commissions for salespersons can also 
be defined with a preferred currency.
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First, turn on the option in the Configuration menu. Then open the profile for 
the entity, and click on the Payment Terms tab.

How to Activate Currencies

To activate specific currencies that are included by default in your Magaya 
system, go to Maintenance folder > Configuration > Accounting.

Click the “Currency List” button. The Currency List opens:
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Double-click a currency to open it:

Check the box “This currency is active” to activate the currency so it can be used.

Click OK to save and close the dialog box. A checkmark will appear in the 
Currency List, indicating that currency is active. The system will automatically 
create an A/R, A/P, and bank account for the activated currency.

Changing a currency rate to apply to a previous date: If you have configured 
your Magaya system to save the history of currencies, then you can enter a rate 
and assign it to a previous date. Right-click the currency and select “Enter 
previous exchange rate.”
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A dialog box opens. Change the date by clicking the numbers themselves or the 
calendar icon. Change the currency rate. Click OK to save the new rate.

The system saves the old rate in the Detail panel of the Currency List.
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How to Add a New Currency to the Currency List

• In the Currency List, click the “Add” button to open a new dialog box.

• Enter the currency name and code. The symbol is optional.

• Enter the current exchange rate and today’s date.

• Click on the checkbox “This currency is active.”

• Click the OK button. The currency is now available in your system.

How to Manage Exchange Rates

Depending on how you configure your Magaya system, there are two ways to 
manage exchange rates: Change the current one, or change a past one.
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To change the exchange rate of a currency for today’s date, double-click the 
currency. A dialog box opens:

• Enter the updated exchange rate in the “Exchange Rate” field.

• Today’s date is displayed by default. The date field is not active in this 
dialog box.

• Click OK to save the changes.

The system updates the current rate and saves the history of the previous rate in 
the Detail panel.

To change a currency rate for a past date:

Right-click the currency and select “Enter previous exchange rate.”
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Enter the information in the dialog box:

Change a Currency Rate for a Specific Transaction:

You can also manage exchange rates while you are working in a transaction. 
This is the most efficient method of managing the exchange rates because the 
system will update the Currency List for you based on the modifications you 
make in a transaction.

For example, if you are working on a shipment and modify the exchange rate, 
the system will ask if you want this modification to be saved in the Currency List 
and to update the rate for all transactions. If you only want to use this currency 
for this transaction, click No. If you want to save the change, click Yes. This will 
update the Currency List and you will not have to go to that list to update it. It 
will update automatically.

Note: Currencies cannot be changed for transactions that have already been 
liquidated and the accounting transactions were generated.
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How to Create an Operations Transaction in a Different 
Currency

When you are working in an operations transactions such as Pickup Orders, 
Warehouse Receipts, Shipment, etc., an individual charge can be set to any 
currency activated in your Magaya system:

When you liquidate an operations transaction that has charges in multiple 
currencies, separate invoices will be generated for each currency.

The currency for ALLthe charges in a shipment can be defined by using the 
Actions button. The currency of the shipment is used as the currency of the 
Invoice or Credit Memo generated for the agent in the liquidation.

To learn more about liquidating shipments in Magaya, please see Chapter 14 of 
the Magaya Cargo System User Manual.
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How to Create an Accounting Transaction in a Different 
Currency

There are different ways to select a different currency or to change the rate of 
one currency in a transaction:

Select a Different Currency Account: When you create an invoice, you can set 
the currency by selecting the AR account. That will define the currency for this 
invoice:
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When you select a different currency account for the transaction (such as from 
the Euro to the Brazilian Real), the system asks you how you want the changes 
applied:

Select the option you want:

• “I used a wrong account to create this invoice and now I am selecting the 
correct one...” This will change the currency denomination and exchange 
rate but not the charges amount.

• “I’m changing the account and currency for this transaction . . .” This 
changes the charge amount to the new currency by using the exchange 
rate you enter in this dialog box. (Selecting this option activates the 
exchange rate fields.)

Click “OK” to save and close.
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Type in a different number for the same currency: You can also change the 
exchange rate of that currency by typing directly in the dialog box in the field 
“Exchange Rate.”

The system asks if you want to change the rate only for this transaction or also 
update the Currency List.

In the dialog box, click the option you want:

• To change the rate for this transaction only, click No.

• To change the rate both here and in the Currency List, click Yes. (This will 
update the Currency List automatically, and you will not have to go to that 
list to update it.)
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Change the rate by changing the date: If your Magaya system is configured to 
apply a currency based on the date of a transaction, you can select the date in the 
transaction, and the system will automatically use the currency from that date.
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Multicurrency Reports

Multicurrencies can be viewed in different reports in your Magaya system. 
When you are viewing a financial report such as a P&L report, you can change 
the currency of that report by using the Actions button:

The currency will change and the totals will be updated automatically in the new 
currency.
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To see a report of gains and losses due to working in multicurrencies, go to the 
top toolbar in Magaya Explorer and selecting the Reports menu. The reports 
available show realized and unrealized gains and losses.

To view payments by currency, by click the Actions button in the Payments List 
and selecting Reports. Then choose “By currency”.

See the section “Multicurrency Reports” on in the “Accounting Reports” in 
Chapter 9 of the Magaya Software Accounting Manualfor more details.
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Relationship Between Accounting & Operations

Magaya Explorer links operations transactions with accounting functions in the 
following ways:

1) Charges can be entered as you add operations transactions to your 
Magaya system.

The system uses the Items and Services that you defined in the Items and 
Services list (under the Accounting folder) to fill in the charge dropdown 
in the charge screen.
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2) The charges entered in an operations transaction such as a Cargo Release 
(CR) are used to create Invoices and Bills during the Liquidation process. 
To liquidate the charges in a CR, click on the Generate button.

Liquidation of CRs, WRs, shipments, and other transactions is explained 
in the Magaya Cargo System Operations Manual.

3) Each operations transaction can have a list of accounting transactions 
(Invoices and Bills) related to it. For each operations transaction, you can 
click on the Actions button and select the Transaction Listing.
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4) Each accounting transaction (Invoices and Bills) has a list of operations 
transactions related to it. For most of the Invoices and Bills, there is only 
one related transaction. The exception is for Periodic Invoices which will 
often have more than one related transaction. Then you will see a 
“History” button.

In this screenshot, this Invoice is related a Shipment. To view the details 
of the Shipment, click on the Shipment button. To go to the Shipment, 
click on the arrow button.

You can also view the History of an accounting transaction when you are 
in the list view such as the Invoices List or Bills List. Select the transaction 
and click on the Actions button. You can also go to the document from the 
Actions button.
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Accounts Receivable Special Procedures

This topic explains how to perform the following accounting procedures, some 
of which are manual. Newer procedures may have replaced these, but these are 
still published for those who still need them:

1) Process a discount for a customer

2) Handle bounced checks

3) Process wire transfer fees

4) Make petty cash deposits
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Processing Discounts Manually

How to add a discount manually to an invoice:

1) Begin by creating the invoice as you normally would by filling in the fields 
and adding the charges.

2) In the Invoice dialog box, click the “Accounts” tab (next to the “Charges” 
tab).

3) Click the Add button. Select a discount expense account.

4) In the line, click the column “Account Name,” and select the expense 
account for discounts. Note: In Magaya software 9.3 and higher, the 
system includes a default “Discount Account.”

In the “Amount” column, click the space and enter a minus sign and the 
number; for example, to offer a $1,000.00 discount, enter -1000.00 in the 
column.

The Description and Entity columns are optional.
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The total will be updated automatically. Click the Close or OK button to save.

Note: You can set payment terms for a customer for a customer in their profile. 
For details, see the section “Set Customer Payment Terms” in the Magaya Soft-
ware Accounting Manual.

Learn how to set prices by item, category, client and more in the following 
Knowledgebase article on Pricing:

http://knowledge.magaya.com/#/article/price_management_tool

Handling Bounced Checks

Handling bounced checks in your Magaya system requires two transactions: 
One records the bank fee, and another creates a new invoice.

Scenario: You have already received the payment, but the check bounced due to 
non-sufficient funds (NSF).

1) Create a Check to Expense:

When you receive the bounced check from the bank, make a “Check to 
Expense” to record the bank fee.

Make the check payable to the bank for the NSF fee amount ($20.00).
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2) Now create another Invoice: Click the “Accounts” tab of the Invoice dialog 
box as shown here:

Include the amount that you will charge your customer to cover the fee that the 
bank charged you ($25.00), and the amount that the customer paid in the check 
that bounced ($1,500.00) that needs to be subtracted from the bank.

The “Bank Service Fee” is the income account in the Chart of Accounts for bank 
service charges such as this bounced check fee of 20.00. This example shows a 
fee of $5.00 added for processing.

Processing Wire Transfer Fees

When you receive a payment via wire transfer, the customer sends the full 
amount, but the bank charges you a fee for the wire transfer. There are two 
options to process this:

1) The payment that you receive will show the fee; or,

2) process the payment in full and create a Check to Expense for the wire 
transfer fee.
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The choice depends on how your bank charges you. The following example 
shows how to process option 1:

1) In the Payment dialog box, click the invoices that you want to apply the 
payment to.

Note: Click the checkbox to show open invoices.

2) Click the “Accounts” tab (next to the Invoices tab).
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3) Click the “Add” button, and add the information on the line:

Account Name (Bank Service Charges), Amount (this is the wire transfer 
fee that the bank charged you; this example shows -25.00), and a descrip-
tion (this is optional, but this example shows “Wire Transfer Fee”.

The total amount received must equal the amount paid ($2200.00 minus 
the fee of $25.00 = $2175.00).

Click OK to save.

Petty Cash Deposits

Use the Petty Cash account in your Magaya system to keep track of petty cash. 
This can be done when making deposits from customers who pays you cash by 
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depositing some of the cash in the Bank Account and assigning a small amount 
to the Petty Cash account.

1) Go to Deposits, and select “Deposit Payment”. In the dialog box, select the 
payments that you want to deposit.
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2) Click the “Accounts” tab (next to the Payments tab).

3) Click the Add button, and add the information: Select the Petty Cash 
account, and enter the amount ($-50.00).

If you do not enter a minus sign, the amount of the petty cash will not be 
deducted from the Deposit total. This example shows the total deposited 
in the bank account is $6400.81 because we subtracted the $50.00 that you 
keep in petty cash.
 276



277

Chapter 11 11: Automated Accounting

11: Automated Accounting



Chapter 11 Automated Accounting
Automated Accounting

Introduction to Automated Accounting

Magaya Explorer provides options to automate the creation of accounting 
transactions. This process is divided into two steps: 1) First, create the transac-
tion, and 2) tell the system how to calculate the prices.

1) Automated creation of accounting transactions is done with the following 
features:

• Automatic creation of charges in operations and when working with 
routes

• Recurring accounting transactions

• Periodic invoices

2) Calculate the prices or fees for the created transactions with the following 
features:

• Tariffs

• Rates for carriers and clients (i.e., your customers)

• Manage contracts

Automated Creation of Charges

Magaya Explorer enables you to add charges and make them appear automati-
cally in operations transactions. If you set up charges and tell the system to add 
them to transactions automatically, then the charges will appear each time that 
type of transaction or document is created. The charges are also carried over 
from one transaction to another when you convert one into another. For 
example, charges added to a Pickup Order or Warehouse Receipt are carried 
over into a Shipment when the transaction is converted. The created charges 
will also be used later in the liquidation to create accounting transactions.

Existing charges in your Magaya system can be automated, or you can create 
new ones and automate them.

Set Up:
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Go to Maintenance > Configuration > Automatic Charge Generation. Verify 
the checkbox is checked to allow automatic generation of charges. The setting is 
on by default and set to use the current date. Modify the date setting as needed.

To set up automation on existing charges, follow these steps:

1) Go to the Accounting folder in Magaya Explorer > Items and Services.

2) Select an item that you want to automate, for example, the Cartage Fee. In 
this example we will add a charge to each containerized ocean export ship-
ment for taking the container to the port. Double-click on "Cartage Fee" 
(or select it and click the Edit button).

3) The “Items and Services” dialog box for the Cartage Fee opens:
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Click the “Automatic Creation” tab and follow these steps:

Activate the checkboxes by clicking on the box next to “Enable Automatic 
creation for:” and a checkmark will appear in the box (1).

Check Ocean House Shipment (OHE) under the Export Shipments list (2).

Click on the “Modes of Transportation” button (3):

• In the screen that opens, uncheck the box to "Apply this charge to all the 
modes of transportation available (1). Then uncheck the other boxes 
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"Vessel" and "Barge" so only the “Vessel, Containerized” option is checked 
(2):

Click OK in the Appliable (applicable) Modes of Transportation dialog 
box to return to the Items and Services dialog box. (Using the Modes of 
Transportation button is optional, but for this example we used it because 
we want only the “Vessel, Containerized” mode.)

• To allow the charges to appear in the operations documentation that is 
viewable to customers, leave the checkbox blank for “Do not Show in 
Documents.” If you do not want the charges to appear in the operations 
documents, check the box.

• If the price for this charge depends on other charges, click this checkbox. 
For example, if you include an insurance charge in a transaction, that 
charge depends on the freight and value of the cargo (which will be calcu-
lated first). The Priority setting only applies to how the charge will be 
displayed in documents, LiveTrack and Transaction Tracking. See more 
details on these functions in the chapter “Items & Services.”

• Click the OK button when done.
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Result: When you are done, the Items and Services list will show which transac-
tions have charges that will be automatically created.

In this example, when an Ocean House Export (OHE) shipment is created and 
"vessel containerized" is selected as the mode of transportation, a charge for 
Cartage Service will be added to that house shipment. (Charges created auto-
matically will always be added after you selected the "client to bill" for that trans-
action.)

The price of the created charge will be calculated based on the tariff or rate set 
for that charge. See the section on Tariffs for details.

Note: In addition to adding the Automatic Creation functionality to an existing 
Item or Service, you can also add a new Item or Service and automate charges 
for it. For example you may want to automate an Express Shipment Surcharge 
for high-priority shipments. Then, each time you create a high-priority ship-
ment, the surcharge will be added. Use the Add button in the Items and Services 
list to add a new item and automate the charge, following the same steps above.

Any automated charges you create will be added to online shipping orders as 
applicable when your customers create Pickup Orders, Cargo Releases, or Ship-
ments in Magaya LiveTrack.

Note: If you want charges to be automated in online sales orders, enable the 
charges you want from the Items & Service list, and then activate this option in 
the Configuration > Online Sales Orders > “Generate charges automatically for 
online sales orders.” Then customers will see the charges online.
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Automate Charges per Customer

You can also automate or override charges per customer on the Charges tab of 
the Customer profile dialog box. For example, you can add an income item that 
applies to this customer.

1) Open the Customer profile dialog box, go to the “Charges” tab, and click 
“Add.”

2) Select the charge. You can select income or expense charges.

3) Enter a fixed price or set a tariff. (For help setting a tariff, see the section 
“Customize a Tariff.”)

4) Optional, depending on the type of accounting transaction you are 
creating: Select the vendor to apply the cost to, if this is an expense for you. 
This option is useful when you perform work for a customer and incur 
expenses that you need to pay to a vendor.

If you do not want the charge to appear in documents, check the box.

If the calculation of this charge depends on other charges in the transaction, 
check the box.

If you want to make this charge automatically appear in certain transactions, 
click the tab “Automatic Creation” and select the transaction.

Click “OK” to save the charge and again to save it for the customer profile.
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Creating Charges from Routes

In Magaya software version 9.0 and higher, there is a feature that enables you to 
create routes and add charges for them. The routes management feature creates 
segments and routes for multimodal shipments.

• You can add costcharges for routes, and those charges will appear auto-
matically on the Master of a shipment that you create using the route.

• When you add salescharges to a route, that charge will appear on the 
House section of a shipment transaction.

If a shipment does not have a route selected, your Magaya system will create 
charges will use the automatic creation of charges setting.
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Recurrent Accounting

Introduction to Recurrent Accounting

In Magaya Explorer you can set up recurring accounting transactions for:

• Invoices

• Bills

• Checks

For example, you can create a recurring invoice for your regular customers such 
as suppliers who store goods in your warehouse. The recurrent invoice charges 
them every month for storage. A wizard walks you through the setup so you do 
not have to create the invoice each month or other time period you set.

Set Up Configuration:

Go to Maintenance > Configuration > Accounting > on the Miscellaneous and 
check the option “Automatically generate recurrent transactions.”

Create a Recurring Invoice

To create a recurring invoice template in Magaya Explorer, follow these steps:

1) Go to the Invoice List.
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2) Click the Actions button and select “Recurrent Invoices:”
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When the list of recurrent invoices opens, click the “Add” button:

A dialog box opens the Recurrent Transaction Wizard. This wizard will create 
a template for a new recurring invoice. All future invoices for this customer will 
be built on this.

Every month when the system automatically generates the next recurring 
invoice for the customer, this template will be used. The date and charge 
amounts will be updated each month to reflect the new charges, while the other 
elements of the template such as the customer’s address will be the same. You 
will not have to re-enter the information. If you need to change something such 
as the address in the future, you can edit the recurrent invoice by using the Edit 
button.
287



Recurrent Accounting Chapter 11
The first screen in the Recurrent Transaction Wizard contains the following:

• Enter the transaction number in the “Number” field. This is the number 
of this template, not the number of the invoice. The invoice number will 
be generated at the moment that the invoice is automatically generated.

• Click on the “Apply to” dropdown menu to select the customer that will 
receive the recurrent invoice. The address displays automatically. To 
change it for this transaction, click the Change button. The date is filled in 
automatically.

• Select the Account this transaction will refer to such as Accounts Receiv-
able.

• The Transaction Date is set automatically to today’s date. Change it as 
needed. This is the date that you created this template.
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• Click the “Add” button in the wizard screen to add a charge. A dialog box 
opens:

– a) Select the type of charge such as Storage Fee (whic is an Income 
item).

– b) Enter a description (optional).

– c) The quantity, units (such as pounds), and the price will be calcu-
lated by the system automatically each time the invoice is generated. 
A price can be added if you want to have a set charge not based on 
the cargo on hand.

– d) Click the OK button to save this charge and return to the wizard 
screen.

• Set the “Paid as” option to either Prepaid or Collect based on the terms of 
the agreement for this recurring invoice.

• Click the “Next” button to go to the next screen in the wizard.
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The next screen in the wizard enables you to set the frequency of the invoice.

• Select the start date. Today’s date is filled in automatically. Change it as 
needed. This is the date that the system will begin generating these 
invoices. You may create the invoice template to begin invoicing the 
customer starting next week, for example. Next week’s date will be used in 
the invoice. You can also set up retroactive recurrent invoices by using a 
past date.

• Set the end date, or check “Never Ends” if the service is continuous.

• Generate: Select the frequency that you want to generate the invoice: If 
you select Monthly, also select the day of the month (1-31) If you select the 
31st, the system will default to the 30th for months that do not have 31 
days. If you select Weekly, the invoice will be generated on Fridays.

• You can charge the customer in advance by clicking on the checkbox. If 
not, uncheck the box (it is unchecked by default). When charging monthly 
in advance, the customer is paying for that whole month in advance.

• The checkbox for “On Hand” cargo in the warehouse is used for fees. The 
box is unchecked by default. Checking the box activates the fields below it.

Use this option to calculate the fee on the invoice based on the amount of 
cargo on hand for the client. The price will be calculated based on the tariff 
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you set up; in this example it is for storage. See the section on “Tariffs and 
Rates” for details.

If you want to give a customer some free days before charging for services 
such as storage to encourage quick movement of cargo, add the number of 
days in the days field “Amount of days before.”

• Other options are:

Generate a separate charge per line item. The number of charge lines in 
the resulting invoice will be the same as the number of cargo lines in the 
related warehouse receipt. This is useful to itemize oversized cargo.

Calculate charges based on the smallest packing unit. (If unchecked, the 
price will be calculated by pallet.) If the cargo is repacked in pallets, the 
price will be calculated based on the items inside the pallet.

You can also disable the recurring transaction by clicking in the Disable 
box.

• Click the “Finish” button.

Result: The recurring invoice template is added to the list of Recurrent Invoices. 
On the first of the month (or preset day), a new invoice will be created for that 
customer. The invoice appears in the Invoices List.

If you are using the PayCargo service, you can send the invoice to that service so 
the customer can pay it online; or you can give the customer Magaya LiveTrack 
permissions to pay the invoice themselves online. For details on setting up this 
service, please see the Magaya Software Communications Manual.

Note: You can also save an existing invoice as recurring by clicking on the 
Actions button when you are in the document view of the invoice:

The wizard opens. Fill in the fields as explained above. (You can also save an 
existing invoice as recurring when you are in the Invoices List. Right-click on 
the invoice and select “Save as Recurrent” from the pop-up menu.)
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Create a Recurring Bill

To create a recurring bill:

1) Go to the Bill List in the Accounting folder.

2) Click the Actions button and select Recurrent Bills:

The list of recurrent bills opens. If you have not created any recurring bills yet, 
the list will be blank.

In the Recurrent Bills list, click the Add button. A dialog box opens the Recur-
rent Transaction Wizard. This is the same wizard used to make a recurring 
invoice. See the section on recurring invoices for details.

You can also create a Recurring Bill from an existing bill: Go to the document 
view of the bill and click on the Actions button. The same Recurrent Transac-
tion Wizard opens. Follow the steps above.

Create a Recurring Check

Recurring checks can be created to pay for expenses that you have on a regular 
basis such as paying rent or insurance every month.

To create a recurring check:
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1) Go to the Checks List, click on the Actions button. Select “Recurrent Checks”.

A new list opens. If you have existing recurrent checks in the system, they will 
be displayed in the list. If you do not have any, the list will be blank.
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2) Click the Add button to add a new recurring check. A “Recurrent Transaction 
Wizard” dialog box opens.

• Select the bank account you want to use to pay this recurring check.

• Select who to pay this check to for the “Pay to the order of” dropdown.

• Optional: Enter a memo (note) if needed. Select a Division if applicable.

• Click the “Add” button. A line in the Detail table will be highlighted. Click 
in each field to enter information or use the dropdowns as they become 
active.

The total will be calculated.

• Click the “Next” button. The next page of the wizard enables you to set the 
frequency of the recurring check. The fields on this screen are the same as 
for creating a recurring invoice.

You can also create a recurring check from the document view such as right 
after you write a “Check to Expense” type of check. (The other types of checks 
cannot be made into recurring checks.) Click on the Actions button. Select 
“Save as Recurrent.” The same wizard dialog box will open.
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Actions for Recurrent Transactions

In the Recurrent Invoices list (and the Recurrent Bills list), click on the Actions 
button to access the following options:

• Generate Recurrent Transactions: If there are transactions due to be 
generated, they will be generated when you click the button. Otherwise, a 
note will state that there are no transactions to generate at this time. When 
you log into the Magaya system, you will receive a notice if there are any 
transactions to be generated (if you have accounting permissions). You 
can click “Yes” to generate them or “No” to generate them at another time.

• Update On Hand Cargo to bill: A note pops up to notify you that the 
update is in progress. This will link a new recurrent transaction with ware-
house receipts previously received for the customer. This is normally done 
automatically, but this manual option is available.

• Choose Columns: As with any list, you can choose the columns and their 
arrangement.

• Export: You can export the list from your Magaya system.
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Periodic Invoices

A Periodic Invoice will gather all the charges for a customer and place them on 
one invoice during a week or month.

Steps

1) First, to enable this function for your Magaya system, go to the Maintenance 
folder > Configuration menu and select the Accounting section.

• In the Accounting configuration options, select the time frequency of the 
periodic invoices. Use the dropdown menu to choose Weekly (Fridays) or 
Monthly (select up to five dates during the month).

Save your settings.

2) To set up Periodic Invoices for specific customers:

• Go to the Maintenance folder and click on “Customers”.
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• Select the customer that you want to create a periodic invoice for 
(double-click on the name to open the Customer dialog box).

• Go to the Payment Terms (“Pmt Terms”) tab:

Note: The only items on this tab that will be discussed here are the ones related 
to periodic invoicing. (The TSA known shipper is covered in the Magaya Cargo 
System Operations Manual.)

You can select how often you want to invoice by clicking the dropdown menu 
“Invoice periodically”:

• Use default: This will use the default you preset in the Maintenance > 
Configuration menu that applies to all customers.

• Never apply: Use this to turn this feature off.

• Weekly: This customer will be invoiced every week. All the operations 
charges during the week will be added to an invoice each Friday.
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• Monthly: When you select this option, additional fields appear so you can 
set up to five separate dates to generate invoices. This customer will be 
invoiced on the dates you select.

When you are done, click the OK button to save.

Periodic Billing for Vendors

The system provides the option to group all the bills generated for a vendor in a 
period (week, month).

To enable this option, go to the Payment Terms (Pmt. Terms) tab of the Vendor 
profile.

For example, set up the monthly billing period for a vendor such as an insurance 
broker so that every time a new insurance certificate is created, the system adds 
the cost charge of the insurance to this monthly bill.

This guarantees that the bill created matches the monthly insurance invoice 
generated by the broker for the same month. If this is not done, you will have as 
many bills as insurance declarations submitted during the month to match one 
invoice.
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Tariffs and Rates: Introduction

Introduction to Tariffs and Rates

Tariffs and Rates can be set up in Magaya Explorer to calculate prices for trans-
actions. The difference between Tariffs and Rates is:

• Tariffs are prices you set for services that you offer. The price depends on
the measurement, value, and storage time of the cargo.

• Rates are calculated based on the measurement information plus the
mode of transportation, and the origin and destination information for
the cargo.

How to use Tariffs and Rates: Tariffs are most often used for charges that are 
static such as storage, insurance, etc. Rates are for freight charges.

How the system will process the tariffs and rates:

1) First the system will look in the Customer profile for the rate that is based
on origin, destination, mode of transport, and cargo measurements. If
there isn’t a customer rate, then:

2) The system will look for a tariff (which is on the Charges tab of the
Customer profile) based on cargo measurements, time, and value. If the
system does not find one, then:

3) The system will check the Standard Client Rates based on origin, destina-
tion, mode of transport, and cargo measurements. If the system does not
find one, then:
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4) The system will check for a tariff in Items and Services based on cargo
measurements, time, and value.
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Tariffs

Tariffs: Introduction

Tariffs are prices you set for services you offer such as refrigerated storage. The 
price depends on the measurement (pieces, weight, and volume) value of the 
cargo, and the time it is in storage. Let’s see how to set up tariffs in Items and 
Services under the Accounting folder.

The Tariff button is available on each Items and Services dialog box.
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How to Set Up Tariffs

Follow the steps below to set up tariffs in your Magaya Explorer.

1) In the Items & Services folder, open an item or a service and click on the 
Tariff button. A dialog box opens:

The tariff will be calculated in the currency that is selected in the Items and 
Services screen. The screenshot above shows “Prices in USD”.

Select the option you want in the “Apply by” field:

Weight: This gives you the option to select the weight units (pounds, kilo-
grams, ton, ounce, or Troy ounce).

Min/Max: In the Tariff dialog box, you have the option of entering a 
minimum and maximum price: Enter the amount in the fields “Min.” and 
“Max.” as needed.

Rate per unit: Set the unit as needed. For example 50 cents for every 2 
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pounds (lb).

When charging by weight, the Tariff screen lets you charge a rate that 
varies based on the weight (range).

Example: For shipments that weigh more than 1 pound but less than 50 
pounds, the rate might be 1.00 per pound. For a shipment weighing 51 to 
100 pounds, the rate might be 0.75 per pound.

Click on the Add button. This activates the cells in the table.

Click in the table cells to enter information. Click the OK button to save. 
Note: These table cells can be used for entering tariffs by weight, pieces, 
volume, time and value.

Pieces: When setting the tariff by Pieces, the weight unit dropdown is not 
available because it is not needed.

Volume: This gives you the option to set the units by Cubic meters, Cubic 
inches, Cubic centimeters, or by Liter.
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Time: This gives you the option to charge by time (Hours, Minutes, 
Seconds, Days, Weeks, or Months).

The Time is calculated based on the time the cargo arrived (based on the 
Warehouse Receipt time), and the time the cargo left the warehouse (via 
Cargo Release or Shipment).

Value: The value is used to charge based on the value of the merchandise 
and it can be used to calculate the amount of the insurance on the cargo. 
When selecting “Value”, the unit dropdown is not available.

Calculated: This gives you the option to calculate the tariff based on a 
script or a formula:

The “Formula” option gives you buttons for Variables, Operators, and Validate.

The following example shows how to calculate a storage charge of 0.02 per day 
per pound.

First, click the Variables button to set the variables for Time (T) to “Days” and 
set Weight (W) to “Pounds”.
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The Variables screen shows a list of variables names and codes. These are the 
variables you will use in the script or formula and the measurement units that 
they will come in.

Enter the formula in the blank field using the Variables and Operators:

Click the “Operators” button to insert operator symbols to multiply, divide, etc.

Click the OK button when you are done. You will be returned to the Tariff 
dialog box.
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To create a formula that rounds the days and pounds up to the next integer 
(whole number), use the “ceiling” function:

To validate the formula, click the Validate button and enter numbers to test it.

The option to calculate by “Script” shows a screen with a button for variables 
(weight, volume, etc.), a button to edit code, and a validation button.

Click the “Edit Code” button to open a screen to type in JavaScript code. This 
screen is used to type the body of the JavaScript function to calculate the price. 
The function brackets are already included in the header and the closing bracket 
is included at the bottom of the screen. The “return” statement is required to 
pass the calculated price back to the Magaya system.

This code example shows the storage charge that rounds up to the next number:

In the script code screen, you can call functions by name if you have functions 
already created in the Maintenance > Configuration > JavaScript Code library. 
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This is covered in detail in the “Configuration Menu” chapter of the Magaya 
Software Customizatin Manual. Validate the code to check for errors. Save it.

Tariff by Percent:

To calculate by percent, select the “Percent” option.

Enter a minimum and maximum (optional), enter the percent amount such as 
5% and how to apply it: to the cost, income or profit.

This percent option can calculate a percent for a commission. If it is used in 
House Shipment, it will only calculate the commission for that House, not the 
cost of Master prorated.

Click OK to save and close this screen and the previous one.

Note: The percent option was introduced in Magaya software version 9.8. It was 
designed to make it easeir to set the percent of a tariff. If your system has existing 
tariffs that calculate a percent with a formula or script, your system will 
continue to use those.

Result: Now the tariff is ready for use in transactions.
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How to Customize a Tariff

You can customize a tariff for a specific client (customer).

1) Go to the Maintenance folder > Customers.

2) Select the customer and open their profile. Then click on the Charges tab.
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3) Click on the Add button.

In the dialog box that opens, set up the custom tariff.

• Select the Charge that you want to customize from the dropdown.

• Enter a price or click the Tariff button. (If you select a freight charge, 
the Price field will change to a note “Freight Charges Use Rates.”)
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• If you want to automate this charge, click “Automatic Creation” tab. 
Select the transactions to automate.

• Click OK when done.

That tariff will now apply to that customer for the transactions you specified.
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Rates

Rates Overview

Rates are used to calculate prices for services related to the movement of cargo. 
They are calculated based on the measurement information plus the mode of 
transportation, and the origin and destination information for the cargo.

The different types of rates are: standard rates for all your customers (clients), 
rates from your carriers, and customized rates applied to individual customers:

• Carrier Rates: These are your purchasing rates for freight services, how 
much you pay the carrier.

• Standard Client Rates: These are your standard rates for all customers. 
You can make these available on Magaya LiveTrack for your customers to 
view.
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• Client Rates: This groups all the rates for all your customers (clients) in 
one place. You can customize multiple and single rates for customers 
using a wizard that is available in the Client Rates folder.
 312



Chapter 11 Rates
The Rates folder also contains contracts. See the sections on contracts for 
details. The next section will focus on setting up carrier rates.

Rates can be used in Pickup Orders if you set the “Place” field on the Shipper tab 
or the Consignee tab. See the Pickup Orders topic for details:

http://knowledge.magaya.com/#/article/create_pickup_order
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Carrier Rates

Overview to entering new rates from your carriers: The article explains how to 
add a single rate from a carrier and how to enter multiple rates from the carriers 
you use for air, ocean and ground transport.

To learn how to import a list of rates, see the Knowledgebase article, "Getting 
Started: Importing Data using the Import Wizard:"

http://knowledge.magaya.com/#/article/import_wizard_tips

Enter Carrier Rates

Carrier Rates are your purchasing rates for freight services (how much you pay 
the carrier). For each carrier that you use, enter the rate information they give 
you in your Magaya system. This rate will be used as the Cost in freight charges.

To set up the carrier rates, follow these steps.

• Open the Rates folder, and click Carrier Rates.

• Click the Add button and select the type of rate you want to enter: A single 
rate or multiple ones:
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This example will illustrate how to add a single rate. Multiple rates is explained 
in the section “Add Rates to a Carrier Contract.” The single rate will apply to 
one carrier for one transport mode and only for one origin/destination.

In Magaya software there are many options for creating rates:
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A dialog box opens. The following example shows an ocean rate:

• On the General tab, select the carrier (or add it if it is not in the list).

• Select the freight class service. This pulls from the Items and Services of 
type “Freight” and “Other Freight”.

• Enter a description (optional). Use this for Commodities that you want to 
classify by type such as electronics. To enter a new commodity, click on 
the plus sign in the dropdown menu, enter the information and click OK. 
Commodity Types can also be entered in Maintenance > Configuration > 
Commodity Types. The Commodity Type can also be specified when you 
are entering Inventory Item Definitions: Select the Commodity field on 
the General tab.

• Select the origin and destination cities for this rate (from the ports list).

• Select the method (mode of transportation) such as “Vessel, Container-
ized”.
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• Transit Time: Enter the number of days of the voyage. (This information 
can be added to the Query Rates screen.)

• Select how to apply the rate: This example uses “Container”. When you 
make this selection, the screen will change depending on what you select.

• Minimum and Maximum prices: Set this option as needed.

• Rate per: Set the rate per unit or per range. Rates per Unit such as pounds 
will multiply the rate by the unit.

If the unit is 1 pound and the price is $1 per pound for weights between 1 
and 50 pounds, to ship 35 pounds will be calculated as 1 x 35 to equal $35.

If the price is 0.80 per pound for shipments weighing between 51 and 100 
pounds, the price for a 70-pound shipment will be calculated as 0.80 x 70 
= $56. The price for 90 pounds will be calculated as 0.80 x 90 = $72.

If you set the unit to equal 100 pounds, and the price of $10 per each unit, 
then shipping 400 pounds will be calculated as 4 units of 100, which will 
cost $40.

Select Rate per Range: Enter the ranges such as 1 to 20 cubic feet, then 21 
to 50 cubic feet, etc. For example, a range is set for $10 for any measure-
ment between 1 to 20 cubic feet; your shipment is 15 cubic feet, the price 
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is calculated at $10. If a shipment is 11 cubic feet, the price is still $10 
because it is in the range of 1 through 20.

Rates per range are useful for Roll On Roll Off (RORO) rates. To set a 
RORO rate, apply the rate by volume (cubic feet) and select Rate per 
Range and enter your numbers.

• Click the Add button to add a rate. This will activate a line in the Prices 
table. Select a container (this example shows a 20-foot and a 40-foot stan-
dard container) in the Prices table, and enter the rate for each in the fields. 
You can add as many as you need.

If you have a contract with a carrier, click on the Contract tab:

• Enter the date the contract expires. When the contract expires, the rate 
will no longer be used.

• Enter the contract number.
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If you want to add any notes, click on the Notes tab and enter them.

Click the OK button when done.

Result: The rate now displays in the Carrier Rates list and is available to use for 
costs in shipments.

Note: You can also set up carrier rates in the Maintenance folder by selecting the 
carrier (if they are in the list already). To create a new carrier profile, click on 
the Add button and select the type of carrier:

To edit an existing Carrier rate, double-click on it (or select it and click on the 
Edit button).

In the dialog box that opens, click the Rates tab. To edit a rate, click on the “Edit” 
button. To add a new rate, click on the “Add” button.

This opens the same dialog box explained above.

You can also edit the rates for an existing carrier by right-clicking on the carrier 
name in the Carrier List and select “Rates” from the pop-up menu. In the screen 
that opens, click on the Add button. Use the wizard to enter the information.
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Actions in the Carrier Rates List

Click on the Actions button in the Carrier Rates list to access the following 
options:

• Reports: Use this to create a report of all carrier rates.

• Other Reports: Use this to create reports by carrier, charge, origin, etc.

Reports can be sent to carriers by clicking on the Email button in the top 
toolbar across the top of Magaya Explorer.

• Create Standard Rate: Use this to create a selling rate based on the rates 
your carrier gives you.

Select a rate in the list and click on this option. A dialog box opens. Select 
a markup type (percent or flat) and enter an optional markup value (how 
much you will add to the price). For discounts, enter a minus sign and the 
number. Click the OK button. The Rate dialog box opens. Verify the rate 
and click OK.
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• Create a Customer Rate: Use this to create an individual rate to apply to 
one specific customer. Click on a rate in the list and select this option. A 
dialog box opens.

Select the markup type (percent or flat), enter the markup value 
(optional), and select the customer this rate applies to. Click the OK 
button. The Rate dialog box opens, showing you the amount the system 
just calculated. Verify the rate and click OK. For discounts, enter a minus 
sign and the number in the Markup Value field.

• Modify Rates: Use this to change rates. See details in the section “Modify 
Rates for Your Customers”.

• Query Rates: Use this to perform a query on carrier rates. Enter the infor-
mation you need for the query in the dialog box that opens. See details on 
how to use this screen in the topic “Query Rates:”

http://knowledge.magaya.com/#/article/query_rates

• Choose Columns: Rearrange, add, or remove columns from the list view.

• Import or Export data in XML or CSV formats in or out of your Magaya 
database.
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Query Rates

How to Query Rates

Use the “Query Rates” button to open the query screen when you need to look 
up rates for carriers or to query selling rates. The button can be found on the 
Rates dialog box for Standard Client Rates and Client Rates. The query dialog 
box is also available from the Actions button in Quotations and in the Rates 
folder for Carrier Rates, Standard Rates, and Client Rates.

To query carrier rates, go to the Carrier Rates folder. To query selling rates, go 
to the Client Rates folder or the Standard Rates folder. The fields in the Selling 
Rates query dialog box are the same as in the Query Carrier Rates dialog box.

When the Query Rates dialog box is opened from the Actions button, it can 
remain open while you move to other screens in your Magaya system. When 
you close the screen, the information you entered will remain available to reuse 
or change.
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Add multiple types of freight service class by clicking the button with the three 
dots that is next to the Freight Service Class dropdown. In the dialog box, check 
the types to include in the query.

The date field canbe used to query future rates.

If you want to query other rates or charges such as documentation, you can add 
them to the query by using the “Select” button for “Other Charges” and see all 
the rates. The query of other charges pulls from the information in your 
Accounting folder in your Magaya system.

Select the origin and destination information and method (mode) of transport. 
These fields are required.
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Enter as much information about the cargo as needed.

Click “Find” to generate a list of rates that match the criteria you enter.

The best rate will be checkmarked in the results list. You can add columns to the 
list by right-clicking on a result. In the “Choose Columns” dialog box, click the 
“Add Columns” button to access more choices such as the Transit Time under 
Rates.

Create a Quotation from the Query:

To create a Quotation from the selling rate dialog box, click the “Create Quota-
tion” button.

When creating a Quote from the Carriers Query rate screen, you can specify if 
you want to include the expense charge in the quote’s Charges. You also have 
the option to choose to summarize the income charges in an “All in One” 
charge. This will add whatever fee you select in the dropdown.
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The Quotation dialog box will open with all the rate query information filled in 
automatically. Make any changes or add information in the dialog box to create 
the document. Email or print the document.
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Standard Client Rates

Standard Client Rates are the rates you charge all your customers.

Steps to Set Up Standard Client Rates

To set up Standard Client Rates:

1) Go to the Rates folder and click “Standard Client Rates”.

2) Click the Add button and select Single or Multiple Rates from the pop-up 
menu:
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This example shows you how to enter a single rate. For details on Multiple 
Rates, see the section “Client Contracts.” When you use the “Single Rate” 
option, the system will create one rate for a service such as priority freight or a 
fuel surcharge that will apply for all customers who send freight to the origin 
and destination you assign in the Rate dialog box. Let’s look at the Rate dialog 
box.

A dialog box opens with three tabs:

• On the General tab, select the Freight Service Class from the dropdown 
menu such as “Air Freight Service”.

• Enter a description (optional). Use this for Commodities that you want to 
classify by type such as electronics. To enter a new commodity, click on 
the plus sign in the dropdown menu, enter the information and click OK. 
Commodity Types can also be entered in Maintenance > Configuration > 
Commodity Types. The Commodity Type can also be specified when you 
are entering Inventory Item Definitions: Select the Commodity field on 
the General tab.

• Select the origin and destination cities for this rate.
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• Select the method (mode of transportation) such as Air.

• Transit Time: Enter the number of days of the voyage. (This information 
can be added to the Query Rates screen.)

• Select how you will apply the rate: by the piece, by weight, volume, 
container, or by a calculated rate. When you make this selection, the drop-
down menu next to it will change depending on what you select. You can 
set the units for weight such as pounds and for volume such as cubic feet. 
For more details, see the section on “Tariffs”.

• Use Gross Weight instead of Volumetric Weight in air and ground rates. 
(Previous versions of Magaya software before v8.5 required a formula for 
this.)

• Enter a minimum and/or a maximum rate as needed.

• Click the Add button to add a rate. This will activate the next line in the 
rate table. Click on the table cell under “More than” and “Rate” to edit the 
table cells. The example shows the first table cell with a rate of 2.50 for one 
pound or more. The next table cell shows 2.00 for weight over 100 pounds.

• To query a rate, click on the “Query Carrier Rates” button. This will query 
previously created Carrier Rates. This is useful when you are creating your 
standard client rate; you can look up your purchasing rates for compar-
ison. See the section “Query Rates” for details.

If you have a contract with the client, click on the Contract tab in the Rate dialog 
box and enter the dates and contract number.

If you want to add any notes, click on the Notes tab and enter them.

Click the OK button when done.

Result: The rate now displays in the list and is available to use in shipments.
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Actions in the Standard Client Rates List

Click on the Actions button to access the following options:

• Reports: Create a report of all Standard Client Rates

• Other Reports: Create reports by description, charge, destination, etc.

Reports can be sent to customers by clicking on the Email button in the 
top toolbar across the top of Magaya Explorer.

• To create a Customer Rate, click on a rate in the list and select the option 
“Create Customer Rate” from the Actions button. This sets a rate that 
applies to one customer. A dialog box opens:

Select the markup type (percent or flat), enter the markup value, and select 
the customer that this rate applies to. Click the OK button. The Rate dialog 
box opens. Verify the rate and click OK. This will apply the markup to that 
one customer.

• Modify Rates: Use this to change rates. See details in the section “Modify 
Rates for Your Customers”. The rate modification will apply to all clients. 
If you want to modify a rate for only one client, use the Actions button in 
Client Rates.
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• Query Rates: See the section “Query Rates”.

• Choose Columns: Use this to rearrange columns and add or delete 
columns in the rates list.

• Import or Export data in XML or CSV formats in and out of your Magaya 
database.
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Custom Rates

Create Customized Rates

You can customize a rate for a client by using a wizard or by opening the Rates 
dialog box in the Customer’s profile. The rate can be based on the standard one 
created for all customers and then changed for a specific customer. This custom 
rate will override any standard rate you set up in your Magaya system for that 
customer.

The wizard is available from two places in Magaya Explorer: Right-click on the 
customer name in the Customer List and select “Rates” from the pop-up menu. 
In the list that opens, click on the Add button to use the wizard.

You can also access the wizard by selecting “Client Rates” under the Rates 
subfolder in Accounting:

For details on using the wizard, see the section “Modify Rates for Your 
Customers.”

The following example shows you how to customize a rate by using the Rates 
dialog box in the Customer’s profile:

1) Go to the Maintenance folder.

2) Click on Customers.
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3) In the Customer profile dialog box, click on the Rates tab.
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4) Click on the Add button in the Rates tab. A dialog box opens.

• On the General tab, select the carrier.

• Select the freight class service. This pulls from the Items and Services 
of type “Freight” and “Other Freight”.

• Enter a description (optional). Use this for Commodities that you 
want to classify by type such as electronics. To enter a new 
commodity, click on the plus sign in the dropdown menu, enter the 
information and click OK. Commodity Types can also be entered in 
Maintenance > Configuration > Commodity Types. The 
Commodity Type can also be specified when you are entering Inven-
tory Item Definitions: Select the Commodity field on the General 
tab.

• Select the origin and destination cities for this rate (from the ports 
list).
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• Select the method (mode of transportation) such as “Vessel, 
Containerized”.

• Transit Time: Enter the number of days of the voyage. (This infor-
mation can be added to the Query Rates screen.)

• Select how you will apply the rate. The screen will change depending 
on what you select.

• Click the Add button to add a rate. This will activate a line in the 
Prices table. Enter information for each in the fields such as weight 
and rate. For example, you can charge by weight to calculate the 
prices. If cargo weighs more 50 pounds, type on 50 and the rate. Add 
the next one as 100 pounds and the rate. You can add as many as you 
need. This rate shows a container, the type of container and its rate. 
See the section on “Tariffs” for more details on using this table.

5) Click on the Contracts tab if you have a contract number and expiration 
date.

6) Click on the Notes tab to enter any notes as needed.

7) Click the OK button to save settings when you are done.

Result: This customized rate is now ready to be used. Your customers with 
access to Magaya LiveTrack can view the rates online.
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Carrier Contracts

Managing Contracts

When you get a contract from a carrier or you want to create a contract with a 
customer, you can enter the rates for those contracts in your Magaya system and 
update them in groups.

Then the rates are available to use in shipments and other transactions, saving 
time since they do not need to be entered each time.

The contracts feature is an easy way to create rates and group them in your 
Magaya system. You can find the contracts in the Accounting folder:

The Carrier Contracts is the place in the Magaya system that handles your 
purchasing rates (your cost to purchase carrier services). This is where you enter 
the rates that the carrier gives you.
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The Client Contracts are used to handle the client rates, which are used to 
calculate the selling prices.
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Add a New Carrier Contract

When you get a new contract from a carrier for the first time, use this method 
to enter the contract into your Magaya system. After you enter the contract 
details, then enter the rate information for that carrier.

1) Go to the Accounting folder.

2) Expand the Rates subfolder and select “Carrier Contracts”. The screen has 
three sections: Contracts, Amendments, and Rates:

3) Start in the Contracts section: click on the Plus sign. In the dialog box that 
opens, enter the following:

• The contract number.
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• The date the contract will become effective.

• The date the contract will expire (the default is one year from today).

• Select the carrier.

• Select the contact - the person who is your contact person. Click on 
the dropdown to access the Contacts list and make your selection. 
This field is optional.

• The Employee is the person who is adding the contract into the 
system. This will be filled in by the system.

• The Division is optional.

To include a copy of the contract as an Attachment here, scan it and attach 
by clicking on the Attachments tab and clicking on the Add button. 
Details on attaching via a scanner are explained in the Magaya Cargo 
System Operations Manual.

Add any notes as needed on the Notes tab.

4) Click OK.

The contract is added in the list.

When a new contract is added into the system, the system will create a default 
amendment called "Initial" and place it in the Amendments list.

To view the original amendment, double-click on “Initial” in the Amendments 
list to open the dialog box.
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The Number field is "Initial". This Initial amendment is the original contract, 
with the same effective date as the original contract and all the details.

Now that the carrier contract information is entered in your Magaya system, 
you can enter the rates for this contract.
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Add Rates to a Carrier Contract

After you add a contract into your Magaya system, select it to add rates to it.

1) In the Rates section, click on arrow on the Plus sign and select from the 
pop-up menu:

Use the “Multiple Rates” option to create carrier rates in batches for many 
ports of origin and destination.

Use the “Single Rate” option to open the rates dialog box to enter one rate 
for one origin/destination. This is explained in the section “Set Up Carrier 
Rates”.

The following example explains how to enter multiple rates.
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The wizard that opens contains the following fields:

The carrier name and Effective Date are filled in the first screen of the 
wizard based on the contract you are working on. These fields are 
Read-Only. To edit them, go to the Contract itself. You can add an expi-
ration date.

2) Select how you want to create rates:

• Enter your own rates: With this option, you enter the rates and the 
origin and destination from the contract, and the system will create 
the rates for you for all the origins and destinations you enter. For 
example, if a carrier sends you one rate for a 20-foot container for a 
group of ports, use this option.

• Copy from similar entities rates: Use this option to make amend-
ments, for example by origin and destination or by percentage. (This 
option is shown in the section “Amend Rates based on GRI”.) The 
advantage of this option is you will not have to recreate the rates 
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from scratch; it works with the existing data you have previously 
entered for this carrier.

When this option is selected, another field appears for you to enter 
the details: Select the type of modification (by percentage or flat rate 
increase or decrease), and enter the value (the number such as 10 for 
10%).

3) Click the Next button in the wizard to go to the next screen. Select the 
ports by clicking on the Add button to open the Ports list. Click on the 
port names and click the OK button. Do this for origin and destination 
ports:
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4) Click Next to go to the Common Rates screen. In this screen, click on the 
Add button to open the Rates dialog box.

• Select the Freight Service Class. This example shows Priority Freight 
Service Cost.

• The Description/Commodity is optional.

• Select a Method of transportation for this rate.

• Select how you want to apply this rate, for example by weight (in 
pounds). Click on the dropdowns for other options.

• Transit Time: Enter the number of days of the voyage. (This infor-
mation can be added to the Query Rates screen.)

• Enter a Minimum and Maximum amount (optional).

• Select a rate by unit or range. Rates per range are useful for Roll On 
Roll Off (RORO) rates. To set a RORO rate, apply the rate by volume 
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(cubic feet) and click Rate per Range. Then enter the ranges such as 
1 to 30 cubic feet, then 31 to 50 cubic feet, etc

• Click on the Add button to enter rates amount per weights.

• Click the OK button to save the rate information.

5) Click Next. The system will generate rates for each port based on the infor-
mation you entered and display the results:

If you want to make an exception for one of the ports shown, select it and 
click “Edit”. To exclude that port from this rate, select the line and click 
“Remove”.

6) Click Next. The system will show you the rates that will be expired and 
replaced with the new ones you just added. If you do not have similar 
rates, this screen will be blank. To exclude a rate from expiring, select it 
and click “Remove”. Otherwise the system will expire any listed in this 
screen as of the day before the effective date for the new rate.
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7) Click Next to go to the last screen in the wizard. Here you can save and 
finish, or save and add another rate:

• Click Save: The system tells you the processing is completed.
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• Or click Restart: If you want to add additional rates that use some 
information that is similar to the rates you just entered, click the 
Restart button.

By clicking Restart, the wizard will return to the screen with the 
origin and destination ports.

8) Click Finish. The wizard closes, and the new rates are displayed in the list.

Extra Info: The same expiration rate can be used when copying a rate. This is 
useful when creating sales rates from the cost rates.

If a carrier offers a discount, you can use a negative number.
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Amend Rates

Learn how to make changes to rates in your Magaya system when you get a rate 
increase from a carrier. Also learn how to change a rate per customer.

This article explains how to modify existing rates by using the wizard explained 
below. You can overwrite existing rates by just importing new ones via the 
Import Wizard. The wizard will expire old rates and add new ones. See the 
Knowledgebase article about the import wizard for more:

http://knowledge.magaya.com/#/article/import_wizard_tips

Amend Rates based on GRI

When you receive a General Rate Increase (GRI) from a carrier, you can enter 
the updates in your Magaya system and apply the rate increase to multiple ports 
at one time, instead of one at a time.

Make sure you select the correct amendment that you want to make changes to.

1) In the Amendments screen, click the plus sign. A dialog box opens.

2) Enter the Amendment Number and Effective Date.

3) Click OK. The dialog box closes, and the new amendment appears in the 
Amendments list. It will show the contract number and the amendment 
number.
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4) Select the new Amendment to highlight it.

5) Go to the Rates section of the screen and click on the plus sign. Be sure you 
are in the correct amendment before you start to add new rates.

This example illustrates how to enter a 10% rate increase for a group of 
ports that have increased by the same amount.

6) From the Add button pop-up menu in the Rates section, select “Multiple 
Rates”.

7) In the wizard, select "Copy from entities rates" for this carrier. If you want 
to use another carrier, select it from the dropdown “Select source entity”. 
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In the additional fields that appear, enter the details of the transformed 
rates (such as percent and value of 10).
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8) Click Next. The Filter screen will appear. Here you can specify exactly 
which rates you want to transform. Filter the rates to find the rates that 
you want to apply the change to by specifying the following:

When you set these criteria, the system will search in your Magaya data-
base for any rates that match these criteria and already exist. If you leave a 
field blank in this screen, the system will apply the transformation to the 
criteria in that field.
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9) Make changes such as removing ports that you do not want to apply the 
new rate to, and click the Next button.
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10) In the next screen, “Found rates” the system will display the rates for the 
ports you selected. Click the Next button.

11) The system generates the new rates, applying the 10% increase to them all 
for you. It will split rates if you have two container sizes (20- and 40-foot) 
in the existing rate. For example, if you get an increase for a 20-foot 
container but not for a 40-foot container, the system will split the rates and 
show them all to you in this screen. Review the information and click 
Next.

12) The system will show you the rates that will be expired and replaced with 
the new ones you just added. The old rate will expire right before the new 
one takes effect. Review the date and time information and click Next.
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13) Click Save.

When you click the Save button, the system tells you the processing is 
completed.

If you want to add additional rates that use some information that is 
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similar to the rates you just entered, then click the Restart button.

If you click on the Restart button, the wizard will return to the first screen 
and show all your information on each screen so you can make changes.

14) Click Finish. The wizard closes, and the new rates are displayed in the list.

Modify a Standard Rate

When carriers raise their rates, you update the GRI and then apply the increase 
to your customers. If you do not want all your customers to have the same 
increase, you can give a customer a discount.

For this example, let’s say you already entered the GRI and applied it to all the 
customers via the Standard Client Rates. To give a customer a discount, follow 
these steps:

1) Go to Client Contracts.

2) Add a new amendment for the customer.
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3) Use the Multiple Rates wizard: click the option to “Transform from 
existing standard client rates”. Enter the amount of the change (for 
example, by weight and by percent). For this example, let’s modify the 
ocean freight for our customer, Jamaica Distribution Center, and only 
raise it by 20% instead of 30%.

a. For the field “Transformation Type,” select “Decrease a percentage”.

b. For the field “Value,” enter 10.

c. Specify the conditions such as “Ocean Freight Service Cost” and “Vessel, 
Containerized”, etc. according to the GRI.

4) Complete the wizard by specifying ports, reviewing the rates generated by 
the wizard, and save the changes.

The discounted rate for that customer is saved. When a shipment is 
created for this customer, the system pulls the rate from this discounted 
rate.

For a PDF of this procedure, see the Magaya.com Training page, Tech Tip 
for June 2012.
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Modify Rates for Your Customers

To make a change to the rate you charge your customers, follow these steps.

1) Go to Client Rates > click on the Actions button > select Modify Rates. A 
wizard opens. In the first screen of the wizard, do the following:

1. Select the client (customer) that you want to change the rate for.

2. Choose the type of modification: a) To change the expiration date, or b) 
to modify the rates. If you are modifying the rates for the customer, select 
how you to modify them - what type and the value.

2) Filter the rates in the next screen by service class, method of transport, and 
other criteria that apply. Click the Next button.

3) Select the ports from the list and go to the next screen to see the rates the 
system found.

4) In the last screen click the Save button to save and finish the wizard. If you 
want to make other changes with similar criteria, click on the Restart 
button.
 356



Chapter 11 Amend Rates
Note: This wizard works the same for Carrier Rates and for Client Rates.

When you customize the Standard Client Rates, the first screen in the wizard 
does not have a client to select because the modification you make will apply to 
all clients.
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Client Contracts

Magaya software includes a wizard to help manage contracts you offer your 
customers.

Client Contracts: Add Contracts and Rates

Use the wizard screens to manage contracts you create for your clients. The 
wizard works the same way as the wizard for adding carrier contracts and 
carrier rates.

First, add the contract for the client.

The contract for the client is added. Now you can add rates for that client.
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Select the amendment and click on the Add button in the “Rates for Amend-
ment” part of the Client Contracts screen. A wizard opens. This example shows 
you how to enter your own Multiple Rates.

1) Enter the information in the first screen of the wizard for this client:

• Enter your own rates: With this option, you enter the rates from the 
contract, the origin and destination, and the system will create the 
rates for you for all the origins and destinations. For example, if a 
carrier sends you the same rate for a 20-foot container for a group of 
ports, use this option. This example will show this option.

• Copy from similar entities rates: Use this option to make amend-
ments, for example by origin and destination or by percentage. You 
will not have to recreate the rates from scratch. It works with the 
existing data you have previously entered. When this option is 
selected, another field appears for you to enter the details: Select the 
type of modification (by percentage or flat rate increase or decrease), 
and enter the value (the number such as 10 for 10%).

Select source entity: Use a similar rate that you created for a different 
customer.

• Copy from carrier rates: Select the carrier that you want to use that 
has similar rates so you can copy those rates here and make changes.
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• Copy from standard client rates: This will use the Standard Client 
Rates you set up earlier. Then you can make changes to the standard 
rates.

2) Click Next to select the ports. (You will see the filter screen if you are 
transforming from existing rates.)

• Click the Add button to open the Ports list. Click on the port names 
and click the OK button. Do this for the origin and destination. Click 
Next to go to the next screen in the wizard.

3) Click the Add button to enter the common rates for the ports you selected 
in the previous screen.

4) Click Next to go to the next screen. This screen will show you the rates that 
were generated by the system. You can edit a rate here if needed. Click 
Next.

5) If there are any rates similar to the ones created, the system will set the 
expiration dates for them based on the effective date. Click Next.

6) Click the Save button if you are done.

The rate information is saved. The following note will appear: “The 
process has finished successfully.” Click the Finish button if you are done.

7) Click on the Restart button if you want to add more rates and use some of 
the same information. The wizard will return to the first screen and show 
all your information on each screen so you can make changes.
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Salesperson’s Commissions

Introduction to Commissions for Sales

In your Magaya system, you can add salesperson’s profiles and include commis-
sion participation rates for each salesperson when they sell or freight or inven-
tory. The system enables you to enter profiles for sales people who are 
employees or outside contractors/vendors:

• If a salesperson is an outside vendor, enter their details in the Salesperson 
profile.

• If a salesperson is an employee, enter their details in the Employee profile 
and a Salesperson profile. The Employee profile includes the User login 
and password fields.

Commissions can be set individually for each salesperson or system-wide to 
apply to all sales people. To set a percent commission system-wide to apply to 
all salespeople for liquidations of shipments, go to Maintenance > Configura-
tion > Accounting and click “Configure Liquidation Options” button for 
Outgoing or Incoming. Set the percent in the dialog box.

This article explains how to add a new salesperson to your Magaya system, set 
their commission for freight and for inventory items, how to see a report of 
commissions, and how to activate LiveTrack access for a salesperson so they can 
place orders online for their customer using LiveTrack.

Add a New Salesperson

To add a new salesperson to your system, follow these steps:

1) Go to Maintenance > Salespersons.

2) Click the Add button.

In the dialog box that opens, you can enter details on any tab. On the 
General tab, enter their email, phone number, which division they work 
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for if applicable, their address, billing address if different, and other 
personal information as needed.

The Identification number can be a DUNS, EIN, SSN (Social Security 
Number), a Foreign or Other type of number.

Freight Commission

Individual sales people can have their commissions calculated in Magaya 
Explorer for any freight they sell. Set the commission amount in their profile, 
and the amount will be automatically added to transactions such as shipments.

To add a freight commission (“participation”) for a salesperson, open their 
profile in Maintenance > Salespersons.
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Click the Participation tab and perform the following steps:

1) Click the “Add” button and select “Freight Participation”.

Note: The freight and inventory options are available in the Magaya 
Supply Chain Solution and Magaya Distribution System.

2) In the “Participation per Customer” screen, select a customer to associate 
with the commission. This means each transaction that includes this 
363



Salesperson’s Commissions Chapter 11
customer will generate a commission for this salesperson based on the 
amount set here.

3) Click the “Add” button. Select either a charge or a shipment.

An example of a Charge is “Ground Freight Service”.

To choose how you want to calculate the commission, click the “Type” 
dropdown and choose the type of commission. This example shows 
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percentage of profit, but you can also select a flat rate, or set the amount 
to calculate by volume, weight, or pieces).

Enter the value such as “5” for five percent of the profit.

An example of a shipment is a percent of a type of shipment such as an 
ocean export. Percents can be set individually per type of shipment.

Click OK in each dialog box to save.

When a salesperson sells freight, the commission is generated in the shipment 
transaction in the Liquidation screen.

View Columns for Participation:

Click the “Actions” button to see the list of columns you can add to the Liqui-
dation screen. Select the columns for the salesman name, participation, and 
profit.
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The commission can also be changed in the Liquidation screen by 
double-clicking on the line.

When you click the “Generate” button in the Liquidation screen, a dialog box 
opens listing all the accounting transactions for the shipment, including the Bill 
for the salesperson’s commission.

The bill and other transactions are saved in the Magaya accounting folder.

To see how the commissions are generated in shipments, see the topic “Liqui-
dation” in the Knowledgebase:

http://knowledge.magaya.com/#/article/liquidation

When a salesperson has participation in the profit in a shipment, the sales-
person can view the shipment in LiveTrack. This applies to the Magaya Cargo 
System.

Inventory Commissions

In the Magaya Commerce System and Magaya Supply Chain Solution, salesper-
sons commissions for inventory sales can be set per item, per category, or 
system-wide.

Configure General Inventory Commissions System-wide:
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To configure a general commission that applies to all inventory sales and to all 
salespersons system-wide, follow these steps.

1) Go to Maintenance > Configuration > Sales

2) Click the “Commissions” button.

In the dialog box, select the Type and Value of the inventory commission. 
This will be applied to all inventory items sold by any sales person. For 
example, to add a commission of 5% of the profit, enter “5”. (Do not type 
in “0.05” for 5%. Type “5”. Do not type the percent symbol in the field.)

3) Click OK and Save.

Inventory Commission per Item:

To add a commission to an item, you can add it from the Salesperson profile or 
go to the Inventory Items Definitions list, open (or create) an item.

On the Accounting tab, click the “Commissions” button.
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A dialog box opens (it’s the same dialog box regardless if you access it from the 
salesperson’s profile or from the Inventory Item Definition). Select the type and 
set the value for the commission in the dialog box.

Choose from Flat Value, Percentage of Profit, Percentage of Income, or a Calcu-
lated Amount. If you want to create the commission to be based on income of 
the charge, you can do it regardless of the cost. As a result, the company does 
not disclose the profit made.

Inventory Commission per Category:

To add a commission to a whole category of items that are sold online in the 
Online Sales Orders of Magaya LiveTrack, (for users of the Magaya Supply 
Chain Solution), go to the Inventory Organizer in the Warehousing folder.
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Open (or create) a category, and select the type and set the value for the commis-
sion in the dialog box.

When a customer purchases an item online, the commission amount is added 
to the transaction.
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When a salesperson sells inventory, the commission can be generated from the 
Sales Order by clicking on the Actions button (after creating the Invoice). The 
system creates a Bill payable to the salesperson.

Reports

Reports can be created in your Magaya system to view all commissions:
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In the Salesperson’s List or Agent’s, go to: Actions > Reports

Additional reports are available from the Reports menu on the top toolbar of 
your Magaya Explorer. Select “Profit Reports” to see profit by salesperson or 
agent.

The “Sales Reports” menu option also includes other accounting reports that 
show commissions such as the “Sales Reports by Item” report. Also see the 
Chart of Accounts to make a report from the Actions button to see accounts by 
Type Code (the commissions are grouped under Expenses).
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Enable a Salesperson to Submit Orders on behalf of Customers

To give a sales person at your company the ability to place orders for their 
customers, such as when visiting with them, follow these steps:

In Magaya Explorer:

First, add the salesperson, or edit an existing salesperson’s profile.

Next, right-click the salesperson’s name in the list. From the pop-up menu, 
choose “Allow Tracking.”

Create (or click Autogenerate) a password (passwords: minimum 6 characters. 
usernames: 6-15 characters). Ensure the box is checked to enable LiveTrack 
access.

On the Tracking tab, check the permissions to activate. The permission to view 
sales orders is on by default.

Click OK save.

To view the list of salespersons who have LiveTrack access, choose the column 
“LiveTrack User” from the Actions button.

In LiveTrack:

In LiveTrack, the salesperson logs in and clicks the “Add” button in the Sales 
Orders screen to place a new sales order. The Buyer field displays the sales-
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person’s name. (It can be changed if needed to click the arrow to select the 
customer name from the dropdown. These entities shown in the list are related, 
i.e., the salesperson has created another transaction for them previously.)

In step 2, the salesperson can search for items, can type in the quantity, or can 
upload a file into LiveTrack. To upload a list, click the “Upload” button. Use a 
CSV or text file with 2 columns: Part Number and the Quantity. If format is an 
Excel spreadsheet, it must be saved as CSV. Don't leave the Quantity field blank; 
add zero if unknown. If the Magaya database doesn't have the item defined 
already, it will upload it from the import file.

Complete the online sales order as usual. See the Knowledgebase article for 
steps:

How to Place Sales Orders Online in LiveTrack

http://knowledge.magaya.com/#/article/customers_place_sales_orders

When the sales order arrives in your Magaya system, go to the Sales Order list, 
right-click it to make a Cargo Release.

If a Cargo Release or Shipment is loaded with items from a Sales Order that was 
assigned to the salesperson, then the salesperson will be able to track that status 
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of those releases and shipments in LiveTrack (Magaya Distribution System or 
Supply Chain Solution required).

Related Resources

You can also set agent participation in your Magaya system. See the following 
Knowledgebase article:

http://knowledge.magaya.com/#/article/agent_participation
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